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1 Evaluation and Evaluation Classic

1 Evaluation and Evaluation Classic

The Evaluation Classic module

The Evaluation module within UNICORN 7.0 contains the basic functionality needed
when evaluating chromatography results. How to use the Evaluation functions is de-
scribed in the integrated Getting Started view and via tool tips.

This manual describes the Evaluation Classic module which include additional features
and requires a separate license.

All the examples given are from the Evaluation Classic module, but the formulas and
algorithms described are also useful when working with the Evaluation module

When to use Evaluation Classic

Most users only need Evaluation, but some features are only available in Evaluation
Classic. These features are listed in the following table:

Function Description

Design of Ex- | DoEis used to find out, in a systematic way, which
Y periments run parameters affect a process to be run and
how to find optimal values for these parameters
to obtain the best possible result using a minimum
number of runs.

Column Log- | The Column Logbook enables the run history for
EE book an individual column to be traced, for example,
how many CIP runs have been performed using
that column.
Multi Result Multi result peak compare is used to make statis-
’E Peak Compare | tical comparisons between peaks in different re-
sults, for example by comparing area, retention,
o etc.
Procedures Frequently used evaluation procedures can be
recorded and saved. The saved sequence of pro-
[EIEE cedure instructions can be included as part of a

method. When the method is run, the evaluation
procedures will be performed automatically.

UNICORN 7.0 Evaluation Manual 29-1108-88 AA 5



1 Evaluation and Evaluation Classic

Symbol

Operations
Add...
Subtract...

‘ Function

The curve op-
erations on
the Opera-
tions menu.

Description ‘

In addition to peak integration a number of oper-
ations can be performed. E.g. apply mathematical
operations to create resulting target curves, shift
retention/amplitude to better visualize differences
in between runs, smooth curves to reduce noise
or create histograms.

Note:

The shift offset operation is available in the Evalu-
ation module.

Customize re-
port

Generate a customized report of the evaluated
result.
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2 Introducing UNICORN Evaluation Classic

2 Introducing UNICORN Evaluation
Classic

About this chapter

This chapter contains:

* Ageneral introduction to the evaluation of results using the Evaluation Classic
module.

¢ Information about the user documentation for UNICORN 7.0, including an overview
of related documents describing the use of the software.

Software declaration of
conformity

UNICORN 7.0 is technically compatible with all relevant sections of FDA 21 CFR Part 11.

A part 11-system assessment checklist is available on request from your local GE
Healthcare representative.

In this chapter

This chapter contains these sections:

Section See page
2.1 About evaluation of UNICORN results 8
2.2 About this manual 10
2.3 Associated documentation 12
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2 Introducing UNICORN Evaluation Classic
2.1 About evaluation of UNICORN results

2.1  About evaluation of UNICORN results

Introduction

This section is a brief introduction to the evaluation of results created in UNICORN and

a description of the scope of this manual.

What is UNICORN?

Workflow

UNICORN is a complete software package for:
e control and supervision of chromatography systems.

* evaluation and analysis of the results from separation runs.

The workflow in UNICORN can be divided into four distinct stages. The flow chart below
shows the workflow stages.

1. Create a method

2. Run the method

3. Evaluate the results

4. Compile a report

This manual describes steps 3 and 4 of this workflow.

Tip: Step 1, how to create and optimize methods, is described in the UNICORN
Method Manual. Step 2, how to perform method runs, is described in the
UNICORN System Control Manual and in the instrument manual.
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2 Introducing UNICORN Evaluation Classic
2.1 About evaluation of UNICORN results

Evaluate the results

Aresult is automatically generated at the end of a run and contains a complete record,
including controlling method, system settings, monitored data and runlog. The complete
result is recorded in the UNICORN database.

Using the UNICORN Evaluation Classic module you can view and analyze result data
and optimize the presentation of the results, for example by:

* integrating peaks
* measuring peak data

e comparing curves and chromatograms from different results
etc.

Note: The source result data created during the run are always saved regardless of
your editing operations. Edited curves are saved as copies, with the original
source curve uncompromized. The original result curves cannot be deleted or
overwritten.

Compile a report

When you are satisfied with the result, you may compile a report using the UNICORN
Evaluation Classic module. The.report can be anything from a simple print of a chro-
matogram, showing selected curves, to a comprehensive report containing, for example:

e chromatograms from several results
e rundatain text form

* log entries

* images

The report options are described in Section 4.6 Generate reports, on page 75.
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2 Introducing UNICORN Evaluation Classic
2.2 About this manual

2.2

Introduction

About this manual

This section describes the purpose of the manual, the general structure and conventions
applied in the text, and some prerequisites that should be fulfilled before you start to
apply any of the procedures described in the following chapters.

The purpose of the UNICORN
Evaluation Manual

The purpose of the UNICORN Evaluation Manual is to provide a comprehensive guide to
the evaluation features of the UNICORN software. The Evaluation Classic module of the
software is presented, along with practical instructions on how to use the functions.

Basically the manual covers the following, major topics:
* how to view results and how to compile result reports

* how to edit and optimize the representation of the results
and

* how to automate frequent evaluation procedures.
The manual also describes algorithms and theoretical models used in the evaluations.

Note: The UNICORN Evaluation Manual does not describe the functions of every
command in all panels and dialogs of the user interface. Refer to the online
user interface help for information about commands that are not described
in this manual. The online help in the Evaluation Classic module is accessed
either by clicking the Help button in a software dialog or by pressing the F1
key.

Document structure

10

Each chapter starts with a brief overview that presents the contents and the headings
for the sections that the chapter contains. Most sections begin with an introduction that
summarizes the content. Some sections are divided into sub-sections, each with an
overview of the contents.

A section is divided into blocks of information with separating lines. The blocks are
identified by a label extending into the margin (such as the label Document structure
above). This makes it easier for you to quickly scan a page to find the exact topic you
are looking for.
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2 Introducing UNICORN Evaluation Classic
2.2 About this manual

Typographical conventions

Menu commands, field names and other text items from the software are quoted exactly
as they appear on the screen, in a bold italic typeface:

Example: Result Navigator

Menu paths are shown in a bold italic typeface with a separating colon between each
level:

Example: Edit:Delete:Curves i.e., the menu option Curves in the sub-menu Delete from
the Edit menu.

Controls on the instrument, computer or keyboard keys are shown with a bold, regular
typeface:

Example: Press the Delete key.

Text that the user must either type exactly as shown in the manual, or that UNICORN
displays as a response (not a regular part of the graphic user interface), is represented
by a monospaced typeface within quotation marks:

Example: "Connection change"
File system paths are represented by a monospaced typeface:

Example: C:\Program Files\GE Healthcare\UNICORN\

Prerequisites

The following prerequisites must be fulfilled before you can use this manual the way it
is intended:

¢ You need to have a general understanding of how your PC and Windows® work. In
most cases universal computer functions will not be explained.

e UNICORN must be installed and configured correctly on your computer.

e Your user profile and access rights must be set up, and you must be able to log on
to UNICORN, access a database and results files.

* You needto understand the general concepts of liquid chromatography. Terminology
and functionalities will be explained only when they differ from normal practice.

UNICORN 7.0 Evaluation Manual 29-1108-88 AA 11



2 Introducing UNICORN Evaluation Classic

2.3 Associated documentation

2.3 Associated documentation

Introduction

This section describes the user documentation that is delivered with UNICORN.

User documentation

The user documentation listed in the table below is available from the Help menu in
UNICORN and as printed books.

Document

UNICORN Method Manuall

Main contents ‘

Overview and detailed descriptions of the method cre-
ation features in UNICORN. Instructions on how to use

the software. Workflow descriptions for common opera-
tions.

UNICORN Evaluation
Manual

Overview and detailed descriptions of the Evaluation
Classic module. Workflow descriptions for common op-
erations. Description of the evaluation algorithms used
in UNICORN.

UNICORN Administration
and Technical Manual

Overview and detailed description of network setup and
complete software installation. Administration of
UNICORN and the UNICORN database.

UNICORN System Control
Manual

Overview and detailed description of the system control
features in UNICORN. Includes general operation, system
settings and instructions on how to perform a run.

UNICORN Online Help

Dialog descriptions for UNICORN (from the Help menu).

12
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3 The UNICORN Evaluation Classic module

3 The UNICORN Evaluation Classic
module

Introduction

This chapter is an overview of the UNICORN Evaluation Classic module with descriptions
of some of the elements of the user interface.

Note: A user may be assigned to an Access Group which is set up so that the user
only has limited access to the various UNICORN modules. The modules that
are unavailable cannot be selected or opened when the program is started.

In this chapter

This chapter contains this section:

Section See page

3.1 Evaluation Classic module 14
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3 The UNICORN Evaluation Classic module
3.1 Evaluation Classic module

3.1  Evaluation Classic module

The Evaluation Classic module
interface

The interface consists of a pane where the current result is displayed and the Result
Navigator. Both panes are described below.
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Evaluation Classic module
window

3 The UNICORN Evaluation Classic module
3.1 Evaluation Classic module

The illustration below shows the different parts of the Evaluation Classic module with a

result displayed:
1 Result Navigator
2 Chromatogram pane

3 Peak table
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3 The UNICORN Evaluation Classic module

3.1 Evaluation Classic module

Toolbar buttons in the Evaluation
Classic module

16

The following table describes the toolbar buttons in the Evaluation Classic module.

Button

s

Function ‘
Opens the Result Navigator.
The Result Navigator is described below.

Note:
This function is also available in the View menu.

pve

i)

Opens a new, empty result.

Note:
This function is also available in the File menu.

[

Opens the Open Curves To Compare dialog.

You may use the dialog to search for curves to compare in specified folders,
results or chromatograms. This dialog is described in Section 5.5 Compare
different runs, on page 161.

Note:

This function is also available in the File menu.

il

Saves the current result.

If the current result is new and has not been saved yet, the Save As dialog
will open so that the result can be named and saved in a selected folder.
Note:

This function is also available in the File menu.

Opens the Print Chromatograms dialog.

This dialog is used for printing the chromatograms on a selected printer.
There are options for the print layout and Preview before printing. This di-
alog is described in Section 4.4 Print chromatograms and peak data, on
page 60.

Note:
This function is also available in the File menu.

pa ]

Cuts the selected result or folder from the current place in the file structure.

Note:

This function is available only for items in the Result Navigator pane. Cut
is also available in the Edit menu.
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3 The UNICORN Evaluation Classic module
3.1 Evaluation Classic module

Button Function

o Copies the selected result or folder, when the Result Navigator is se-
lected.

e or
« Opens the Copy to Clipboard dialog, when an open result is selected.

Either the curve window or the peak table data may be copied to the
Windows clipboard.

Note:
This function is also available in the Edit menu.

Pastes a copied result or folder to the selected folder.

Note:

This function is available only for items in the Result Navigator pane. Paste
is also available in the Edit menu.

Returns the result to the state it was in before the last change (Undo).

"f) Note:
This function is also available in the Edit menu.

Opens the Generate Report dialog.

@ The Generate Report dialog is used to preview and print reports in selected,
saved formats and also to delete saved formats.

When New is selected, or a saved format is selected for editing in the
Generate Report dialog, the Customize Report window is opened in the
Evaluation Classic module. The editing process is described in detail in
Section 4.6 Generate reports, on page 75.

Note:
This function is also available in the File menu.

Opens the Documentation dialog.

uj The dialog contains the complete documentation for the result, including
—_| | forexamplethe Run Log, Evaluation Log and System Settings. This dialog

is described in Section 4.5 Run documentation, on page 63.

Note:

This function is also available in the View menu.
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3 The UNICORN Evaluation Classic module
3.1 Evaluation Classic module

Button Function ‘

Opens the Customize dialog where curve and axis settings, styles and
A colors, header content and text items can be set. Saved layouts can be
ch selected and edited layouts can be saved for later use.

This dialog and the layout operations are described in Section 4.3 Optimize
the presentation of chromatograms, on page 40.
Note:

This dialog can also be opened by clicking Customize on the chromatogram
right-click shortcut menu.

Opens the Peak Integrate dialog, where curve characteristics including
peak areas, retention time and peak widths are identified and measured.

This dialog is described in detail in Section 5.2 Peak integration, on page 102.

Note:
This function is also available in the Integrate menu.

Opens the Multi Result Peak Compare wizard.

This wizard can be used to compare peak data from different results, for

example from a complete series of Scouting runs. The options and how
to use the wizard is described in Section 5.6 Multi Result Peak Compare
wizard, on page 181.

Note:

This function is also available in the File menu.

Opens the Column Handling dialog, where information about the columns
— E is viewed and edited.

lii Note:

This function is also available in the Tools menu.

-l. Switches to the UNICORN Evaluation module.
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The Result Navigator pane

The Result Navigator shows all the user folders, individual results and Design of Exper-

iment results that are available.

3 The UNICORN Evaluation Classic module

3.1 Evaluation Classic module

Using the tool icons, Edit menu commands or the right-click menu, results may for ex-
ample be copied, deleted, or renamed.

IE T ar
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>

Note:

The Result Navigator pane features are described in Section 4.2 Locate results,

on page 30.
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3 The UNICORN Evaluation Classic module
3.1 Evaluation Classic module

Result Navigator Auto Hide

The Result Navigator may either be displayed open in the left portion of the Evaluation
Classic module, or the Auto Hide function can be selected by clicking the pin symbol in
the top right-hand corner of the pane.

Pindi-  Function

rection

Auto Hide is off. Click the pin symbol to turn the function on.
[A] x |~
L
Auto Hide:
- Auto Hide is on. Click the pin symbol to turn the function off.

If Auto Hide is selected, the Result Navigator opens automatically when the mouse
pointer is placed over its tab. It remains open as long as the mouse pointer remains over
the pane. The pane closes automatically when the pointer is moved outside.
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3 The UNICORN Evaluation Classic module
3.1 Evaluation Classic module

The Chromatogram pane

The illustration below shows the Chromatogram pane.

“Chrom.1 | Chrom. 1 (1) : Capto achere 007 -

—— v 1_280_Chram A:Run 1 — Cond_Chram 1:Run 1 —— UV 1_280@01,6ASEM_Chrom.1:Run 1

mau
s012
200

5948

4128

& UV 1_260@01 PEAK

Peak data | Integration summery

Ho Peak name | Relention (m] | Area (mFméll] Height [wal]]
D | .28 502.1320 96.458
2 5012) 12021460 200,751
3 59.48 966.7461 111.350

The current result contains two chromatograms. The chromatograms are displayed by
clicking the corresponding tab. A Peak Table is also displayed under this chromatogram.
Peak Tables are described in detail in Section 5.2.3 Display peak data, on page 108.

Docking chromatogram panes

If a result contains several chromatograms, each chromatogram will be displayed in its
own pane. The chromatograms can be stacked on top of each other and selected by
clicking the corresponding tab. They can also be arranged in various positions using a
docking function. The arrangement of chromatograms is described in Section 5.5.1 Open
and compare chromatograms, on page 162.
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3 The UNICORN Evaluation Classic module

3.1 Evaluation Classic module

Design of Experiments results
The illustration below shows the Design of Experiments pane in the Evaluation Classic

22

module.

Experiment | Anslysis | Prediction | Optimization |

Experiment W Factor Fiesponse
ExpNo  Run Result Date created Included ColumnType Load Additive Asymmetiy Area
scouting test 005 06/27/2008 10:46:10 O
NODZ OO scouting test 005 06/27/2008 10:4:48 O
NOoo2 ooz scouting test 002 06/27/2008 10:44:14 O
NOD4 003 scouting test 003 06/27/2008 10:44:52 O
NOOG oo scouting test 001 06/27/2008 10:42:36 O
NODE 007 scouting test 007 06/27/2008 10:47:28 O
Noo7 004 scouting test 004 06/27/2008 10:45:32 O
rl i} | >
Replace Result... Insert Result.. Add Response. . k Remove Response..

Evaluation of Design of Experiments results including analysis, prediction and optimiza-
tion of experiments is described in UNICORN Method Manual.
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4 View and present the results

4 View and present the results

About this chapter

This chapter describes how to present the chromatograms and curves of your result file
and how to create and print reports.

In this chapter

This chapter contains these sections:

Section See page
4.1 Open and view results 24
4.2 Locate results 30
4.3 Optimize the presentation of chromatograms 40
4.4 Print chromatograms and peak data 60
4.5 Run documentation 63
4.6 Generate reports 75
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4 View and present the results
4.1 Open and view results

4.1  Open and view results

Introduction

All contents of the result files are opened in the Evaluation Classic module where you
can analyze the results and compile reports. The Evaluation Classic module user interface
and toolbar icons are described in Section 3.1 Evaluation Classic module, on page 14.

The result files that are located in folders accessible to you are shown in the Result
Navigator. There are different ways to locate the specific result that you are looking for.
Section 4.2 Locate results, on page 30 describes this. However, in this section an additional
aid to identify a certain result and locate specific curves is also described. This preview
function is called Quick View. This section also describes how to highlight curvesin a
chromatogram, read curve values using a marker and save curve data as a Snapshot.

How to open specific chromatograms and curves is described in Section 5.5.1 Open and
compare chromatograms, on page 162 and Section 5.5.2 Open and compare curves, on
page 169.

Open a result in the Evaluation
Classic module

There are four ways to open a result from the Result Navigator:

¢ Select aresult and press the Enter key

or

¢ Double-click a result

or

* Right-click a result and click Open on the shortcut menu

or

e Select aresult and click the Open toolbar button in the Result Navigator.

Open

Result: The result is opened in the chromatogram pane.
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4 View and present the results

4.1 Open and view results

Only one result at a time may be opened this way. If you open a new result, the previous

result will automatically close. However, you may open several chromatograms from

different results. This is described in Section 5.5.1 Open and compare chromatograms,

on page 162.
Note:

When working in a network environment, it is not possible to edit the same

result file from two different locations simultaneously. If the result is already
open at another network workstation, you can only open it in read-only mode.
A message similar to the illustration below will open.
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—— UV 1_280_Chrom.1:Run 1

5012

— IV 1_280@01 BASEM_Chrom.1:Run 1

1935751 34

100 120 140 160

A: UV 1_280@01 PEAK. |

[E3

Peakc data | Integration summany

No
»

1
2
3
4
5
E

Peak name | Retention m])

151
41.29
50.12
6348
14353
151.34

Brea [mi*mal]
19.1449
602.1820
1202.1460
9667461
0.7350
14.3524

Height (maLl]

5.680
96,458
200.751
111.350
3.562
3.056
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4 View and present the results
4.1 Open and view results

Aresult may contain several chromatograms and corresponding peak tables, which will
open as one or several tabs. Each chromatogram can be selected by clicking the corre-
sponding tab. The selected tab has a light color and its information is displayed in the
active window.

The chromatograms may also be shown simultaneously if you click Tile All Chro-
matograms on the View menu.

Highlight or select a curve

You can highlight or select an individual curve in the chromatogram. The table below
describes the differences:

If you... Then... ‘

hold your mouse pointer | a pop-up box will display the curve name.
over a curve segment

hold your mouse pointer | the curve and the short line segment in front of the curve
over a curve name name become bold.

clickacurvesegmentor | the Y-axis shows the values for this specific curve.
a curve name

— uw,znn,cnmm.mum — Cond_Chrom.1:Run 1

BRERSHLHBRIFERER

26 UNICORN 7.0 Evaluation Manual 29-1108-88 AA



4 View and present the results
4.1 Open and view results

Insert a vertical marker

The vertical marker is used to measure the values for a specific curve position. Right-
click in the chromatogram and click Vertical marker. Move the marker along the X-axis
and read the X-axis and Y-axis values of the selected curve in the box in the top left
corner of the chromatogram.

+<: 34.034 ml
- 5 926 mall — ID101 a 002:1_UV 1_280
maL
g00
a0
o0
6350
00 +
250
00
430
400
550
300
230
200
150
100
a0
o
-50
-100 ml
o 5 10 15 20 25 30 35 40
Note: The marker will measure the curve that currently is selected if several curves

are displayed in the chromatogram. The marker will have the same color as
the selected curve.

Set marker reference

You can use the vertical marker for more measurements than just the readings from a
specific curve position. The following table describes how to use the marker to determine
Delta Peak and Mean Y-axis values.

Step Action

1 e Position the marker where you want to begin the measurement.

e Right-click and then click Set vertical marker reference point.

Result: The reference point is set to the position shown in the box in the top
left corner of the chromatogram.
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Step Action

2 « Drag the marker to the point where you want the measurement to end.

Result: The measured area is colored as illustrated below:

A Chrom.l | Chrom.1 (1) ; HiScreen Capto CIEX 001

2 55130 ml

" 2 376 mall - .
Diela: 9390 ml 4 _280_Chirom 1 :Run 1

tdear: 2503 mal 5012
bdir: 2,376 mall
b aw 2543 mal
180
170
160
150
140
130
120 2945
110
100
an
an
0
0]
=0
40
30
20
10

0 I
20 30

41.29

o)

w1 2an rheom 1Bm 1L 50 0

3 e Read the Delta and Mean values from the box:

e 55130 mil

N2 3TE mall
Delka: 9.391 ml
kMearn: 2.503 mall
kir: 2376 mall
kMax 2543 mal
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Snapshots

4 View and present the results
4.1 Open and view results

You can take a Snapshot of all the curve values at the marker position. The following
table below describes this:

Step

Action

1

e Insert a vertical marker where you want to take the Snapshot.
e Right-click, and then click Snapshot.
Result: The Snapshot dialog opens.

¢ Click Save to save the Snapshot

Result: The Save As dialog opens and you can save the Snapshot as a
text file.

or

o Click Print to print the Snapshot
Result: The Print dialog opens and you can print the Snapshot using the
selected printer.

Note:

Snapshots taken during the method run are saved directly to the result and
can be accessed by clicking the Snapshot sub-tab in the Result Information
tab of the Documentation dialog.

Click Close to close the Snapshot dialog.

Note:

The snaphot will record only the values of curves that are displayed. Curves
that are filtered will not be recorded.

UNICORN 7.0 Evaluation Manual 29-1108-88 AA 29



4 View and present the results
4.2 Locate results

4.2  Locate results

Introduction

With exception for the Administration module, there are navigator panes available in
all UNICORN modules. The navigator panes can be used to locate and open methods
and result files and to arrange files in folders.

The Result Navigator in the Evaluation Classic module consists of the same type of
navigator pane as the other UNICORN modules, but also contains a pane for Recent
Runs and a specific search pane, Find Results. If desired, the Result Navigator can also
display methods.

Show the navigator pane
To open and display the navigator panes, either
¢ click the Result Navigator on the View menu
or

¢ click the Open Result Navigator toolbar button.

6.

Note: As described in the general overview of the Evaluation Classic module in Sec-
tion 3.1 Evaluation Classic module, on page 14, Auto Hide can be selected for
the navigator panes.

Navigator toolbar

The following table shows the navigator toolbar buttons:

Button Function

Opens the selected result.

Open Note:

Selected items can also be opened by clicking Open on the File menu or by
double-clicking the file in the navigator pane. The Open command on the
right-click shortcut menu can also be used to open selected chromatogrames,
curves or peak tables.

30 UNICORN 7.0 Evaluation Manual 29-1108-88 AA



4 View and present the results
4.2 Locate results

Button Function

Creates a new folder in the folder that is currently selected.

'|:r" ~ | | Note:
This function is also available by clicking New Folder on the File menu or
clicking New Folder on the right-click shortcut menu.

Performs a Refresh in the navigator pane to update all items to the current
Y | status.

Note:

This function is also available on the View menu. However, note that the
Refresh menu command will update both the items in the navigator pane
and items open in the module. The navigator toolbar button will only update
the navigator pane.

Opens the View Details list where the following optional information
v columns may be selected for display in the navigator pane:

e System
e Created by

e Last modified date

‘.E -

v Swstem

v Created by

v  Last modified

Filter settings

The Result Navigator will normally show only results and Design of Experiments results
(Design of Experiments are only available for some systems). This is the default filter
setting for the items that are displayed. However, the navigator may also show items
that primarily are used in another UNICORN module, i.e., methods and method queues.
The options are:

* Results, DoE Results - showing only items that are relevant in the Evaluation Classic
module

e All - showing all items including method items and archived items
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4.2 Locate results

e All except Archived - only archived items are filtered

Note: The navigator panes will only show folders that you have access to. Your access
rights to folders are defined in the Access Groups and Network Users in the
Administration module. The user setup process is described in the UNICORN

Administration and Technical Manual.

Expand and collapse folders

When you select a folder in the navigators, the folders and results immediately below
the selected folder are displayed.

If you have expanded the folder structure to lower levels, you may want to collapse all
folders below a selected top folder, to simplify browsing.

¢ Right-click a folder and click Expand/Collapse All.

Open

Quick Miew, ..

Mew Folder  Chrl+h
Rename Fz

Copy Chrl+C

Cut Chrl+
Delete Del
Expand/Collapse all %
Properties

Result: The folder structure is collapsed to the selected folder level.

File properties

You can display some of the properties of a selected result in the navigator pane.

32

¢ Right-click a result and click Properties.

Result: The Properties dialog opens.
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4.6 fractionation ID51 021 Properties

General | Fesult |

M ame:

Created by:
Created:

Last Modified by:
Last Modified:

4.6 fractionation 1051 021

Foger
09/26/2008 15:45:33
Foger
10/16/2008 13:38:31

Cloze
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4.2 Locate results

The Recent Runs pane

The Recent Runs pane shows all the available recorded recent runs based on the selected
user preferences. The following table describes how to use Recent Runs to locate and
open a result.

Step

1

Action

Click the Recent Runs tab in the Result Navigator.

Result: The Recent Runs pane opens.

Fiesults | FecentRBuns | Find Results

Refresh ] [ Freferences...

Remove Remave Al

.| Run005 [AensW/0ver night - Week end run:
.| Run004 [AensW/0ver night - Week end run:
| RunD03 [/AensWw/0ver night - Week end run:
| RunDD2 [/lensWw/0ver night - Week end run:
[]] Manual Run 001 [/Staffan/P2-04 [Manual))

Note:

Until the files and chromatograms in the list have been opened and saved
manually, they are noted in bold text. When they are opened and saved the
text is changed to plain text.

If needed, click Refresh.

Result: The Recent Runs list is updated with all runs that were performed
since the Result Navigator was opened the last time.

Locate and double-click the desired result.

Result: The result opens in the Evaluation Classic module.

Note:

34

Click the + signs to view or select individual chromatograms from the results.
Individual results can be selected and removed from the list by clicking Re-
move.Remove all clears the whole list. Remove and Remove all only clear
the list, the results are not deleted.
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Recent Runs preferences

The Result Navigator will display Recent Runs based on the individual user preference
settings. The table below describes how to adjust the preference settings:

Step Action

1 Click Preferences.

Result: The Preferences dialog box opens.

Preferences

Maximum number of results to keep:
M aximum no of days to keep results:

() Results created by the current user only
(O Results created by the specifisd users:
(&) &l accessible results

[] Remave results when saved

I ak. %J [ Cancel
2 ¢ Type the maximum number of results to keep on the list.

¢ Type the maximum number of days to keep the results on the list.

3 Select which results to display on the list:
« Only results created by the current user.
e Allresults created by specified users.

Note:

Click Specify to open a dialog box and select from a list with all accessible
users.

o All accessible results regardless of the creator.

4 o Click Remove results when saved if the results are to be removed from
the list when they have been saved.

Result: All new results will be displayed on the Recent Runs list based on the
changed preferences.
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4.2 Locate results

Search for results using Find

Results

36

The Find Results function in the Result Navigator is used to locate results in the available
folders.

Note: There is also a common Find function which is available in the Edit menu of
all modules except the Administration module.

The table below describes how to use the Find function to locate and open a result.

Step Action

1 « Click the Find Results tab

Result: The Find Results pane opens.

e Type aresult name or part of a result name in the Result name box.

Note:

The standard wildcard character * can be used to represent a number of
characters before or after the partial result name.

or
e Type a Sample ID value in the Value of variable Sample_ID box.
Note:

A Sample ID can be set in the Start Protocol. The defined variable name
must begin with Sample_ID.
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Step Action

3 e Click Find.

Result: The located results are listed.

Note:

A search for DoE* as in the example below, will only find results that include
the text DoE, not Design of Experiments results.

Fiesults | Recent Rung | Find Results

Result name:
DoE”

Walue of variable 'Sample_ID"

[ Find | [ Advanced Find... |

= E‘] DoEmethod] 001 [/David/DoE Results]
a1

= E‘] DoEmethod] 002 [/David/DoE Results]
a1

] DoEmethod! 003 [/David/DoE Results]

1| DoEmethodl 004 [/David/DoE Results)

v | DoEmethod! 005 [/David/DoE Results)

| DoEmethod! 006 [/David/DoE Results)

- -

4 o Double-click the desired result or chromatogram

Result: The file or chromatogram opens in the Evaluation Classic module.

Note: Click Advanced Find for more advanced search functions, which are described
in the following topic.
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Search for result files using
Advanced Find Results

The table below describes how to use the Advanced Find Results function to locate and
open a result file.

Step Action

1 o Click Advanced Find
Result: The Advanced Find Results dialog opens.

Advanced Find Results

Folder. | /Roger/Results

Mame: ﬁ v|

Include subfolders

[#] Date from: | 2008-10-03 %
to: 20081121 »

Result content

Question:

Answer:

Walue:

|
|
W ariable: v
| |
|
|

Batch ID:

Find QJ[ Close |

2 o Click Browse to display the folder structure in a Browse Folder dialog,
and click a top folder to search in.

Note:
Your home folder will be selected by default.

e Type afile name or part of a file name in the Result name box.

Note:

The standard wildcard character * can be used to represent a number of
characters before or after the partial file name.

3 o Select if the search shall Include subfolders.

o Select if the search shall be limited to a range of creation dates.
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Step Action
4 If desired, specify Result content to search for results containing:
o Questions (as defined in the Start Protocol)
e Answers (as defined in the Start Protocol)
e Variable (specific names)
o Value (specific variable values)
e Batch ID (specific values)

Result: The file or chromatogram opens in the Evaluation Classic module.

5 e Click Find.
Result: The located files are listed in the Find Results pane.

¢ Click Close to close the Advanced Find Results dialog.

Note: Previous search qualifiers can be found in the lists by each text box. The
qualifiers are listed in reverse order with the latest qualifier on top:

Mame:

HETF*
Gel Filtration®

Cation®

DoE™

“Run b

Close the navigator pane

To close the navigator pane:

e Click the small cross in the top right-hand corner of the navigator.

Result: The navigator closes.
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4.3  Optimize the presentation of chromatograms

About this section

This section describes some of the ways you can optimize the presentation of a chro-

matogram.

In this section

This section contains these subsections:

Section See page
4.3.1 Customize the chromatogram layout 41
4.3.2 Edit curve presentation 46
4.3.3 Change the axes 51
4.3.4 Enter and edit text in chromatograms 55
4.3.5 Save and apply layouts 57

40
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4.3.1 Customize the chromatogram layout

4.3.1 Customize the chromatogram layout

Introduction

The Customize dialog box is used to make changes regarding chromatogram presenta-
tion. The main features of the Customize dialog box regarding chromatograms are de-
scribed in the subsequent sections in this chapter. Features regarding peak tables are
described in Section 5.2 Peak integration, on page 102.

Instruction

The folowing table describes how to make changes in the Customize dialog box:

Step Action

1 Open a result.
2 e Right-click the chromatogram and click Customize
or

o Click Customize on the Tools menu

or

o Click the Customize toolbar button.

74

Result: The Customize dialog box is displayed.
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4.3.1 Customize the chromatogram layout

Step Action

3 e Carry out the changes on the different tabs to get the desired layout for
header, curves and peck table.

Customize: Chrom.1

Curve Style and Color Edit Texts

Header Curve Names s Hediis

Select curves to display:

Layout Library

Peak Table

Curve

ORIEOO0NOREOOOEOOOOEERICCL

008: System flowe_Chrom, 1:Manual Bun 003

003: Systemn pressure_Chrom. 1:Manual Run 003

010: Cond temp._Chrom. 1:Manual Run 003

011: Fraction_Chrom.1:kManual Run 003

2 Uy 1_280001 BASEM_Chrom.1:Manual Run 003
013 Sample flow_Chrom.1:kanual Run 003

014: Sample pressure_Chrom. 1:Manual Run 003

015: PreC prezsure_Chrom,1:Manual Run 003

016: PreC 1 Hz pressure_Chrom. 1:Manual Run 003

my: Uy 1_280@01 BASEM [2)_Chrom.1:Manual Run 003
018: DelaC prezzure_Chrom.1:Manual Run 003

019: DelaC 1 Hz pressure_Chrom. 1:Manual Run 003

020: PostC prezsure_Chrom, 1:Manual Run 003

021 U 1_2800117,5U8 (1]_Chrom.1:Manual Run 003
022 Run Log_Chrom.1:Manual Run 003

023 Cone. 81_Chrom.1:Manual Run 003

024: Cone. B2_Chrom.1:Manual Run 003

025: Cone. 83_Chrom.1:Manual Run 003

026: Cone. B4_Chrom.1:Manual Run 003

027 L 1_280-27_Chrom. 1:Manual Run U1 to UMICORMN
028 Y 1_280-28_Chrom.1:Manual Run U1 to UMICORMN
093: Motor 0 pogition_Chrom. 1:Manual Run 003

[ Clear ][ Selectal |

54}

%Apply ta all chromatagramns

Ok

] [ Cancel

o Select Apply to all chromatograms if you want to apply changes made
in the Customize dialog to all open chromatograms.

4 Click OK to apply the changes.

42
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Tabs in the Customize dialog
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4.3.1 Customize the chromatogram layout

The folloeing table lists the tabs of the Customize dialog and outlines the editing functions

of each tab.

Tab

Header

Use this tab to...

select the items to be displayed in the header field above
the curves:

e Scouting variables
e Variables
e Questions

e Notes

Curve Names

select how the curve names are displayed. This is de-
scribed in detail in Section 4.3.2 Edit curve presentation,
on page 46.

Y-axis determine how the Y-axis is displayed. This is described
in detail in Section 4.3.3 Change the axes, on page 51.

X-axis determine how the X-axis is displayed. This is described
in detail in Section 4.3.3 Change the axes, on page 51.

Curve select the curves to display in the chromatogram.

Peak Table select the Peak Table settings. This is described in detail

in Section 5.2.3 Display peak data, on page 108.

Curve Style and Color

determine how the curves are displayed. This is described
in detail in Section 4.3.2 Edit curve presentation, on
page 46.

Edit Texts

edit any text that has been added to the chromatogram.
This is described in detail in Section 4.3.4 Enter and edit
text in chromatograms, on page 55.

UNICORN 7.0 Evaluation Manual 29-1108-88 AA

43



4 View and present the results
4.3 Optimize the presentation of chromatograms
4.3.1 Customize the chromatogram layout

Tab Use this tab to... ‘
Layout Library e select and apply a saved chromatogram layout
or

o delete a saved layout

or
e save the current layout.

This is described in detail in Section 4.3.5 Save and apply
layouts, on page 57.

Note: You can select to apply the settings in all tabs to all open chromatograms,
with the exception of text. Text entries can only be applied to the current
chromatogram.

Layout options in the right-click
menu

You can also change the chromatogram layout by clicking some menu items from the
right-click shortcut menu. The following table describes the layout options available on

this menu:
Click... when you want to...
Grid add a grid to the background of the chromatogram.
Filter Curves add a list of all available curves to the chromatogram,

with checkboxes to select the curves to display:

v

Uv 1 280 Chrom.1:HiScreen Capto CIEX 001 Y
— U 2 0 Chrom.1:HiScreen Capta CIEX 001 |_|
— U 3 0 Chrom.1:HiScreen Capta CIEX 001
Cond Chrom.:HiScreen Capto CIEX 001
— % Cond Chrom.1:HiScreen Capta CIEX 001
¥ =—— Copg B Chrom.1:HiScreen Capto CIEX 001
F;E\fshmmj HiScreen Capto CIEX 001

o

— Zystem pressure Chrom.:HiScreen Capto CIEX 001

Note:

Click the arrow buttons to show additional curves that do
not fit in the available space.
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when you want to...

Select Active Curve show only the active curve in the chromatogram.
Only (this option is available only when Filter Curves is selected)
Select All Curves show all curves in the chromatogram.
(this option is available only when Filter Curves is selected)
Legend show the list of all displayed curve names over the curve
area of the chromatogram.
e Time select the unit of the X-axis.
or
e Volume
or
e Column volume
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4.3.2

Edit curve presentation

Select curves to display

The Curve tab of the Customize dialog contains a list of all the curves included in the
chromatogram. Select the curves you want to display in the chromatogram, and click

OK.

Curve name appearance

You select options for the curve name appearance on the Curve Names tab. This is an

example of a default curve name:

ID101 a001:1 UV 1 280

The table below describes the three components that make up the default curve name:

Component Description Example ‘
Result name Name of the result. This is defined by the | 1D001 a 001
settings in the Result Name & Location
dialog in the Method Editor.
Chromatogram Number given automatically duringarun. | 1
name
Curve name Curve type, for example a monitor signal. | uv 1 280
Note: A chromatogram name may also be defined in the New Chromatogram text

instruction.

Choose curve name appearance

You can choose to view only part of the curve name. The table below describes how to
do this:

46

Step Action

1

2

Open the Customize dialog.

Click the Curve Names tab.

Select the appropriate boxes for Curve name appearance.

Click OK.
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Note: It is usually sufficient to select the Curve Name option if only one chro-
matogram is being evaluated. However, confusion can arise when more than
one chromatogram is shown, so more complete names might be necessary.

Curve style and color settings

All curves within a chromatogram are represented by a default color and line style.
Curves that are imported into the chromatogram or newly created curves are automat-
ically assigned a color and line style. The settings are available in the Curve Style and
Color tab. The tab also contains settings for peak labels, fraction marks and run log texts.

Change the color and style of a
curve

The table below describes how to change the color and style of a curve:

Step Action

1 Open the Customize dialog.
2 Click the Curve Style and Color tab.
3 ¢ Click the curve you want to change from the list.

o Click Colorto open the Color dialog and choose a color from the palette.

¢ Click a button to choose a Line style.

Select curve to modify color and linestyle for: Color: Line style:
i1 w1 280 - [ — ]
R (
1 [
(
[
& Conc, B
v

« Repeat step 3 to modify other curves.

4 Click OK to apply the changes.
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Peak labels

Peaks can be labeled on the Curve Style and Color tab. A combination of the following
labels can be selected:

*  Number

* Peak Name

* Retention (the default label).

You can also select Vertical or Horizontal alignment for the text.

Note: You will need to perform a peak integration and create a peak table before
the labels are displayed. The peak name is entered in the peak table. This is
described in Section 5.2.4 Edit the integration parameters, on page 112.

Align Fraction and Run log texts

Both Fraction and Run log text can be set either to be displayed when the mouse
pointer is positioned over a fraction mark (Fly over only) or at all times. The Fraction text
can be aligned both vertically and horizontally. Default setting for both text types is
Vertical. The Vertical selection for Run log text is the setting to show the text at all times.

Mumber Test alignment %ertical 3 Verlical
[] Pesk Name O Wertical Horizontal (7 Fly over only

. Harizartal
[ Retertion | © Horzonta O Fyaver only

Filter Run log information

48

The following table describes how to select the Run log entry and feedback types to
show in the chromatogram:

Step Action
1 Open the Customize dialog.

2 Click the Curve Style and Color tab.
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Step Action

3 Click Filter in the Run log text alignment field.
Result: The Filter Run log dialog opens.

4 « Select the entry types to show in the chromatogram.

¢ Select the feedback types to include in the run log entries.

Filter Run log 3]
Select run log types to show
Included entry types: Inciuded feedback types:
Set Mark lssued
Block Start [] Pracessing
Alarms, Warnings and Errors Completed
Methad Failed
b anual Ignored
System Cancelled
[ seectal | [ Clear |
[ Ok ] l Cancel l
o Click OK.
Result: The Filter Run log dialog closes.
5 Click OK in the Customize dialog to apply the changes.
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Add a grid

You can add a grid to the background of the chromatogram by selecting the Grid
checkbox.

maLl
300

280
260
240
220
200
180
160
140
120
100

g0

50

40

20

-20
-40
-B0
-80

[l
15 20 25 30 35 40 45 =0 o5

Note: You can also right-click in the chromatogram and click Grid on the shortcut
menu.
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4.3.3 Change the axes

Introduction

This section describes how to change the chromatogram axes according to your prefer-
ences. These changes are made in the Y-axis and X-axis tabs of the Customize dialog.

Change and fix the Y-axis

The following table describes how to change and fix the scale of the curves in the chro-
matogram Y-axis:

Step Action
1 Click the Y-Axis tab.
2

« Select the appropriate curve from the list.

o Click Fixed in the Scale for curve number field.

Customize: Chrom.1

Curve Style and Color

Select curve to modify axis scale for

]
002: L 2_0_Chrom.1:Manusl Bun 003 —
003: Lt 3_0_Chrom. 1:Manual Run 003
004: Cond._Chrom. 1:Manual Run 003

005: % Cond._Chram, 1:Manual Run 003
008: Cone. B_Chrom.1:Manual Run 003
007: pH_Chrarn. 1:Manual Run 003

008: System flow_Chrom.1:Manual Run 0
003: System pressure_Chrom.1:Manual R
010: Cond temp._Chrom. 1:Manual Run 01
072 Uy 1_280@01, BASEM_Chiom.1:Ma
013 Sample flow_Chrom, 1:Manual Run €
014: Sample pressure_Chrom.1:Manual Fi
015: PreC pressurs_Chrom. 1:Manual Fun
018: PreC 1 Hz pressure_Chram. 1:Manual
017: L 1_2806@01 BASEM [2]_Chram.1:
018: Deltal: pressure_Chrom, 1:Manual Ry
019: Deltal 1 Hz pressure_Chrom.1:Mam.
020: PostC pressure_Chrom. 1:Manual Rur
021: U 1_280@0117.5UB (11_Chrom.1:
023: Conc. O1_Chrom.1:Manual Bun 002
024: Conc. 02 _Chrom.T:Manual Bun 002
025: Conc. 03_Chrom.1:Manual Bun 002
026: Conc. 34_Chrom.1:Manual Run 002
027: v 1_280-27_Chrom.1:Manual Bun
028: L 1_280-28_Chrom.T:Manual Run —
0393: Motor 0 position_Chrom, 1:#anual Ru 2
100 Meter 1 esition Cheae T-banosl B
< | 3

Edit Texts Lapaut Library

Header Curve Names -Aiis Hedixis Curve Pezk Tabls

Scale for curve number D07

) Auto

Mir: M ax:
%Fixsd. -E000.001) |6000.00C| mAl
Allwith This Unit

Select which axes to display:
Left Axis
|DU4 Cond._Chrom.1:Manual Run 003 v|

Right &uxis
| Mong v |

[] Apply to all chromatograms
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4.3.3 Change the axes

Step

3

Action

e Type the desired minimum and maximum values.

o Click All with this unit if you want other curves with the same Y-axis
units as the current scaled curve to be similarly scaled.

Note:

The values will only be applied to existing curves. They will not be applied
to new curves created after this function was last used.

Click OK to apply the changes.

Select Y-axes to display

The following table describes how to select the Y-axes to display in the chromatogram.

52

Step Action
1 Click the Y-Axis tab.
2 e Click a curve for the left Y-axis in the Left Axis list.
« If youwant to add a second Y-axis, proceed with step 3. If not, jump to
step 4.
3 Click a second curve from the Right Axis list.
4 Click OK to apply the changes.
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4.3.3 Change the axes

Change and fix the X-axis

The following table describes how to change and fix the scale of the X-axis in the Cus-
tomize dialog:

Step Action

1 Click the X-Axis tab.

Customize: Chrom.1

Curve Style and Color Edit Texts Layaut Library
Header Curve Mames -Ais Hebiis Curve Peak Table
Base
) Time
® Volume

) Column Yalume

Az stale

® Auto
i Maw

Adjust retention zera bo injection number:

[] &pply to all chromatograms
2 Click the appropriate option in the Base field:
e Time
e« Volume

e Column Volume

Note:

Some calculated curves, for example baselines, exist in only one base and
might seem to disappear when the base is changed. Curves are collected in
time and recalculated for display in volume. Thus, switching the base between
Time and Volume can slightly alter the resolution of the displayed curves.
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4.3.3 Change the axes

Step Action
3 o Click the Fixed option in the Axis scale field to set the axis limits manu-
ally.
e Type the desired minimum and maximum values.

o Ifdesired, select the Adjust retention zero to injection number checkbox
and click an injection number in the list.

Note:

This sets the time/volume to zero at the selected injection mark. The time
and volume before selected injection will become negative values.

4 Click OK to apply the changes.
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4.3.4 Enter and edit text in chromatograms

Introduction

This section describes how to enter and edit text annotations in the curve field of the
chromatogram. The text is applicable to the active chromatogram.

Enter annotation text

The following table describes how to enter annotation text in the chromatogram:

Step

Action

1

e Right-click the curves view of the chromatogram window and click Add
text on the menu.

or

e On the Edit menu, click Text and then click Add.

¢ Click where you want to insert text in the chromatogram.

Result: A text box opens.

Change text

o Double-click inside the text box.
e Type the new text.

o Click outside the text box to set the text.

Note:

You can select and drag the text box to a new position with your mouse
pointer.
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4.3 Optimize the presentation of chromatograms
4.3.4 Enter and edit text in chromatograms

Edit annotation text

The following table describes how to edit inserted annotation text:

Step Action

1 On the Edit menu, click Text and then click Add.
Result: The Edit Texts tab of the Customize dialog is displayed.

Customize: Chrom.1

Header Curve Names s Hohis Curve Peak Table
Curve Style and Calor | Edit Tests ‘ Layaut Library

Texts in the chromatogram:

E_
Change text

Selected text:

|Chamge text

[ Change text ][ Delete text

Info

The “Apply to all chromatograms” check. box
does not apply to this page. The texts are
always specific to one chromatogram window,

[ Apply ta all chromatagiams
2 o Select the text that you want to edit and make the appropriate changes
in the Selected text field.

e Click Change text or Delete text.

3 Click OK to apply the changes.

Shortcut option
You can also double-click inside the text box to select the text. Then you can

* type new text

and

¢ click outside the text box to set the new text
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4.3.5 Save and apply layouts

Introduction

4 View and present the results
4.3 Optimize the presentation of chromatograms
4.3.5 Save and apply layouts

All configurations that you make in the Customize dialog can be saved as a layout. It is
possible to apply saved layouts to other chromatograms. Layouts can either be saved

as personal layouts for your own use only, or as global layouts that are available for

everybody with network access. You may also save a layout as your default setting. The
default layout will be applied automatically when you open a result.

Save a layout

The following table describes how to save a layout:

Step Action

1 Open the Customize dialog.

2 e Make the appropriate layout configuration within the various tabs.

o Click OK to see the applied affects of your changes.

e Return to the Customize dialog box to perform further changes.

3 Click the Layout Library tab when you are satisfied with the layout.

Customize: Chrom.1

Header Curve Hames W-dis

Hduis Curve Peak Table

Curve Style and Calor Edit Texts | Lapcut Library

Saved layouts:

Use Selected Layaut
Delete Selected Layout
Save Cunent Layout As..

Filter lapouts

(%) Show all lapouts

() Ghow global lapouts
) Show personal layouts

“wihat does this do™

Here pou can save all settings made on all
pages, except the "Edit Texts' page, in the
chromatogram layout dialog. You save the
settings bo a named file. You can then recall
those seftings by selecting the file in the list and
pressing the "'Use Selected Layout” buttan. A1l
zettings will then be restared as they were when
you saved the |apout. Use this to save your awn
often used layout settings. You can also use this
to create a default layout to be used whenewver
you open a hew resul file for the first time by
checking the "Save as default” check box in the
zave dialog.

€]

[ Apply to all chromatograms
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4.3.5 Save and apply layouts

Step Action

4 Click Save Current Layout As.
Result: The Save Layout dialog box is displayed.

Save Layout (3]

Save layout as;

In layout library
O Glabal

() Persanal

Save as default
Ok ] [ Cancel

5 e Type a name for the layout in the Save layout as box.
e Select if the layout should be Global or Personal.
« If you want the current layout to be the new default layout, select the
Save as default checkbox.
Tip:
The default layout will be applied automatically when you open a result.
6 Click OK to save the layout and close the Save Layout dialog.
Result: The new layout name is added to the Saved layouts list.
7 Click OK to close the Customize dialog.

Apply a layout
The following table describes how to apply a saved layout:

Step Action

1 Click the Layout Library tab in the Customize dialog.
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Step Action

2 e Select alayout from the Saved layouts list.
Saved layouts:
&?J:"ﬁﬁiiﬁi[ﬂ]ﬁ] Apply Selected Lapout L\\
011 s el
(& Show all layouts
() Show global layouts
() Show perzonal layouts
¢ If necessary, select which layouts to show in the Filter layouts field.
Note:
Personal layouts are noted with a (P), global layouts with a (G).
o Click Apply selected layout.
3 If the same layout is to be applied to all chromatograms on the Evaluation
workspace, select the Apply to all chromatograms checkbox.
4 Click OK to close the dialog and apply the changes.
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4.4  Print chromatograms and peak data

Introduction

This section describes how to print the chromatograms that are open in the Evaluation
Classic module.

The Print Chromatograms dialog

box
Following is an illustration of the Print Chromatograms dialog.
Note: The selected print format is outlined in red.
Print Chromatograms
Fririter: | Microzoft Office Document Image ‘Writer ha | l Properties... ]
Frirt Farrnat
L] n n == mm
A =M = B
Chromatograms in each column
Chraratograms in gach row
Uze thick lines
(]S %J [ Cancel l
Instruction

The following table describes how to print active chromatograms on the default Windows
printer.

Step Action

1 Open all chromatograms that you want to print in the Evaluation Classic
module.
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4 View and present the results
4.4 Print chromatograms and peak data

Action

e On the File menu, click Print.

or
o Click the Print result button.

=

Result: The Print Chromatograms dialog opens.

Select print format and layout options.

o Click OK to open the Print dialog and proceed with step 8.

or

e Proceed with step 5 to preview and edit the layout.

Click Preview.

Result: The Customize Report window opens.
o Click Edit Mode to make changes, for example to change the order of

the chromatograms (see Section 4.6.2 Create a new report format, on
page 79 for more information about how to edit).

o Click Preview to return to preview mode.

Note:

You can print directly from the Customize Report window or click Exit to re-
turn to the Print Chromatogram dialog.
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62

Action

o On the File menu, click Print.

or

o Click the Print button.

=

Result: The Print dialog opens.

Print (3]
Frinter:
Frint R ange Copies

[OF]

Mumber of copies
Ofages ||

Enter page numbers and/or page ranges
seperated by commas. For example 1,3.5-23

o Select the print range and number of copies.

e Ifnecessary, click Properties to open the printer properties dialog where

the settings for your printer can be changed.

e Click OK to print the chromatograms.
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4.5 Run documentation

Introduction
The full documentation for a method run is stored in the result. This section contains:
* aninstruction how to view and print the run documentation,
e alist and short descriptions of the contents of the run documentation,

* aninstruction how to save the text instructions from the run as a new method.

View and print the run
documentation

The following table describes how to view and print the run documentation.

Step Action

1 Open a result in the Evaluation Classic module.
2 e Onthe View menu, click Documentation
or

e Click the Documentation button.

EE

Result: The Documentation dialog opens.

See further information about the tabs and contents below.

3 e Click Print.

Result: The Print dialog opens.
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4.5 Run documentation

Step Action

4 e Select the documentation items you want to print.

Note:

Items that do not contain any information cannot be selected. If you select
a group heading (e.g., Result information) all sub-headings that contain
information will automatically be selected.

Print rz|
Frinter: |Adobe FDF v| [ Froperties... ]
Iberrs:

Test instructions Result infarmatian
Yariable list Praperties

Start pratocal Run summary
Columnz Mame and location

[] Fraction callectar

[] System infarmation

[] Calibratian

[] Evaluation log tethod infarmation

Fun log Properties

[ (0]8 L\\\J [ Cancel
5 Click OK to print the selected items.

The Documentation tabs
The following table describes the contents of the Run Documentation tabs.

Note: Some of the items listed below may be excluded from the Run Documentation.
Tabs will only be shown if the item exists in the result.

Documentation tab Contents

Result Information The Result Information tab contains general information
about the result.

See "The Result Information tab" in this section.
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Documentation tab Contents

Evaluation Procedures

Method Information

The Evaluation Procedures tab shows all procedures that
have been run during or after the method run. See Sec-
tion 7.3 Automated evaluation procedures, on page 231 for
information about how to work with evaluation proce-
dures.

The Method Information tab shows the general Properties
of the method:

¢ Name

¢ When and by whom the method was created

¢ When and by whom the method was last modified
¢ The system and Instrument Configuration that the

method was created for

Click Details to view comprehensive information about
the Instrument Configuration.

The Method Information tab also contains a listing of all
the electronic signatures that have been added to the
method, under the sub-tab Signatures.

Start Protocol

The Start Protocol tab shows the method items that were
included in the Start Protocol at the start of the method
run.

System Information

The System Information tab shows the system settings
during the method run, for example

¢ UV, conductivity and pH settings
e Pumps and pressure settings
e Air sensor settings, watches and alarms

« Fraction collection settings

UNICORN 7.0 Evaluation Manual 29-1108-88 AA

Calibration The Calibration tab shows a calibration report for the
system.
Run Log The Run Log tab shows selected log entries and feedback.

See "The Run Log and Evaluation Log tabs" in this section.
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4.5 Run documentation

Documentation tab

Evaluation Log

Contents ‘

The Evaluation Log tab lists all of the evaluation opera-
tions that have been performed for the result during all
sessions, including at the end of the method run. The log
also shows when the result has been accessed without
editing after the end of the method run.

See "The Run Log and Evaluation Log tabs" in this section.

Fraction Collector

(system specific)

The Fraction Collector tab shows an image of the cas-
settes, tubes and well plates used in the fraction collector.
This tab is only shown if fractionation has been chosen
as a component in System Properties in the Administra-
tion module.

Variable List

The Variable List tab shows all the method variables and
corresponding values, listed by the method block where
they appear.

The list can show detail and/or unused variables. At this
stage, the variable values are no longer possible to edit.

Scouting

Text Instructions

The Scouting tab shows the scouting parameter settings.
This tab corresponds to the Scouting settings in the
Method Editor.

The Text Instructions tab shows all the text method in-
structions from the method.

These instructions can be saved as a new method. This is
described in "Save the method used for the run as a new
method" in this section.

Notes

The Notes tab shows all notes that have been made re-

garding the method, the method run and the subsequent
evaluation. The notes are divided into the following sub-
tabs:

e Method Notes
o Start Notes
e Run Notes

e Evaluation Notes

You can add new notes on the Evaluation Notes sub-tab.

Note:
Click Find to search for specific text in the Notes.

66

UNICORN 7.0 Evaluation Manual 29-1108-88 AA



4 View and present the results
4.5 Run documentation

Documentation tab Contents

BufferPro

(system specific)

Columns

The BufferPro tab shows the BufferPro settings, including
the recipe settings, the stock solutions and a general de-
scription.

The Columns tab shows information about the columns
used during the method run. It contains two sub-tabs:

Column type

The Column type tab shows general information about
the type of column that has been used, including:

« general Run Parameters

e column Details (dimensions, volumes, bed heights,
etc)

e Ordering Information
Column

If Column logbook is enabled the Column tab shows spe-
cificinformation for the column that has been used, includ-

ing:
e |ID numbers
e Media Batch ID and expiration date

e number of runs the column has been used for

e results from performance tests
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The Result Information tab

The table below describes the sub-tabs and contents of the Result Information tab:

Result Infor- Contents

mation sub-

tab

Properties The Properties sub-tab shows general information about the result:
« Name
e BatchID

« When and by whom the result was created

¢ When and by whom the result was last modified

e The system and Instrument Configuration that was used for
the method run

Click Used Components to view a list of all components and moni-
tors that were used for the run.

Click Details to view comprehensive information about the Instru-
ment Configuration.

Signatures The Signatures sub-tab contains alisting of all the electronic signa-
tures that have been added to the result.

RunSummary | The Run Summary sub-tab (illustrated next) shows a summary of
the run expressed in volume or time per phase and block.

The phases and method blocks within the phases are shown as
they appear in the Text Instructions.

The method base can be toggled between time and volume by
clicking Time or Volume.

Snapshots The Snapshots sub-tab shows all snapshots that have been taken
during the run.

NameandLo- | The Name and Location sub-tab shows the search path to the re-

cation sult, as an image of the folder structure where the result is saved.
This sub-tab corresponds to the Result Name and Location dialog
in the Method Editor.

Data Migra- The Data Migration sub-tab shows details on the result data migra-

tion tion.
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‘ Spstem Information || Calibration || Fun Log ” Evaluation Log | Questions |
| Warablelist | Testlnstuctions | Motes | Columns | Method Infomation ‘ Fresult Information Start Protocol
| Propetties || Signatures | Fiun Summary | Snapshots H Mame and Locat\on‘
Base Unit
@ Time ) Yolume l:l
Block Start End Length

Hain 0.000 16.247 16.247

Method Settings [Phase] 0.000 0.063 0.063

0.1 prm filter [Phase] 0083 0.077 0.013

MALS and R [Phase] 0077 0.050 0.013

E quilibration [Phase] 0.090 1.068 0.978

Equilibrate 0110 1.085 0.955

Sample Application [Phase] 1.068 1.502 0.433

Prepare sample loading 1.068 1.068 0.000

Inject 1.088 1.488 0.420

Elution [Phase] 1.502 16.247 14.745

lsacratic 1.522 16.247 14725

FPrint ] [ ak. ] [ Cancel
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The System Information tab

The table below describes the sub-tabs and contents of the System Information tab:

System Information sub-

tab

System Settings

Contents

The complete list of system settings is shown here, in-
cluding for example:

e UV settings

o Conductivity settings

e pH alarm settings

e Pumps and pressure settings
e Air sensor settings

e Fractionation settings

e Watch settings
etc.

Operational Statistics

(system specific)

The operational statistics for the instrument compo-
nents are shown here, for example:

e UV Cell component Id number
e UVlamp run time

e Mixer component Id number
e Number of pump strokes

e Valve operations
etc.

Mixer Size and UV Cell
Path Length (system spe-
cific)

The UV cell and Mixer specifications are shown here,
including

e UV cell path length

¢ Mixer volume

70
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Documentation

Calibration

“Wariable List Text Instructions Notes

Fun Lag
Method Information

Evaluation Log

Fiesult Information | Start Prolocol |

System Settings | Opsrational Statistics | Mixer Size and LY Cell Path Length

System Information

Fraction collector arm:
Serial Number: 1473336
Frac arm moves: 9536
Accumulator moves: 2604

Miker:

Serial Mumber, 1475992
Hiser chamber serial rumber:
Mixer un time: 224 hour
Spstem pump A,

Serial Mumber: 1477894

No of strokes: 184151

Pump run time: 160 hour
System pump B

Serial Mumber: 1477695
No of strokes: 203207

Pump run time: 152 hour
Sample pump:

Serial Mumber, 1477896

Ko of strokes: 26137

Pump run time: 11 hour
Duatemnary valve:

Serial Mumber 1475964
Kurnber of tuns for O1: 20266
Kurnber of tums for O2: 20566
Nurnber of tums for O3 20376

Print 0K

J {

J

Cancel

The Run Log and Evaluation Log

tabs

The Run Log and Evaluation Log are similar but cover different process cycles.

Run Log

Wariahle List Text Instructions
System Information

Nates C
Calibration

Methad Information Result Information

| Evalugtion Log

Start Protocol

Questions

09 min Batch ID: fOFS5EFT 404 74589801 -scdecdd] dizé

03 min Base CV, 2,945 {ml}, Superdex 200 5150 GL

09 min Phase Method Settings lssued] (Processing) [Completed)
09 min Base Samedshain

08 min Noise reduction U 5.0 {sec} [lssued) (Processing]
08 min Noise reduction Uy 5.0 {sec} [Completed)

08 min Injection walve Manual load (Issued) [Processing)
08 min Injection valve Manual load [Completed)

NA rain Cohran mnzitioe 1 Don o le2edl Procsccinnl

-1.
-1
-1
-1
-1
-1
-1
-1
-1.08 min “Wavelength 280 {nm} 420 {nm} 214 {nm} (Completed)
-1
-1
-1
-1.
A1
<

09 min Alam pre column pressure Enabled 10.00 {(MPa} 0.00 {MPa} (Issued) (Processing]
03 min Alaim pre column pressure Enabled 10,00 {MPa} 0.00 {MPa} (Completed)
09 min Wavelength 280 {nm} 420 {rm} 214 fnm} lssued) (Processing

09 min Method Run 5/22/2012 5:38:49 PM +02:00 Method: Sup200 old 5_150 LAMay16_2012 120522 no col valve Result /De A

Included enty types:
Set Mark
Block Start

Included feedback types
[] Frocessing
Campleted

ssued

Alarms, Wamings and Erors

Method

Hanusl

System

Adiust retention zero to infection number

Base

@ Time
 Yolume

Pt | |

J

Cancel
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The Run Log shows settings and events from the initial start of the method run up to
the end of the run.

The displayed run log can be filtered to show only selected entry and feedback types.
The Base can be shown either as Time or Volume and the retention zero can be adjusted
to a selected injection.

Evaluation Log

Documentation
VaiableList | Scouling
Start Protocol

Testnshuctions | Notes | Colmns |  Method Information

System Information Calbration Fiun Log |

2010-06-28 16:28:46 +02:00
2010-06-28 16:23:00 +02:00
2010-06-28 16:23:00 +02:00
2010-06-28 16:25:00 +02:00
2010-06-25 16:25:00 +02:00
2010-06-28 16:25:00 +02:00
2010-06-28 16:25:00 +02:00
2010-06-28 16:25:00 +02:00

2010-06-28 16:25:00 +02:00
2010-06-28 16:25:00 +02:00
2010-06-28 16:29:00 +02:00

g ystem, UNICORN
Logging started. User, Roger, UNICORN 5.1.0.435.
Command SET_COLUMN_HEIGHT{ 10 ) applied on Chiom.1.

Command SET_COLUMMN_YT( 17.2 ) applied on Chrom.1

Command SET_COLUMN_V0{ OFF } applied on Chrom 1

Command SET_SKIM_SIZE_RATIO( OFF ] applied on Chiom 1

Command MEGATIVE_PEAKS( OFF | spplisd on Chiom. 1

Command REJECT_PEAKS( OFF, DFF, OFF, OFF, 20 spplisd on Chiom.1

Command CALCULATE_BASELINE_MORPH(1.12. 0.0933531825008332. 4. 41631464706734.

2 3442076471156 ] applied on Chrom. 1
Command SUB( 1,12, 17 ] applied on Chrom.1

Command PEAK_INTEGRATE[ 17, A applisd on Chiom 1
Command CLEAR( 17 ) pplied on Chiam.1

| ResultInformation |
Evaluation Log

]

[ Print

J

Ok

J [

Cancel

J

The Evaluation Log is initiated by the first evaluation action and additional entries are
added every time the result is accessed.

The evaluation operations are listed in the order that they have been performed. The
date, time and time zone is shown for each entry.

Search for log entries

The following table describes how to find specific text in the logs.

Step Action

1

72

Select the log tab where you want to perform your search.
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Step Action

2 e Click Find.

Result: The Find dialog opens.

Find what: |Alarm delta colur pressung | [ Find Met
Direction: |
‘I\]Eancel
[ Match whale word enly () Up -

[Shift+F3]
[ Match case (&) Dawn [F3]

3 ¢ Type the text you want to locate in the Find what box.
Note:

Your previous search text may be shown in this box if you have used the
search function before.

e Select additional search criteria:
- Match whole word only
- Match case
- Search up

- Search down

o Click Find Next.

Result: The first log entry where the search text is found is marked.

Save the method used for the run
as a new method

You can save the method and the variables that were used for the run as a new method
as described in the following table.

Note: It is not possible to re-create a method in UNICORN 7.0 from a result that has
been migrated from UNICORN 5.

Step Action

1 Click the Text Instructions tab.
2 o Click Save as.

Result: The Save As dialog box opens.
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Step Action

3 e Select the appropriate destination folder.
e Type a name in the Name box.
e Click a system in the System list.

4

e Click OK.

Result: The method is saved.
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4.6  Generate reports

About this section

The Evaluation Classic module provides extensive tools to create detailed reports. This
section describes how to create and print reports and how to customize the report lay-
outs.

In this section

This section contains these subsections:

Section See page
4.6.1 Generate and print a predefined report format 76
4.6.2 Create a new report format 79
4.6.3 Edit an existing report format 95
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4.6.1

Introduction

Generate and print a predefined report format

This section describes how to generate and print a report using a format that has been
defined and saved.

Should you need to store your reports in an electronic format you can also save them
as PDF files. This section describes how to do this.

Generate and print the report

76

The following table describes how to select a format and print the report:

Step Action

1 e Onthe File menu, click Report

or

e Click the Report button.

A

Result: The Generate Report dialog opens.

2 e Select the Format for the report by clicking the format name.
Generate Report ®
Format
[Global] i
o
Note:

Global report formats are noted by the text "Global" before the report
format name in this list.
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Step Action

3 o Click Preview to view the report in the Customize Report window and
click the Print button

or
o Click Print in the Generate Report dialog.
Result: The Print dialog open

4 e Click a printer in the Printer list.
« Select a Print Range, all pages or just selected pages.

e Select a number of copies.

Result: The report is printed on the selected printer.

Note: Click Edit mode in the Customize Report dialog to change the layout. You can
either print the edited format from this mode and close the Customize Report
dialog without saving the changes or save the edits when you close the dialog.

Save the report in PDF format

The generated report can be saved as a PDF file, regardless if Adobe™ Acrobat™ is in-
stalled on the computer or not. The two alternatives for saving the report are described
below:

Save the report with Adobe Acrobat installed

Step Action

1 Perform steps 1 to 3 in the "Generate and print the report” instruction above.
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4.6.1 Generate and print a predefined report format

Step

6

Action
e Click an Adobe PDF printer on the Printer menu.

Print ®

Frinter: | [EEaA=0a

Frint R ange Copies

@a Mumber of copies

OPages [ |

Enter page numbers and/or page ranges
seperated by commas. For example 1,3.5-23

€]

Note:

You must have a full installation of Adobe Acrobat or a suitable PDF creation
application to be able to do this.

e Click Properties and edit the document properties if needed.

o Select the print range and number of copies.

e Click OK.

Result: The report is created as a PDF file and saved in the location specified
in your Acrobat settings.

Save the report without Adobe Acrobat installed

Step

Action

1

9

10

11

Perform steps 1 to 2 in the "Generate and print the report”instruction above.
Click Preview to view the report in the Customize Report window

On the File menu, click Save As PDF.

Result: The Save As dialog opens.

e Browse for a folder and enter a File name for the report.

o Click Save.

Result: The report is created as a PDF file and saved in the location specified
in the dialog.
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4.6.2 Create a new report format

Introduction

This section describes how to create a new, customized report format. You can choose
from a variety of objects to include in a report, including chromatograms, methods,
documentation, free text and more. You can also place, align and size the objects as you
please.

Note: Click Preview/Edit mode to toggle between the Preview mode which is for
view only, and the Edit mode where you can edit the report items. The editing
actions in this section are only available in the Edit mode.

Open the Customize Report
window

The following table describes how to open the Customize Report in Edit mode to create
a new report format.

Step Action

1 Open a result in the Evaluation Classic module.
12 « On the File menu, click Report.
or

o Click the Report button.

i

Result: The Generate Report dialog box opens.

13 e Click New.

Result: The Customize Report window opens in Edit mode.
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The Edit mode window

The followingillustration shows the Customize Report window in Edit mode with a blank
report open:

Customize Report; UNTITLED, B®
File Edit Wew Insert layout  Help

Pieview FievPage NewPage OneFage 50% = AddPage [elele foe Ext

i T S |

e =] & == [

IF‘agM of1 Edit Mode o

Toolbar buttons in the Customize
Report window

The following table describes the different functions of the toolbar buttons in the Cus-
tomize Report window:

Toolbar button Function ‘

Preview/Edit mode This button toggles between a print preview of the report
and the Edit mode.

Prev Page This button displays the previous page or pair of pages (if

there is more than one page).

Next Page This button displays the next page or pair of pages (if there
is more than one page).
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Toolbar button Function

One Page/Two Pages This button toggles between single page view and pairs
of pages view (if there is more than one page).

Select the magnification of the view in this list.

0%
5%

100%:
150%:
200%:
S00%:

Whole Page
Add Page This button adds a blank page to the report.
Delete Page This button deletes the current page from the report.
Exit This button closes the Customize Report window.
Note: The general toolbar buttons are described in the following topic. The toolbar

button for specific formatting operations are described in the instructions for
how to use the functions.

General toolbar buttons

The following table describes the different functions of the general toolbar buttons in
the Customize Report window:

Toolbar icon Function

Opens a new, blank report.

Note:

You can also choose the File:New menu command.

Opens the Open Report Format dialog. You can choose
__*.1 to open a previously defined format for editing.

Note:
You can also choose the File:Open menu command.
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Toolbar icon

Function ‘
Saves the edited report format.

Note:
You can also choose the File:Save menu command.

Cuts the selected object from the report.

Note:
You can also choose the Edit:Cut menu command.

Copies the selected object in the report.

Note:
You can also choose the Edit:Copy menu command.

Pastes a copied or cut object from the clipboard into the
report.

Note:
You can also choose the Edit:Paste menu command.

Add or delete report pages

The following table describes how to add or delete report pages:

If you want...

to add new pages,

to delete a page while
in One Page mode,

e click Add Page.
Result: A new page is added after the last page.

e select the page with Next Page or Prev Page,

e click Delete Page and confirm the deletion.

to delete a page in Two

e select the page with Next Page or Prev Page,

Page mode,
e click an object on the page,
o click Delete Page and confirm the deletion.
Note: * On the Edit menu, click Delete or press the Delete key to delete objects,

not whole pages.
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e The number of pages in the Edit mode does not always correspond to the
number of printed pages. Click Preview in the toolbar for a print preview.

Change the page layout

The page layout is changed in the Page Setup dialog. The following table describes how
to set up the page layout:

Step Action

1 e Double-click anywhere on the report page (not on an object)
or

e Right-click (not on an object) and click Properties on the shortcut menu

or
« On the Edit menu, click Page setup.
Result: The Page Setup dialog box opens.

Page Setup %)
Page Setup |F00ter First Header | Header
Margins
Top: i
’ e
Battarm: inch Oem
Left: 0.59 inch
ke oss | ol
Right: 053 inch
Settings
[] Same header on all pages
%Draw a frame around the pages
(] 8 ] [ Cancel
2 ¢ Type new values for the Margins if necessary.

o Click the appropriate Settings and Units.

Note:

An extra Header tab will appear if you clear the Same header on all pages
checkbox. The First Header tab is used for the first page header only, and the
Header tab is used for all subsequent pages.
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Step

3

Action

o Click the First Header tab.

e Select all the items you want to include in the header from the Select
Items list.

e Click Font to change the font for all items if necessary.

o Type header text in the Free text box and click Font to alter the default
font if necessary. This text will be placed on top of the header.

e Type the report title in the Report title box and click Font to alter the
default font if necessary. The title is centered immediately above the
page contents.

If you want to have a line under or over the header, select the appropriate
option in the Layout field.

e Repeatsteps 3 to 5onthe Footer tab and the subsequent pages Header
tab.
Note:

All Header and Footer tabs contain the same options. You can have all infor-
mation in either the header or footer or split information between the header
and footer as required.

Click OK to apply the changes.

Add objects to the report

The following table describes how to add objects to the report. The various objects are
described in the next topics.

84

Step

Action

1

e Click the appropriate button in the Report items toolbar.

or

e Click an object on the Insert menu.
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Step Action

2 ¢ Press and hold the left mouse button on the report page, and drag out
a box to the size of the item you want to insert.

Note:

The mouse pointer shows a symbol for the type of item you have selected.
e Release the mouse button.
Result: A Setup dialog opens. The dialog is specific to the type of item that

you want to insert.

3 o Select the desired Settings, for example Start on new page, and click
OK.

Result: The object is inserted onto the page.

Note: * Ifyou want to edit an object later, double-click the object box.

* Thesize of the object in Edit mode does not always correspond to the size
in the printed report. Click Preview for a print preview.

Add free text

The following table describes how to add free text to the report:

Step Action

1 e Click the Free Text button.

T

e Press and hold the left mouse button on the report page and drag out
a box to the size of the text. Release the button.

Result: The Setup Free Text dialog box opens.
2 Type text in the edit field.
3 Select the appropriate Settings:
e Start on new Page: the text is to start on a new page
e Size to content: the text box should be automatically sized

« This position on all pages: the text should appear in the same position
on all pages, for example as header and footer text.
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Step Action

4 o Click Font to change the default font.
Result: The Font dialog box opens.

e Make the necessary changes and click OK to return.

5 e Click OK

Result: The text object is inserted onto the page.

Add a picture

The Picture dialog box is useful to insert logos, pictures or other figures in the report.
The following table describes how to add a picture object to the report:

Step Action

1 e Click the Picture button.

-4

]

e Press and hold the left mouse button on the report page and drag out
a box to the size of the picture item. Release the mouse button.

Result: The Setup Picture dialog opens.
2 o Click Browse to locate the desired picture file.
e Select the picture file and click Open.

Note:

A number of image file formats are supported, for example .bmp, .gif,
.emf, .jpg and .tif.

Result: A preview of the selected picture is displayed.
3 e Select the desired Settings (Start on new Page, Size to content).

Result: The picture is inserted onto the page.
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Add a chromatogram or peak
table

The following table describes how to add a chromatogram and/or peak table to the report.

Step Action

1 e Click the Chromatogram button.
A
e Press and hold the left mouse button on the report page and drag out
a box to the size of the chromatogram/and or peak table. Release the
mouse button.
Result: The Setup Chromatogram dialog opens.
Setup Chromatogram
Selected Chromatogram(z)
hromatogram
Settings Fontz
[ Thick lines
[ Start on new page
[IFullpage
[ Original file name
Lapout
[ Current
[ ak. ] [ Cancel
2 Click which chromatogram(s) to insert in the Selected chromatogram(s) list.

e Active chromatogram inserts the chromatogram that currently is active
in the Evaluation Classic module.

e All chromatograms inserts all chromatograms that are open in the
Evaluation Classic module.

e 1,2 etc,inserts the corresponding chromatogram.
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88

Step

3

5

Action

Select the desired Settings.
If desired, change the Fonts.

Note:
Separate fonts can be selected for the Chromatogram, the Peak table
and the Header text.

Click Define in the Layout field if you want to re-define the layout of the
chromatogram.

Result: The Report Customize dialog box opens.

Make the appropriate changes and click OK to return to the Setup
Chromatogram dialog box.

Note:

- All curves can be de-selected in the Report Customize dialog box
leaving only the selected peak table(s) in the report.

- The changes that you make will only affect the report and not the
view of the chromatograms in the Evaluation Classic module.

Tip:

If selecting Current layout, the chromatogram will appear as in the Eval-
uation window, for example with the current zooming.

Click OK.

Result: The chromatogram is inserted onto the page.
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Include a method

The following table describes how to include a method in the report:

Step Action

1 o Click the Method button.

e Press and hold the left mouse button on the report page and drag out
a box to the size of the item. Release the button.

Result: The Setup Method dialog opens.

Setup Method El
Selected items will be included
Main Method Fonts
7 ok

Text..

Settings

[] Start on news page

Expand main
0k, ] l Cancel ]
2 Select the items to be included in the report:

e Main Method is the method on which the run was based.

e Blocks are the blocks that were used in the method.

3 o Select the appropriate Settings (Start on new page, Expand main).

Note:
Expand main displays the expanded method view.

« If desired, change the Fonts for the Title and Text.

Result: The method object is inserted onto the page.
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Add documentation

90

The table below describes how to add documentation to the report:

Click OK.

Step Action
1 o Click the Documentation button.
e Press and hold the left mouse button on the report page and drag out
a box to the size of the item. Release the button.
Result: The Setup Documentation dialog opens.
Setup Documentation g|
Selected items will be included [}
Yanable list A | SelectAl
Scouting
Start protocol
Questions
[] Ewaluation procedures Fonts
Method information
Method notes
Start notes
=l Bun natas b’
[ 5tart on new page
ak. ] [ Canicel
2 Select the items to be included in the report:
o Select All includes all items in the report.
e Clear All removes all selections.
3 « If desired, change the Fonts for Title or Text.
e Select if the documentation should start on a new page.
4

Result: The selected documentation items are inserted into the report.
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The following table describes how to add the Evaluation Log to the report:

Step Action

1 o Click the Evaluation Log button.

e Press and hold the left mouse button on the report page and drag out
a box to the size of the item. Release the mouse button.

Result: The Setup Evaluation Log dialog opens.

2 « If desired, change the Fonts for Title or Text.

e Select if the Evaluation Log should start on a new page.

3 o Click OK.

Result: The Evaluation Log is inserted into the report.

Move and resize objects freely

The following table describes how to select, move and resize objects freely:

If you want to... then...

select a single object,

e click the Select button,

R

o click the object of interest.

select several objects,

o click the Select button,

« pressand hold the Ctrl key while you click the objects.

move the selected
objectl(s),

click on the objects, hold down the left mouse button and
drag the object(s) to the new position.
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If you want to...

resize the selected
objectls),

then...

click one of the object border anchors, either in the corners
or in the middle of a border, and drag the box to the new
size.

Note:

Some Text objects cannot be resized.

Alignment toolbar buttons

Objects can be placed in exact positions and sized in relation to other objects. The table
below describes the function of the Alignment toolbar buttons in the Report Editor:

Toolbar button Function
Align left
|""'_I Matches the left alignment of all selected objects to that
— of the highlighted object.
Align right
_Ijl Matches the right alignment of all selected objects to that

of the highlighted object.

Align top

Matches the top alignment of all selected objects to that
of the highlighted object.

||_
e

Align bottom

Matches the bottom alignment of all selected objects to
that of the highlighted object.

|

Adjust to margins

Stretches the selected object(s) to the left and right mar-
gins.

Adjust to left margin
Adjusts the selected object(s) to the left margin.
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Toolbar button Function

Adjust to right margin

-il Adjusts the selected object(s) to the right margin.
!
Adjust to center
* Adjusts the selected objectls) to the center of the page.
o

Make same size

Adjusts the selected objects to the same size as the high-
lighted reference object.

Make same width

Adjusts the selected objects to the same width as the
highlighted reference object.

Make same height

Adjusts the selected objects to the same height as the
highlighted reference object.

Note: The Make same size and Make same width buttons can only be used to resize
the width of chromatograms, free text and picture objects.
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Save the report format

94

The following table describes how to save the finished report format:

Step Action

1 o On the File menu, click Save.
or
e Click the Save button.
Result: The Save Report Format dialog box opens.
2 e Type a name for the format.
o Select if you want to save the format for global use.
o Select if you want to save the format as default.
Note:
The name for the default format will automatically be changed to
DEFAULT.
3 o Click OK to save the format.
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4.6.3 Edit an existing report format

Introduction
This section describes how to edit an existing report format.

Note: By clicking the Preview/Edit mode button, you can toggle between a print
preview of the report and an editing mode. The editing actions are only avail-
able in the Edit mode.

Edit a saved report format

The following table describes how to edit a saved report format in the Evaluation Classic
module.

Step Action

1 Open a result file.
2 « On the File menu, click Report
or

o Click the Report button.

)

Result: The Generate Report dialog opens.

3 o Select areport format to edit.

o Click Edit.

Result: The Customize Report window opens.
4

« Make the necessary changes to the report format.

Note:

Once you have made a change, the title bar of the window will add the
word Modi fied to the report format name.
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Step Action

5 e On the File menu, click Save

or
o Click the Save button.

Result: The edited format is saved.

6 To return to the Evaluation Classic module window:

e Onthe File menu, click Exit

or

o Click the Exit button.

7 o Click Close to close the Generate Report dialog.

or

o Select another report format to edit.

Note: See Section 4.6.2 Create a new report format, on page 79 for instructions
about how to add or edit report items. You can also click Save As on the File
menu in the Customize Report window, to save the edited format under an-
other name and keep the original report format unchanged.
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5 Evaluate results

About this chapter

This chapter describes how to perform a number of editing and evaluation operations
on your results, for example:

e peak integrations
¢ baseline operations (editing and optimization)
¢ fraction and peak operations (how to pool fractions, etc.)

e comparison of different runs

For information about how to view results, see chapter Chapter 4 View and present the
results, on page 23. Curve operations and automated evaluation procedures are described
in chapter Chapter 7 Other evaluation operations, on page 213.

Note: Analysis and evaluation of Design of Experiments results is described in
UNICORN Method Manual.

In this chapter

This chapter contains these sections:

Section See page
5.1 Subtract a blank run curve 98
5.2 Peak integration 102
5.3 Baseline operations 131
5.4 Fraction and peak operations 149
5.5 Compare different runs 161
5.6 Multi Result Peak Compare wizard 181
5.7 Rename folders, results, chromatograms, curves and peak tables 192
5.8 Sign results electronically 193
5.9 Save results 195
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5.1 Subtract a blank run curve

Introduction

Subtracting a blank run curve is useful to improve the peak integration parameters if
the curves have a drifting baseline or ghost peaks.

Ghost peaks

If the ghost peaks come from impurities in the eluents, all equilibrations of the columns
should be the same from method run to method run. If, for example, the equilibration
volume with buffer A is larger before a blank run curve than before a separation, your
ghost peaks might be higher in the blank run curve. See Section 7.1.2 Reduce noise and
remove ghost peaks, on page 218 for further information.

Example of a UV curve with
baseline

The illustration below shows a UV curve with a baseline, prior to subtraction of the
baseline:
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Example of a UV curve after
subtraction of the baseline

The illustration below shows the UV curve above, after subtraction of the baseline:

How to import a blank run curve

If a blank run curve was made, this might have been stored in another result. The following
table describes how to import the blank run curve:

Step Action

1 Ensure that the destination chromatogram has been opened and is the active
tab in the Evaluation Classic module.

2 On the File menu, click Open, then click Curves.

Result: The Open Curves dialog box is displayed.

3 Double-click the result that contains the blank run curve.

Result: The curves in the first chromatogram are displayed.
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Step Action

4 « Click the appropriate chromatogram in the Available curves list.

Result: The curves for that chromatogram are displayed in the field below.

5 e Click the curves that correspond to the blank run curve and click the
Select button.

Result: The selected curve is displayed in the Selected curves field.

6 e If youwant to remove a curve from the field, click it and then click the
Remove button.

e Click OK to import the curve.

Note: Ifthere is no blank run curve available, you can create one by clicking Calculate
baseline on the Integrate menu as described in section Section 5.2.2 Perform
a peak integration, on page 105. For more detailed information on how to import
curves, chromatograms and other results see Section 5.5 Compare different
runs, on page 161.
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5.1 Subtract a blank run curve

You can subtract the blank run curve or the baseline from the sample curve. The following

table describes how to do this:

Step Action

1 On the Operations menu, click Subtract.

Result: The Subtract dialog box is displayed.

Subtract 3]
Source chromatogram and curve: Source chiomatogram and curve: Target chromatomiam and curve:
[ chrom 1 v [Chom v Chiom 1
o0: U 1_280 ~ 012 U 1_280¢201 BASEM ~

0l | 002 U 2.0 = 017 UV 1_280@01 BASEM (2] =

00UV 30 o3 UV 30 021: W 1_280¢0117 5UB (1)

004: Cond, 004: Cond. 027 W 1_280-27 -

005: % Cond. 005: % Cond, 026: LY 1_280-28

006: Conc. B 006: Conc. B [FE]

007: pH 007: pH 030

008: System flow 008: System flow 31

009: Spstem pressure 00%: System pressuie 032

010 Cond temp. 033

012: UV 1_280¢@01 BASEM 034

013 Sample Aow W W 035:

014: Sample pressure 014: Sample pressure 036:

015: PreC pressure 01%5: PreC pressure 037

016: PreC 1 Hz pressure 016: PreC 1 Hz pressure 038 v

017: UV 1_280¢@01 BASEM (2] 07 UV 1_280@01 BASEM (2)

016: Deltal pressure 0118: Delal pressure Curye name:

91? Eellagl: 1Hz pressure v 913 Qa\ta_li 1 Hz pressure v Uy 1_280@0112,5U8

2 ¢ Select the sample chromatogram and curve in the chromatogram list
and curve field to the left.
e Select the baseline or blank run curve to be subtracted in the middle list
and field.
Note:
The suggested curve number is highlighted in the Target chromatogram
and curve field. A default name is displayed in the Curve name box.
Note: All resulting curves from the subtract operation receive the SUB suffix by de-

fault. The default curve name can be changed as needed in the Curve name

box.
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5.2 Peak integration

About this section

Peak integration is used to identify and measure a number of curve characteristics in-
cluding peak areas, retention time and peak widths. This section describes:

¢ how to calculate a baseline, perform the peak integration and display the data
and

* how to perform some special operations, for example peak exclusion.

In this section

This section contains these subsections:

Section See page
5.2.1 Baseline calculation 103
5.2.2 Perform a peak integration 105
5.2.3 Display peak data 108
5.2.4 Edit the integration parameters 112
5.2.5 Integrate part of a curve 124
5.2.6 Exclude or skim peaks 128
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5.2.1 Baseline calculation

Introduction

The first step when you integrate peaks is to calculate a baseline. A correct baseline is
crucial for accurate calculation of the peak areas. This section describes the options for
how to calculate baselines in the Peak Integrate dialog.

Baseline options
UNICORN offers several options for how to create an accurate baseline:
* To use the automatic Calculate baseline function.
¢ To create a baseline based on a blank curve.
* To use a Zero baseline.

* Toreuse an existing baseline.

The Calculate baseline function

The Calculate baseline instruction provides automatic calculation of the baseline. In
most cases the measurement is very accurate. The calculation can be performed using
the Morphological algorithm or the Classical algorithm.

Baselines based on a blank curve

A blank curve can be used as the baseline for peak integration.

* You can use a blank curve with the same chromatographic conditions as the corre-
sponding sample.

or

* You can subtract the blank run from the source curve and then perform peak inte-
gration on the resulting curve with the Calculate baseline instruction.

Note: In addition to blank run curves, it is also possible to select any curve from the
current chromatogram as the baseline (e.g., an edited baseline.)
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Zero baseline

To use a Zero baseline means that there is no baseline subtraction at all. The baseline
will be a straight line at the zero level.

Reuse an existing baseline

Using an existing baseline for the selected curve is the default alternative whenever
there is an existing baseline available. The option Correlated baseline is selected if this
is the case.
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5.2.2 Perform a peak integration

Instruction

5 Evaluate results
5.2 Peakintegration
5.2.2 Perform a peak integration

The following table describes how to perform a basic peak integration.

Step Action

1 Open a result file in the Evaluation Classic module.

2

or

¢ Onthe Integrate menu, click Peak Integrate.

o Click the Peak Integrate toolbar button.

Result: The Peak Integrate dialog opens.

Peak Integrate

Chromatogran:

‘ Chrom. 1

1]

o02: Uy 2.0
003 Uy 3.0
004: Cond,
005: % Cond.
006: Conc. B

007 pH

008: System Faw

003: System pressure

070: Cond temp.

012: Uy 1_260E01, BASEM
073: Sample Aow

074: Sample pressure

075: PreC pressure

076: PreC 1 Hz pressure

Target peak. table:

.
B: =1
I

o

E-

F

G:

H:

I:

J: __
K

L

M:

(£

Peak table name:

017 UY 1_280@01.BASEM (2) v [uv 1_280@01 PEAK
Bazeline;
| Calculate bassline v [ Peak Window... |
Column height [bed height): cm
Column Wt: I:l
Save and Edit Peak Table..&l [ ok ][ cance
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5.2.2 Perform a peak integration

Step Action

3

Tip:

Select a source chromatogram and curve.

Click a baseline or a calculation method in the Baseline list.

Click OK to integrate with the default selections.

or

Proceed with steps 4 to 6 to change the default selections.

Click Baseline settings to change the calculation algorithm in the Set-
tings dialog box. The default algorithm is Morphological.

Change the selections or values.

Note:

See also Section 5.3.2 Optimize the baseline with a morphological algo-
rithm, on page 136 and Section 5.3.3 Optimize the baseline with a classic
algorithm, on page 140 for more information about how to edit baseline
settings.

Click OK.

Click Peak window to edit the peak window limits if necessary.

Click Reject peaks to set the parameters for peak rejection if necessary
(See Section 5.2.6 Exclude or skim peaks, on page 128).

Edit the Column height (bed height) or Column Vit values if necessary.

If a result from an intelligent packing method that includes a packing test is
evaluated, the bed height of the column may have to be adjusted to the
measured bed height to achieve the correct column performance test values.

106

Click OK to integrate and close the dialog box.
or

Click Save and Edit Peak Table to save the integration and open the in-
tegrated curve for editing.

- See Section 5.3.1 Edit the baseline manually, on page 132
- See Section 5.2.4 Edit the integration parameters, on page 112
- See Section 5.2.5 Integrate part of a curve, on page 124

- See Section 5.2.6 Exclude or skim peaks, on page 128
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Peak integration results

The peak table is displayed underneath the active chromatogram. The start point and
end point of each peak are marked by vertical marks, drop-lines, in the chromatogram.
The peaks are automatically labeled according to what is selected in the Curve Style
and Color tab of the Chromatogram Layout dialog box. A summary of the integration
and the settings used can be viewed by clicking the Integration summary tab.

This is an illustration of the results after a peak integration:

/" Chrom.1
—— UV 1_280_Chrom.1:TtT labtest run 001 — lnigction Chrom 1:T4T lab test run 001 — U 1_260@01 BASEM_Chrom 1:THT |
mAL
190 10810
185
180
75
170
165
160
155
150
145
140
135
130
125
120
s 8508
110
105
100
95
30
85
B30
ke
70
BS
B0
55
S0
45
40
3=
30
2
20
15
10
5
0
-5
=10
0 10 pal 30 40 50 B0 70 &80 90 100 110 120 130 140 150 160 170
ALY 1_280@07 PEAK
Peak data | |ntegration summary
Ho Peak name  Retertion [ml) | Area (mPmall) | Height (méL1)
r 1 e 8506 627.9613 109.561
2 10910 15237130 186,666
3 181.04 48.2300 4.766
Note: Peak tables can be copied from one chromatogram to another by clicking

Copy between chromatograms on the Edit menu. The copied peak table
name will have the default ending coPpy.
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5.2.3 Display peak data

Introduction

There are a number of options for how to display and edit the peak data and peak table
contents. This section describes some of these options. Other options are described in
Section 5.2.4 Edit the integration parameters, on page 112.

Peak characteristics

108

The peak retention times and several other peak characteristics are calculated automat-
ically. The following table describes how to display other peak characteristics.

Step Action

1 e Right-click in the active chromatogram.

¢ Click Customize on the shortcut menu.

Result: The Customize dialog opens.

2 Click the Peak Table tab.
Curve Style and Color Edit Texts Layout Library
Header Curve Names s Haiis Curve Peak Table
Select table to display: Select peak table columns:
NOMNE | |[#] Peak name ]
Peaktable-A: LY 1_280@01 PEAK. 1 |[#] Retention Cul
Peaktable-B: LY 1_280@01,COPY M width
Peaktable-C: =
X ] &rea
Peaktable-D: = . .
Peaktable-E: [ Pgak endpoint rgtentlons
Peaktable-F: [] idth at half height
Peaktable-G: [[] Percent of total area
Peaktable-H: [[] Percent of total peak area
Peaktable-l: [¥] Height
Peaktable-]: [] Type of peak limits
Peaktable-t: 71 Peak endoaint height
Peaktable-L: L_| Feak endpaint heignts
Peaktable-M: | | Fraction tube id . |
Peaktable-N: | |[] Baseline height v
[] Height less than: Fill peaks
[] 'width less than: Patterm

[ &rea less than:

N
)z
||

[ 'width mare than:

[] Peak must be ane af: 20 largest

[] Da not show global peak table data
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5.2.3 Display peak data

3 ¢ Select options from the Select peak table columns list.

e Click OK.

Result: The selected items will be displayed in the peak table.

How to filter peaks from view

Peaks can be removed from display in a peak table. The following table describes how

to filter the peaks:

Step Action

1 e Right-click in the active chromatogram or peak table.

e Click Customize on the shortcut menu.

Result: The Customize dialog opens.

2 Click the Peak Table tab.

3 o Select the checkboxes in the Filter Peaks field to select the filter criteria.

o Specify filter values.

Tofilter peaks vs. to reject peaks

The table below describes the major differences in the effects of filtering peaks compared
to excluding the peaks by rejection (which is decribed in Section 5.2.6 Exclude or skim

peaks, on page 128).

Filter peaks... Reject peaks...

excludes the pecaks from display,

permanently excludes peaks from the in-
tegration,

does not exclude the peaks from the
calculation of the total peak area,

excludes the peaks from the calculation
of the total peak areaq,

can be reversed.

cannot be reversed.
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Peak labels

110

Peaks can be labeled with their retention, sequentially numbered, or be marked with
specific identification names. See the following table for an instruction on how to display
peak labels.

The label type can be selected on the Curve Style and Color tab in the Customize dialog.
Clear all label options to hide the labels, for example for presentations.

The illustration below shows the Customize dialog with the Curve Style and Color tab

opened:

Customize: Chrom.1

Header Curve Names YAz Habiig Curve Peak T able
Curve Style and Color Edit Testz Layout Libram
Select curve to modify color and linestyle for: Colar: Liree style:
1 Wwizw = @ (—
- 2 WZO 3 (
3 UY3E0 E (
4 Cond, (
(
& Conc. B
7 pH
-
Peak label Fraction text alignment Fiur log text alignment
Mumber Text alignment (®) Vertical @ Vertical
[] Peak Name O vertical () Horizontal () Fly owver anly
[ Retertion, | © Horizonta O Fly over only
[] Grid
[] Apply to all chromatograms [ [1]4 ] ’ Cancel

The following table describes how to display peak labels:

Step Action

1 e Right-click in the active chromatogram or peak table.

e Click Customize.

Result: The Customize dialog opens.
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Step Action

2 Click the Curve Style and Color tab.
3 Select one or more of the following labeling options in the Peak label field:
e Number

Result: The peaks will be numbered sequentially.

e Peak Name

Result: Peak names will be displayed. See Section 5.2.4 Edit the integration
parameters, on page 112 for information about how to name the peaks.

e Retention

Result: The retention volume or time will be displayed.

4 Select if the label should be aligned vertically or horizontally in the Text
alignment field.

5 Click OK.

Measurement options

It is possible to determine the coordinates of any point on a curve and to obtain values
for retention and peak height. This is a useful tool for many other functions, such as for
measuring the parameters used in baseline calculations.

Coordinates can be obtained in two ways:

* Through direct measurement using the Vertical marker. This is described in Sec-
tion 4.1 Open and view results, on page 24.

e From peak table data.
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5.2.4 Edit the integration parameters

Introduction

Once a pecak table has been generated based on an appropriate baseline, it is possible
to split or join peaks and to manually adjust the peak start and end points. The peaks
will then be renumbered and the peak values will all be recalculated.

The changes are made in the Edit Peak Table dialog. In this dialog you can also add
peak names that may be used as labels in the chromatogram.

Open the peak table for editing

The following table describes how to open the peak table for editing. The editing options
are described below.

Step

Action

1

4

e On the Integrate menu, click Edit Peak Table.
Result: The Edit Peak Table dialog opens.

Note:

If there are several peak tables in the result, the dialog will open for the peak
table tab that is selected. The name of the baseline on which the peak table
was based is displayed in the dialog.

Perform the changes (described in the instructions below).

e Click OK.

Result: The Save Edited Peak Table dialog opens. The dialog displays a
suggested name and location for the peak table.

Confirm the name and location and click OK.

Note:

112

The Edit Peak Table dialog will be opened immediately if you select Save and
Edit Peak Table as the last step of the peak integration.
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The Edit Peak Table dialog
The illustration below shows the Edit Peak Table dialog:

Edit Peak Table - [U¥ 1_280@01,PEAK (1)]

File  Edit Baselne  Integrate
& I + -
a e =
SN,
— L1 280 — UV 1_280@01,BASEM-Edited
malJ
400
350 2
300
230
200
150 +
100
3
a0
L
o Ij_'_'_ | |
mi
o 2 4 =3 g 10 12 14 16 18 20 22 24 26
Peak data |
Mo Peak name = Retention [ml] | Fetention at start [ml] | Retention at end [ml] | Area [mlfmal]
L 0.4 0.32
2 T
3 20.91 20.69
(] 8 ] [ Cancel

Toolbar buttons in the Edit Peak
Table dialog
The following table describes the toolbar buttons in the Edit Peak Table dialog.

Button Function

Activates the Zoom mode. When it is activated, you can use the mouse
pointer to drag out an area to be zoomed in. This is described in The zoom

i
Al e .
7« function below.

Activates the Edit Peaks mode. In this mode, you can select a peak and
@ edit the start and end points. This is described in Edit the peaks manually
below.
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Button

Function ‘

Activates the Set Curve Points mode. In this mode, you can select baseline
curve points for editing and add new points to re-draw the baseline. This
is described in Adjust the baseline below.

Activates the Peak Window mode. In this mode you can restrict the part
of the curve that the peak integration is performed on. See Section 5.2.5
Integrate part of a curve, on page 124 for more information.

Returns the result to the state it was in before the last change (Undo).

Note:
This function can also be selected in the Edit menu.

The zoom function

The following table describes how to use the zoom function in the Edit Peak Table dialog.

Step

Action

1

Click the Zoom button.

Result: The mouse pointer is changed into % .

e Position the mouse pointer over the left topmost position of the area
you want to zoom in on.

e Press and hold the left mouse button.
Drag the cursor over the area you want to zoom in on.

Release the mouse button.

Result: The area is enlarged.

Note:

A Zoomed mode note will be displayed in the top righthand corner of the
chromatogram when the zoom function has been used. Right-click, then click
Reset Zoom to return to the full display.

114
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Peak start and end points

The beginning of each peak is marked with a dropline above the curve, and the end of
each peak is marked with a dropline below the curve. The illustration below shows an
example of start and end point droplines:

Where there are two adjacent peaks, the end of the first peak will be at the same point
as the beginning of the next peak. Thus, there will be a dropline below and above the
curve at the same point. See the illustration below:

Edit the peaks manually

The start and end points of a peak can be adjusted graphically by moving the droplines
in the Edit Peak Table dialog. The following table describes this:

Step Action

1 Click the Edit Peaks button.

Result: The mouse pointer is changed into £L

2 e Click the peak you want to edit.

Result: The peak is highlighted and marker lines show the start and end
points.
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Step Action

3 e Position the mouse pointer over the marker line that you want to change.

Result: The pointer is changed into a double-arrow symbol.

31.96

30 35

e Drag the marker to a new position with the mouse pointer.

Result: The start or end point droplines of the peak are changed and the
corresponding values are updated in the peak table.

Note: A dropline can never be moved beyond another dropline or beyond a point
where the peak meets the baseline.

Adjust the baseline

The baseline can be adjusted graphically (see also Section 5.3.1 Edit the baseline manu-
ally, on page 132) in the Edit Peak Table dialog. The following table describes this:

Step Action

1 Click the Set Curve Points icon.

Result: The mouse pointer is changed into + .
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Step Action

2 Perform one or more of the operations below as desired:

o Click toinsert a new data point.

2% a0 33 40 43

« Double-click on a data point or right-click the point and select Delete
Point from the shortcut menu to delete the point.

¢ Click a data point and drag the point to a new position to move the
baseline.

Result: The baseline is edited and the peak table values are recalculated
accordingly.

Note: Accept negative peaks must be selected before the peak integration if you
want to be able to drag a data point to move the baseline above the curve.
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Calculate a new baseline

The baseline can be recalculated in the Edit Peak Table dialog. To alter the baseline
settings:

Step Action

1 e Onthe Baseline menu, click New then click Calculate.

Result: The Settings dialog opens.

Baseline Settings

Chozen algorithm

() Clagsic

(®) Morphological

Baszeline

Structure width: ml

Minimum digtance between points: 3449 ml

Default alues

ak. ] [ Cancel ]
2 Click an algorithm (Morphological is default).
3 e Adjust the Baseline parameters as desired.

- Structure width

- Minimum distance between points
or

o Click Default Values for the default values.

Result: The baseline is recalculated.

Note: On the Baseline menu, click New then click Zero Baseline to replace the cal-
culated baseline with a zero baseline.
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Add color to a peak

The following table describes how to add a fill color and a pattern to an individual peak
in the Edit Peak Table dialog:

Step Action

1 Click the Edit Peaks button.

Result: The mouse pointer is changed into @

2 Click to select the peak.
3 e Right-click and click Fill Peaks from the shortcut menu
or

e onthe Edit menu, click Fill Peak.

Result: The Color and Pattern dialog opens.

Color and Pattern 3]

Fill zettingz
Fill selected peaks

[ QK. ] [ Cancel

e Select the Fill selected peaks checkbox.

Result: The Color button and Pattern field will become available.

UNICORN 7.0 Evaluation Manual 29-1108-88 AA 119



5 Evaluate results
5.2 Peak integration
5.2.4 Edit the integration parameters

Step Action

5 e Click Color.

Result: The Color dialog opens.

Basic colors:

ey e § |
HTEE...
EEEEEEEN
ENEEEEEN
EEEEEEEN
O T

Cusztorn colors:
Hamssaal— Pt
Sat: Green:

Diefing Customn Colars 33 ColorSolid Lum: Blue:

[ Ok, l [ Cancel l [ Add to Custom Colors ]

6 o Click one of the Basic colors
or

e click Define Custom Colors to open the settings field and define new
colors (illustrated above).

« After you have selected a color, click OK to close the dialog.

7 o Click afill pattern in the Pattern field.
e Click OK..

Result: The peakis filled according to the selections.

Note: The color and pattern selections will override the general Fill settings that can
be selected for all peaks on the Peak Table tab in the Customize dialog for
the chromatogram.
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It is possible to split a peak into two new peaks by inserting a dropline. The following
table describes how to split a peak in the Edit Peak Table dialog:

Step Action
1 Click the Edit peaks button.
Result: The mouse pointer is changed into @
2 Click the peak in the curve or in the peak table to select the peak.
3 « Right-click and click Split Peak
or
« on the Edit menu, click Split Peaks.
Result: Anew dropline is inserted at the middle point between the two existing
droplines and the peak is split. The peak numbering and the peak table are
updated accordingly.
Note: The area under each new peak will not be the same if the symmetry of the

original peak was not perfect.

It is possible to join the areas of adjacent peaks if they are separated by a dropline. The
following table describes how to join adjacent peaks in the Edit Peak Table dialog:

Step Action
1 Click the Edit peaks button.
Result: The mouse pointer is changed into @
2 Click the peak in the curve or in the peak table to select the peak.
3

¢ Right-click and click Join Left or Join Right
or

¢ on the Edit menu, click Join Left or Join Right.

Result: The original intervening dropline is removed, all peaks are renumbered
and the peak table is updated.
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Add peak names
The table below describes how to add names in the Edit Peak Table dialog, to identify

122

the peaks:
Step Action
1 Click the Edit peaks button.

Result: The mouse pointer is changed into @

Click the pecak in the curve or in the peak table to select the peak.

e Right-click and click Peak Name
or

e onthe Edit menu, click Peak name

or
o double-click the peak.

Result: The Edit Peak Name dialog opens. The number and retention of the
selected peak is displayed.

Edit Peak Name

Peak Retention: I:I il
Feak Mumber; :l

Peak Mame: |anine Serunn Alburin |

[ 1]8 %—][ Cancel ]

Type a name in the Peak name box.

Result: The new name is added in the corresponding Peak name cell in the
peaktable. Itis also shown below the peak in the chromatogram. If you have
selected to show peak names in the chromatogram, it will also be displayed
over the peak.

Note:

You can also add a peak name by selecting the Peak name cell in the peak
table, click again in the cell and then type the peak name. A pencil symbol is
displayed by the peak number to indicate that you are able to enter the text.
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Delete peaks
The following table describes how to delete a peak in the Edit Peak Table dialog:

Step Action

1 Click the Edit Peaks button.

Result: The mouse pointer is changed into @

2 Click the peak in the curve or in the peak table to select the peak.
3 o Right-click and click Delete Peaks
or

« onthe Edit menu, click Delete Peaks

or
e press the Delete key.

Result: The peak is deleted, the remaining peaks are renumbered and the
peck table is updated.

The Integrate menu

If needed, you can click the commands on the Integrate menu to perform a peak inte-
gration in the Edit Peak Table dialog box. This is useful for example if you want to re-in-
tegrate the curve using different settings or integrate only part of a curve with different
settings.

See Section 5.2.5 Integrate part of a curve, on page 124 and Section 5.2.6 Exclude or skim
peaks, on page 128 for more information.
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5.2.5 Integrate part of a curve

Introduction

There are several possibilities to improve the results if the peak integration is unsatisfac-
tory. This section describes how to select only part of a curve for integration.

This partial integration can be performed both in the Integrate dialog in preparation for
the peak integration, or in the Edit Peak Table dialog to adjust an unsatisfactory peak
integration. Both alternatives are described here.

Select part of a curve for

integration

124

The table below describes how to select only a part of a curve for peak integration in
the Integrate dialog box:

Step Action

1 e Choose Integrate:Peak Integrate

or

e click the Peak Integrate icon.

Result: The Peak Integrate dialog opens.
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Step Action

¢ Click the Peak Window... button.
Result: The Set Peak Window dialog opens.

Set Peak Window ®

—— UV 1 265 Chrom.1:Manual Run 001
mal
19
18
7
18
1%
4
13
12
"
0
3

LR A A SR

e A

Left it 209 Right it ggtg] [ Ok | [ Cancel

€

o Type new X-axis values for the Left limit and the Right limit.
or

« drag the vertical cursor lines to define the limits.

4 Click OK.

Result: The baseline will be calculated from the whole curve, but the calcula-
tion of the peak areas is only performed on the selected section.

Edit integration for part of a
curve

Part of a curve can be selected in the Edit Peak Table dialog box and integrated with
settings that differ from the rest of the curve. The table below describes how to do this.

Step Action

1 e Choose Integrate:Edit Peak Table.
Result: The Edit Peak Table dialog box opens.
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Step Action

2 « Click the Reintegration Window icon.

[
Result: The mouse pointer is changed into [-1 and two vertical marker
lines are displayed.
e Place the mouse pointer on one of the marker lines.

Result: The mouse pointer changes shape to a double-sided arrow, see
picture below.

Edit Peak Table - [UV 1_28001,COPY-Temporary]
File  Edit  Baseline  Integrate
A M+
R G )
ey — D101 20021 U1 280 — D101 a 002:1_UV 1_230@01,BASEM
500
450
400
350
300
250 +
200
150
100
50
5 — -
-50
ml
0 5 10 15 20 25 30 35 40 45 50 55
Feak name | Retention (m) | Area [m'mAU) | Rietenlion at start [ml) | Retention at end ()
1 1667 2932014 1253 16.92
2 1782 107261731 29
3 .05 12031730 2879 3408
= 3505 262.9059 34.09 %76
5 ®.40 205067 3676 .93
6 3940 I E T 994

Note:
The left marker line may be placed over the Y-axis initially.

3 Drag the cursor lines to the beginning and the end of the selected part of
the curve.

Note:
All operations described below will only affect the selected part of the curve.
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Step Action

4 If desired, change the integration parameters:
Reject peaks

e Choose Integrate:Settings.
Result: The Reject Peaks dialog box opens.

¢ Change the settings as desired and click OK.
Skim peaks

e Choose Integrate:Peak Skim.
Result: The Peak Skim dialog box opens.
o Select the Skim Peaks checkbox and type a ratio.

e Click OK.

5 e Choose Integrate:Peak Integrate.

Result: The selected part of the curve is peak integrated based on the
changed parameters.

Note: Refer to Section 5.2.6 Exclude or skim peaks, on page 128 for information about
the integration parameters in step 4 above.
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5.2.6 Exclude or skim peaks

Introduction

The results of the peak integration can sometimes be improved if some peaks are ex-
cluded. Also, more accurate results may be obtained if smaller peaks are skimmed off
larger peaks with shoulders, as described in this section.

Exclude peaks

The table below describes how to define peaks to be excluded in the Peak Integrate di-
alog during a peak integration.

Step Action

1 Click the Reject peaks button.
Result: The Reject Peaks dialog opens.

Reject Peaks

Filter parameters

[] Height less than: l:l mé

[] 'width less than: l:l min

[] &rea less than: l:l min * mél
[] 'width mare than: l:l min

Peak area is less thar: largest

[ ak. Q{J [ Cancel
2 e Selectthe appropriate checkboxes and type values for peak height, width
and area.

e Define how many of the largest peaks you want to include.

3 Click OK.
4 Proceed with the peak integration.
Note: You can also exclude peaks from the peak integration in the Edit Peak Table

dialog. Select Integrate:Settings to open the Reject Peaks dialog.
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Include negative peaks

Select the Accept negative peaks checkbox of the Peak Integrate dialog to include
negative peaks in the integration. The negative peaks will be reported as negative areas
in the peak table. By default, negative peaks are not included in the integration.

Peak skimming vs. droplines

The area under a peak can be calculated either using separating droplines or peak
skimming:

* Droplines are vertical marks that split two peaks at the valley. Droplines are used
mostly for peaks of relatively similar size. When a peak has a shoulder, splitting with
droplines will cause the first peak to lose too much of its area to the peak that forms
its shoulder.

* The Peak skim option can be used to skim off the smaller peak with a straight line
that starts in the valley between the peaks and ends at the other side of the smaller
peak, at the point where the skim line and the curve slope are equal.

The illustration below is an example of how a dropline (left) and a skimmed peak (right)
affect the area under the main peak and the peak shoulder. The peak shoulder area is
marked in gray:

Dropline
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Skim peaks

130

The table below describes how to select a ratio to skim peaks in the Peak Integrate dialog:
Step Action
1 Select the Peak skim checkbox.
2 Determine the ratio when peak skimming should be applied based on the
relationship in the illustration below:
hp1 -h
pLv > skim ratio
h|02 "y
h pl hy hpZ
O NN, SRR AU, SR ...
I
Note:
The default ratio value is 10.
3 Type the ratio value in the text box.
4 Proceed with the peak integration.
Note: You can set a peak skim ratio or edit earlier settings after the peak integration.
Open the Edit Peak Table dialog and select Integrate:Peak Skim.... and enter
a Ratio in the Peak Skim dialog.
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5.3 Baseline operations

About this section

In order to achieve the best possible peak integration result, the baseline may have to
be edited or optimized. This section describes:

¢ how to edit the baseline manually

and

¢ how to optimize the baseline using a selected algorithm.

In this section

This section contains these subsections:

Section See page
5.3.1 Edit the baseline manually 132
5.3.2 Optimize the baseline with a morphological algorithm 136
5.3.3 Optimize the baseline with a classic algorithm 140
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53.1

Introduction

Edit the baseline manually

The first choice when you want to optimize the peak integration is to change the baseline
parameters. This section describes how to optimize the baseline manually.

The Edit Baseline dialog

132

You can edit the baseline manually in the Edit Baseline dialog in the Evaluation Classic
module:

e Click Integrate:Edit Baseline to display the dialog.

The Edit Baseline dialog displays the baseline and the curve it was calculated from. The
baseline points are marked with gray squares. A selected baseline point is colored red.
Hold the cursor above the baseline point to display its coordinates to the left, below the
chromatogram. See the illustration below:

Edit Baseline

~ [ -
.[+ 2
] 9
— 1280 — UV 1_280@01 BagE -—- v
méL
400
380
360 2
340
320
300
280
260
240
220
200
180
180
140
120
100
80 3
80
40
o n
e 1 : e
1 UV 1_280@01, BASEM] ml
a 2 4 & 8 1 12 14 18 18 20 22 24 3
19,550 ml 13.546326 mél) Delets | [ Delete &l | [ DrswShaighttaNestPaint | [ DK | [ Cancel |
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How to use the zoom function

The table below describes how to use the zoom function in the Edit Baseline dialog.

Step Action

1 o Click the Zoom icon.

| ‘h
¥

Result: The cursor is changed into a magnifying glass.

2 e Press and hold the left mouse button.
« Drag the cursor over the area you want to zoom in on.
e Release the mouse button.

Result: The area is enlarged. Right-click and select Reset zoom to restore
the full view.

How to edit and insert data
points

The tables below describe how to edit and insert baseline data points:

Step Action

1 Select Integrate:Edit Baseline.

Result: If there is more than one baseline available, the Select Baseline to
Edit dialog opens. If not, proceed to step 2.

« Select the baseline you want to edit from the list.
Result: The Edit Baseline dialog opens

2 « Click the Set Curve Points icon.

#+

Result: The mouse pointer is changed into a pen symbol and a cross.

3 Add, delete and/or move data points according to the table below.
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Step Action

6 Click OK.

Result: The Save Edited Baseline dialog opens.

7 e Confirm the location and type a new name if necessary.

Result: The new baseline is saved.

If you want to...

Add a data point

Then... ‘

Click the left mouse button to place a new baseline point
in the chromatogram.

Result: A new point is created, marked by a red square.
The baseline curve is redrawn as a smooth spline function
based on the old and the new points. The baseline is
guided by the points, but does not necessarily pass
through them.

Tip:

If you want to create straight baselines, read the instruction
later in this section.

Delete a data point

Click the data point to select it and click the Delete button.

Result: The data point is deleted and the curve is redrawn.

Note:

Click the Delete All button to delete all the data points at
once.

Move a data point

Select the data point and drag it to a new position.

Result: The baseline curve is redrawn.

Tip: Click the Undo button to cancel the last edit if the result is not satisfactory.

134
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Edited baseline

The illustration below is a simulated example of a baseline before and after editing:

How to draw a straight line

The table below describes how to force a straight baseline between two points.

Step Action

1 Select the first of the two points in the point list.

2 Click the Draw straight to next point button.

Result: The baseline is drawn through the points as a straight line.
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5.3.2 Optimize the baseline with a morphological algorithm

Introduction

The first choice when you want to optimize the peak integration is to change the baseline
parameters. This section describes how to optimize the baseline with a morphological
algorithm.

Morphological algorithm
description
A morphological algorithm can be described as a line that follows the chromatogram

parallel to the X-axis. Data points for the baseline are created whenever the line touches
the curve, and the points are joined at the end to create a baseline.

A morphological algorithm gives the best result in curves with drifting baseline and peak
clusters. The morphological baseline follows the curve faithfully, and a curve with a
baseline at a more even level can be created by subtracting the morphological baseline.

A morphological algorithm does not work well if there are negative peaks or if quantitative
data from negative peaks are important in the run.

Note: Morphological algorithm is the default baseline setting.

How to set a morphological
baseline

Follow the instructions to choose a Morphological algorithm and define baseline settings.

Step Action

1
Clickthe button or select Integrate:Edit Peak Table to perform peak
integration.

2 e Choose Calculate baseline in the Baseline drop-down menu.

e Click the Baseline settings button.

Result: The Baseline Settings dialog opens.
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Step Action

3 ¢ Select the Morphological algorithm.
e Change the Baseline parameters if necessary.
See more information about the parameters below this table.

e Click OK.

Morphological algorithm
parameters

The parameters for the Morphological algorithm are:
* Structure width

e Minimum distance between points

Structure width

Structure width determines the length of the straight line that follows the chromatogram.
The default value is set at the widest peak in the chromatogram multiplied by 1.5.

The illustration below is an example of how a morphological baseline follows the peaks
at the different levels in the curve:

=T AT 00 11 2 18R - -~ ATCATO0R 1L 2 3R BRSER
P
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The correct structure width

settings

138

Settings too low

Structure width settings that are too low can result in a baseline that reaches too high
up in the peaks of the curve. Sometimes a wider peak is not recognized because it con-
tains a cluster of smaller peaks. The Structure width is then set to a value according to
the largest width of the identified narrower peaks, and must be increased.

Settings too high

Structure width settings that are too high mean that narrower peaks, especially in
fluctuating curves, are not properly followed. This happens when an artifact in a curve
is identified as the widest peak by the morphological algorithm, and then is used to set
the default Structure width value.

The illustration below is an example of baselines using the default morphological algo-
rithm settings (A) and a morphological algorithm with an increased Structure width
value (B).

AR 100 Lo LRh TRy o = 0L 100 11t 1% hen 0 L EREED ~o o MR 100 S T2 18 A BAGEN
[ 13

b zh ) 3 b 3 20 EQ 3 EQ g 0 T i
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Minimum distance between
points

The Minimum distance between points is a measure of the distance between the data
points used to generate a baseline. The largest number of data points is produced at
the slopes of the curves. If you increase the Minimum distance between points value,
fewer points will be collected on the slopes.

The illustration below is an example of a baseline (A) that is created with the Minimum
distance between points parameter set at a low value. The number of data points is
reduced when the Minimum distance between points parameter is set to a higher value
(B).

A
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5.3.3 Optimize the baseline with a classic algorithm

Introduction

The first choice when you want to optimize the peak integration is to change the baseline
parameters. This section describes how to optimize the baseline with a classic algorithm.

Classic algorithm description

A classic algorithm searches for all parts of the source curve that are longer than a de-
fined minimum baseline segment and fall within limiting parameters. Together, the pa-
rameter values define the limits for a rectangular box. A part of the source curve must
fit entirely inside this rectangular box to be identified as a baseline segment.

A classic algorithmis particularly useful when you need to integrate curves with negative
peaks and when quantitative data from negative peaks are important.

Classic algorithm parameters
The parameters for the Classic algorithm are:
e Shortest baseline segment
* Noise window
* Max baseline level
¢ Slope limit
See more information about the parameters below.

How to set a classic baseline

Follow the instructions below to set a Classic algorithm and define a baseline.

Step Action

1 Click the Baseline settings button in the Peak Integrate dialog.

Result: The Baseline Settings dialog opens.
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Step Action

2 ¢ Select the Classic algorithm.
e Change the Baseline parameters.
See more information about the parameters below this table.

e Click OK.

Tip: The same settings can be edited in the Calculate Baseline dialog when a new
baseline is created. Choose Integrate:Calculate Baseline to open the dialog.

Test your parameter changes

The best way to optimize the baseline is to change the baseline parameters step by step
and then check the resulting baseline after each change. When the desired effect is ac-
complished it is best to go back and try a parameter value in between the two last settings
to avoid an unnecessarily low or high value.

How much the values should be changed depends on the cause of the peak integration
problem. The table below is a general guideline.

Baseline parameter Recommended initial change
Shortest baseline segment | 20%-50%
Noise window 10%-30%
Max baseline level Usually not necessary to adjust
Slope limit 25%-50%
Tip: If necessary, click the Default Values button to restore the default values.
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Shortest baseline segment

If an excessively high Shortest baseline segment value is set, short curve segments
between peaks in the middle of the chromatogram are not identified as baseline seg-
ments. The calculated baseline does not follow the source curve, see below:

J

The Shortest baseline segment value is decreased by 50% in this example:
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A changed Slope limit will often improve the baseline calculation. The Slope limit sets
the maximum slope of the curve to define when a peak is recognized. An excessively
high Slope limit will cause the up-slopes of the peaks to be recognized as baseline seg-
ments.

The example above was improved by the shorter baseline segments but the high slope
of the short segments in the region between the second and the fourth peak still makes
the baseline unacceptable. In the example below the Slope limit is increased by a factor
of 2.5, which produces a correct baseline:

Slope limit too high

An excessively high Slope limit value can cause peak limits too high up on the peaks.
This can be the case when the chromatogram includes a very large flowthrough or solvent
peak. The large peak affects the calculation of the default parameters and leads to ex-
cessively high values for the Slope limit.

Note: An excessive value for the Noise window can have the same effect and be
caused by the same situation, often also in combination with a high Slope
limit.

Peak limits are defined on peaks in the example below due to the high Slope limit:
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The example below has a much lower Slope limit, and a lower Noise window:
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Noise window

Occasionally too many peaks occur after the peak integration, usually because noise
on the baseline is erroneously detected as peaks. The solution to this is to increase the
Noise window parameter. However, this can result in peak limits too high up on the peak
slopes. The illustration below is an example of noise detected as peaks (A) and the result
of a second peak integration with an increased Noise window (B).
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Tip: You can also use the Reject peaks function in the Peak Integrate dialog to

reduce the number of peaks based on the total number of accepted peaks or
the minimum peak height.
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Missing peaks

Sometimes obvious peaks are not detected in the peak integration. The probable cause
is that the Noise window is set too high. See the illustration below:

All peaks are detected if the Noise window is decreased- see example below:

Note: Missing peaks can also be caused by improper settings for Reject peaks in
the Peak Integrate dialog, or Filter peaks in the Chromatogram Layout dialog.
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When to change the Max
baseline level
In rare cases the top of a broad, flat peak can be incorporated as a baseline segment.

This is one of the very few situations where it is useful to change the Max baseline level.
The illustration below is an example:

How to set the Max baseline level

Follow the instructions below to set the Max baseline level.

Step Action

1 Right-click in the chromatogram and select Marker.

Result: A vertical line is set in the chromatogram. A text box in the top left
corner of the chromatogram displays the X-axis and Y-axis values of the
curve at the point where the vertical Marker line crosses the curve.

2 e Move the Marker with your mouse.

e Measure the height of the peak you want to exclude from the baseline.

3 Choose Integrate:Calculate baseline.
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Step Action

4 e Select Classic as Algorithm.

e Typeanew value for Max baseline level. Set the level slightly lower than
the value that you measured in step 2.

Example of a correct baseline

The illustration below is an example of a correct baseline after the Max baseline level
has been changed:

148 UNICORN 7.0 Evaluation Manual 29-1108-88 AA



5 Evaluate results
5.4 Fraction and peak operations

5.4  Fraction and peak operations

About this section

This section describes other operations that you can perform on your results, including:

In this section

Pool several fractions into combined fractions,
create an average fraction absorbance curve, the Fraction Histogram,

match protein activity to a curve using the Activity Histogram
and

use the absorbance ratio to verify peak purity or identify peaks.

This section contains these subsections:

Section See page
5.4.1 Pool fractions 150
5.4.2 The Fraction Histogram 153
5.4.3 Match protein activity to a curve 156
5.4.4 Peak purity and peak identification 158
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5.4.1 Pool fractions

Introduction

Fractions are collected sequentially during a separation. Each fraction contains a set
volume of sample. This section describes how to pool the curves from several fractions
into a new curve.

Display the fractions in the
chromatogram

Each fraction is numbered according to its order in the sequence. The information is
saved as a curve under the name Fractions.

To display the position of each fraction in relation to the information displayed on the
UV detection curve:

¢ Select the Fraction... curve on the Curve tab in the Customize dialog.
or

* Right-clickin the chromatogram and select the Filter Curves menu command. Select
the checkbox for the Fraction... curve.
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Pool fraction curves

The table below describes how to pool fractions.

Step Action

1 e Open the result from the File Navigator.

¢ Choose Operations:Pool Fractions.

Result: The Pool Fractions dialog opens:

Pool Fractions

Fraction marks: Fraction no. Target chromatogram and curve:
Chrom.1 w Chirom.1

011: Fraction Chrom. 1:DefctO0

Out'w aste
341
342
343
3B3
3B.2

waste[Frac) k

341

342
waste[Frac)
Out'w aste

OO0OO0OEREOOREC

036: v

Curve name:
< I |Fraction@11 POOL |

ok Cancel

The fraction curves for the selected chromatogram are listed in the Fraction
marks field. The fractions for the selected fraction curve are shown in the
Fraction no. field.

2 « Select the check box for each fraction to be pooled.

Note:

Only adjacent fractions will be pooled. In the example above, fraction
3.A.1 will be pooled with fraction 3.A.2 and fraction 3.B.2 will be pooled
with fraction 3.8.1.

o Select the destination for the new curve in the Target chromatogram
and curve field.

o Click OK.

Result: The fraction curve with the pooled fractions is added to the chro-
matogram.

Tip: The default name for the fraction curve is shown in the Curve name field. The
default curve ending is POOL. The default curve name can be changed as
needed by typing a new name in the field before the fractions are pooled.
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Show only the pooled fraction
curves

The active chromatogram will now show both the original and the pooled fraction curves.
The table below describes how to show only the pooled fractions.

Step Action

1 e Right-click in the chromatogram and select the Customize dialog. Click
the Curve tab.
or
e Right-click in the chromatogram and select the Filter Curves menu
command. Select the checkbox for the Fraction... curve.
2

e De-select the check box for the original fraction curve (remove the check
mark).

Result: The original fraction curve is de-selected and is not displayed.
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The Fraction Histogram

The Fraction Histogram dialog in the Evaluation Classic module can be used to create
a curve for the average fraction absorbance. It can also be used to create a table
showing the amount of protein and the concentration in each fraction.

Create a Fraction Histogram

curve

Follow the instructions below to create a Fraction Histogram curve.

Step Action

1 Select Operations:Fraction Histogram.
Result: The Fraction Histogram dialog opens.

2 Select the desired UV curve in the left Source chromatogram and curve
field.
Tip:
The fractions curve should already be selected on the middle field.

3 Click OK.
Result: The average fraction absorbance values are displayed as a new curve
in the chromatogram.

Tip: By default, the Fraction Histogram curve will be assigned to the first available

curve position, which is shown in the Target chromatogram and curve list.
A default curve name with the ending HIST is suggested in the Curve name

field. You can choose another curve position and type another curve name in
the Curve name field if desired.

Protein concentrations in the

fractions

The protein concentration in the fractions are calculated using the following formula:

Concentration [mg/ml] = A/ (d * 1000 * Ext. coef)

A = Average fraction absorbance = Area / Volume [mAU]
d = UV cell path length [cm]

Ext. coef. = Protein coefficient at used wavelength. [l g™1 cm™

4
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Protein amountsin the fractions
The total amount of protein found in the fraction is calculated using the following formula:

Amount [mg] = Concentration [mg/ml] * fraction volume [ml]

Calculate the protein
concentration and amount

Follow the instructions below to calculate the protein concentration and amount in the
fractions using the Fraction table in the Fraction Histogram dialog:

Step Action

1 Select Operations:Fraction Histogram.

Result: The Fraction Histogram dialog opens.

Note:
If the path length is not shown, it can be entered manually.

2 Type the extinction coefficient for each fraction in the corresponding Ext.
coef table cell.
Result: The fraction protein concentration and amount are calculated and
displayed in the corresponding Conc. and Amount table cells.
Note:

The values are calculated using a zero baseline (i.e., no baseline subtraction
is applied).

Export the Fraction table

The complete Fraction table can be exported as an Excel file:

Step Action

1 Click the Export Table button in the Fraction Histogram dialog.

Result: The Export Fraction Table to Excel file dialog opens.

2 Browse to the folder where you want to save the file.
3 Type a name in the File name field.
4 Click the Save button.

Result: The table is saved in Excel format.
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Print the Fraction table

The complete Fraction table can be printed directly from the Fraction Histogram dialog:

Step Action

1 Click the Print Table button.

Result: The Print dialog opens.

2 If necessary, select a printer and the number of copies to print. You may also
click the Properties button in this dialog, to change the general printer set-
tings.

3 Click OK.

Result: The table is printed on the selected printer.
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5.4.3 Match protein activity to a curve

Introduction

You can compare data from the results of protein activity assays, such as ELISA, with
the data contained in the UV curve. The activity curve and the UV curve can be compared

in a combined presentation.

The Activity Histogram dialog

The illustration below shows the Activity Histogram dialog:

Activity Histogram

Source chromatogran and fraction curve:
| Chirarn.1 - |

Edit source activity walues:

Fraction | Activity ]
Out- aste- 0.000
542 25.200
“waste[Frac 0.000
E.&.4- 13.800 =
B.A5- 75.300
BAE-
Yl astelFrac il DDDEE' |

Target chromatogram and curve:
Chirorn. 1

003 LY 3_0_Chrom.1:1.50 002 ~
004: Cond_Chrom.1:1.50 002 —
005: % Cond_Chrom.1:1.50 002

006: Conc B_Chrorn.1:1.50 002 |
007: pH_Chrom.1:1.50 002

008: Spstem flow_Chrom.1:1.50 002
009: Spstern pressure_Chram,1:1.50 002
010: Cond temp_Chrom.1:1.50 002

0713 Sample flow_Chrom.1:1.50 002
014: Sample pressure_Chrom,1:1.50 002
015: PreC prezeure_Chrom.1:1.50 002
0716: DeltaC pressure_Chrom.1:1.50 002
017 U 1_2800201 BASEM_Chram 1
018 Fraction@11.HIST_Chrarn.1

019:

(£

Curve narne:
|Fraction@11HIST |
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Enter protein activity values for

comparison

Follow the instructions below to enter the values from a protein activity assay in a
comparison histogram:

Step

Action

1

Choose Operations:Activity Histogram.

Result: The Activity Histogram dialog opens.

By default, the fraction curve for the current chromatogram is selected in
the Source chromatogram and fraction curve list.

o If necessary, change the source and target chromatograms.

All the component fractions of the fraction curve are listed in the Fraction
column of the Edit source activity values field.

« Type an activity value for each fraction in the Activity column.

Result: A histogram curve showing the activity values is added to the chro-
matogram.

Tip:

By default, the Activity Histogram curve will be assigned to the first available
curve position, which is shown in the Target chromatogram and curve list.
A default curve name with the ending HIST is suggested in the Curve name
field. You can choose another curve position and type another curve name in
the Curve name field if you so wish.
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5.4.4 Peak purity and peak identification

Introduction

Ratios between UV curves measured at different wavelengths give useful information
about peak purity or peak identity.

Peak purity

The absorbance ratio can be used to check peak purity. If the peak is pure, the absorbance
spectra are the same over the whole peak and the ratios should therefore remain con-
stant. The peak is probably not pure if the absorbance ratio is not the same over the
whole peak.

Theillustration below shows a chromatogram of two co-eluting components with differing
absorbance spectra and a small difference in retention time:

AU Co-eluting peaks
1 A+B

Ratio
3

A270nm
A255nm
Ratio A27onm/A255nm

o

O 1 T T
0 1 2 3 4

Time units

Peak identification

The absorbance ratio can be used for peak identification. Different compounds have a
specific ratio between absorbancies at different wavelengths.

The illustration below shows a chromatogram of two components with differences in
their absorbance spectra:
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Separated peaks

AU Ratio
! B
09 |
08 25
0.7 .
06 - A270nm
8’2 : ' A255nm
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Divide the curves

Time units

Both curves must have a baseline close to zero AU before they can be divided. This is
achieved with baseline subtraction. The table below describes how to subtract the
baseline from an earlier integration and divide the curves:

Step

Action

1

Perform peak integrations to create a baseline for each UV curve, see Perform
a peak integration.

Select Operations:Subtract.

Result: The Subtract dialog opens.

¢ Select the UV curve in the first Source chromatogram and curve list.

o Select its baseline in the second Source chromatogram and curve list.

e Click OK.

Result: A curve with the subtracted baseline is added to the chromatogram
in the first available curve position. By default, the curve name will have a
SUB ending.

Tip:

You can also subtract corresponding blank runs if there are blank runs avail-
able.

Repeat steps 2 and 3 for the second UV curve.

Select Operations:Divide.

Result: The Divide dialog box opens.
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Step
6

Action

o Select the first result curve from the subtractions in the first Source
chromatogram and curve list.

¢ Selectthe second result curve from the subtractions in the second Source
chromatogram and curve list.

Click the checkbox for Threshold and type values for each curve. This results
in the following:

e The quotientis set to 1.0 if either of the sample values is closer to zero
than the threshold value. Very high quotient values are prevented if divi-
sion is performed with values close to zero. Very low quotient values are
also prevented.

Note:

Default Threshold values are entered by UNICORN. The values can be changed.

Click OK.

Result: A new curve is added to the chromatogram in the first available po-
sition. By default, the curve name will have a DIV ending.

Filter the result curve

160

The resulting curve can be filtered to reduce noise and to remove ghost peaks. The table
below describes how to filter the curve.

Step Action

1 Select Operations:Smooth.
Result: The Smooth dialog opens.

2

e Select the Source Chromatogram.
e Select a Filter Type.
Tip:

The Median filter is recommended to remove noise that appears as spikes or
occurs in a small area of the curve.

Result: A new curve is added to the chromatogram in the first available po-
sition. By default, the curve name will have a SMTH ending.
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5.5 Compare different runs

About this section
This section describes
* how to make comparisons between curves or chromatograms from different runs
* how to present curves or chromatograms from different runs
* how to compare curve parameters among curves from different runs
* how to view several chromatograms at the same time
* how to overlay curves from different runs in one chromatogram
* how to stack curves from different runs in one chromatogram

* how to create mirror images

In this section

This section contains these subsections:

Section See page
5.5.1 Open and compare chromatograms 162
5.5.2 Open and compare curves 169
5.5.3 Shift curves 178
5.5.4 Create a mirror image 179
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5.5.1 Open and compare chromatograms

Introduction

This section describes

¢ how to import chromatograms from other result files to an open result,

and

* how to compare chromatograms in a result.

Commands to use

Two commands in the Evaluation Classic module can be used to import chromatograms
from results into an open result:

* File:Open to compare

This is the preferred option when you search for many chromatograms in a specific
folder based on defined selection criteria. See “How to import chromatograms with
the command File:Open to compare” below.

* File:Open

This is the preferred option to import any individual chromatograms from result files
in different folders. See “How to import chromatograms with the command File:Open”
below.

Open chromatograms

You can display several chromatograms, from different results, simultaneously for
comparison. The table below describes how:

Step Action

1 Open the result containing the first chromatogram.
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Step Action

2 e Choose the File:Open menu
e Choose the Chromatogram menu item
Result: The Open Chromatograms dialog opens.
Open Chromatograms
u Results v "
Falder hame Spztemn Lagt modified A
@ Manual Bun 001 F2.814 2009-01-21 15:15...
@ Manual Bun 004 FP2.8-04 2009-07-14 10:22:...
@ Manual Bun 005 F2.805 2009-01-14 10:53:..
@ Manual Bun 006 F2.810 2009-07-14 10:54:...
@ Manual Bun 008 F2814 20090014 14:04:.
@ Manual Bun 009 F2.8-M 2009-07-14 10:24:...
[ L . TR S o, =R W] a1 17 !
< I >
Select Chromatograms
Awailable: Selected:
N Chrom.1 : Manual Run 001
Chirom.1 : Manual Run 004
Ok l [ Cancel
3 Select a result in the browser pane.

Result: The chromatograms in the result are listed in the Available list.
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Step Action

4 ¢ Click the checkbox for each chromatogram in the Available list that you
want to select.

o Click the selection button (as illustrated above).

Result: The chromatogram is added to the Selected list.

Tip:

You can click the de-selection button to remove selected chromatograms
from the list. This will remove all chromatograms with checkmarks. Note that
you must first click to remove the checkmark from each chromatogram that
you want to keep in the Selected list.

5 e Repeat step 4 until you have selected all the chromatograms you want
to open.

o Click the OK button.

Result: The selected chromatograms open in the Evaluation Classic module.

Note:

If the names of the imported chromatograms already are used they will be
sequentially numbered for identification purposes. Each chromatogram will
be opened in its own tab. However, depending on the number of chro-
matograms and the length of the names, not all tabs may be visible at once.
Click the arrow symbol on the top right corner of the chromatogram pane to
show a list of all open chromatograms. You may select the chromatogram
you want to view from this list.
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Import chromatograms with the

command File:Open to compare
The table below describes how to import chromatograms with the File:Open to compare
command. The search is performed at specific locations or with specific search criteria.

This method is useful if, for example, you want to import chromatograms from all results
of a scouting folder.

Step Action

1 Choose File:Open to compare:Chromatograms in the Evaluation Classic
module.

Result: The Open Chromatogram to Compare dialog box is displayed.

DOpen Chromatograms to Compare

Chrarnatogrann selection

Folder | /Rroger/Riesults/DoE 1D DoE_1 [3) | [ Browse.. |
Result: |" v| [ Browse... ] [ All ]
Chromatogram: |" v| [ Browse... ] [ All ]

Found chromatograms

Search Chrom.1 | Do 1D DoE_1 003 | /Roger/Results/DoE 1D DoE_1[3)
Chrom.1 | Dok 1D DoE_1 004 | /Roger/Results/Dok (D DoE_1 (3]

B3] Chom.1 | Dok ID DoE_1 005 | /i E 1D DoE_1 (3]

[] Chram.1 | DeE 1D DaE_1 006 | /Roger/Results/DcE 1D DoE_1(3)
(] Chram.1 | DoE ID DoE_1 007 | /Foger/Results/DeE 1D DoE_1 (3]
[] Chram.1 | DaE 1D DaE_1 008 | /Roger/Results/DcE 1D DoE_1(3)
[] Chram.1 | DeE 1D DaE_1 009 | /Roger/Results/DcE 1D DoE_1(3)
[] Chram.1 | DaE 1D DaE_1 010 | /Roger/Results/DcE 1D DoE_1(3) —
[] Chrom.1 | Dok 1D DoE_1 011 | /Roger/Results/Dok 1D DoE_1 (3] bt
< | >

[ (0]8 %J[ Cancel

| >

o Click the Browse button beside the Folder droplist

This opens a browse dialog where you can select the result folder where
you want to search for chromatograms.

Note:

The search will not include the contents of subfolders. You must select
the subfolders individually for the search.

o Repeat this step to define specific results or chromatograms if desired.
Tip:
Click the droplist arrow buttons to view searchpaths that you have used

previously. You can click selections in these lists to search the same locations
again.

UNICORN 7.0 Evaluation Manual 29-1108-88 AA 165



5 Evaluate results

5.5 Compare different runs

5.5.1 Open and compare chromatograms

166

Step

3

Action

Click the Search button in the Found chromatograms field and a list of
chromatograms will be displayed based on the designated search criteria.

A new search can be performed with new search criteria without erasing
the initial chromatograms from the list.

Select the chromatograms that you want to import. If you click the Select
All button, all the displayed chromatograms will be imported.

If you want to clear the list of displayed chromatograms, click the Clear
button.

Click OK.

Result: All the selected chromatograms are opened in the Evaluation Classic
module.

Note:

If the names of the imported chromatograms are already used they will be
sequentially numbered for identification purposes. Each chromatogram will
be opened in its own tab. However, depending on the number of chro-
matograms and the length of the names, not all tabs may be visible at once.
Click the arrow symbol on the top right corner of the chromatogram pane to
show a list of all open chromatograms. You may select the chromatogram
you want to view from this list.
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Display and compare the
imported chromatograms

By default, the chromatograms are opened behind each other in the full chromatogram
pane. The table below describes how to arrange the imported chromatograms so that
several can be viewed and compared at the same time:

Arrange the chromatograms

Step

Action

1

Click the tab of one of the chromatograms and hold the mouse button
pressed.

Result: A positioning icon is displayed in the chromatogram pane.

Move the mouse pointer to the area of the window where you want to place
the pane.

The arrows of the symbol show the side of the pane where the selected
chromatogram will be docked. Drag the mouse pointer over the appropriate
arrow.

Result: The area where the chromatogram will be docked is colored.

Release the mouse button.

Result: The pane is moved and docked in the new position.

Tip:

Several chromatograms may share a space, either placed on top of each

other or arranged side by side or above each other. Click the center position
of the symbol to place a chromatogram on top of another.

Tip:

e To restore the original layout with the chromatograms displayed as tabs,
select View:Chromatograms as Tabs.

e To view all chromatograms side by side, select View:Tile All
Chromatograms.
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168

Display all chromatograms on the same scale

Step Action

1 Click the Customize icon or select Tools:Customize to open the Customize
dialog for any chromatogram.

2 Select the X-Axis tab and make the changes to the Base and the Axis scale.

3 Select the Apply to all chromatograms option and click OK.

Note: Imported chromatograms cannot be shown with column volume as the X-

axis base.
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5.5.2 Open and compare curves

Introduction

This section describes how to import or copy curves from different runs into one chro-
matogram for comparison.

Commands to use

Two commands can be used to import curves from results into one chromatogram:

* File:Open to compare

This is the preferred option if you want to automatically search result files that are
stored in the same folder to locate all curves of a specified type, for example, all UV
curves. This is especially useful for comparison of curves from scouting runs. More-
over, the imported curves can be automatically overlaid, stacked or presented as
mirror images. See "File:Open to compare" below.

* File:Open:Curves
This is the preferred option to import individual curves. See "File:Open:Curves" below.

Note: Original curves are underlined in the chromatogram, imported and created
curves are not underlined.
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File:Open to Compare

The table below describes how to import curves to a chromatogram with the command

170

File:Open to Compare:

Step Action

1 In the Evaluation Classic module,

e choose File:Open to compare:Curves

or

« click the Open curves to compare toolbar button.

Result: The Open Curves to Compare dialog opens.

Dpen Curves to Compare

Curve selection
Folder:
Result:
Chromatogram:

Curve:

Found curves

|KF|UgerfF|esuIls/DUE 1D DoE_1 (3]

|

| [ Browse.. |

| [ Browse. | [ ar |
v| [ Browse. [ & |
v| [ Browse. [ & |

Search

Curve optiohs

;L

- U 1_280 | Chram 1 | DaE 1D DaE_1 001 | /Roger/Results/DoE A
- U 2_0 | Chrom.1 | DoE 1D DeE_1 001 | /Roger/Results/DoE 10—
: UV 3_0 [Chrom.1 | DoE 1D DoE_1 001 | /Roger/Results/DoE 10—
: UV 1_280| Chrom.1 | DoE 1D DoE_1 002 | ARoger/Resultz/DoE
- W 2 0 [Chrom.1 | DoE 1D DoE_1 002 | /Rager/Results Dok I
rom.1 | DoE 1D DoE_1 00
om.1 |DoE 1D DoE_1
- U 2_0 | Chrom.1 | DoE 1D DoE_1 003 | /Roger/Results Dok I
: U 3_0 | Chrom.1 | DoE 1D DoE_1 003 | /Roger/Results Dok 1LY
S

/Roger/Results/Dok I

[ Store in new chromatogram: |

@ Overlay O Stack ) Mimor
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Step Action

2 ¢ Select the desired search criteria in the Folder, Result, Chromatogram
and Curve droplists of the Curve selection section.

o Click Search and a list of curves will be displayed based on the selected
search criteria.

Tip:

A new search can be performed with new search criteria without erasing

curves located in the previous search.

o Select the check boxes for the curves that you want to import. Click the
Select All button if you want to import all the curves.

« If you select the Store in new chromatogram option, the curves will be
imported into a new chromatogram. This is recommended to keep the
source chromatogram free of too many additional curves.

3 o Select howto display the imported curves in the Curve options field. The
options are described in "Curve options" below.

UNICORN 7.0 Evaluation Manual 29-1108-88 AA 171



5 Evaluate results
5.5 Compare different runs
5.5.2 Open and compare curves

Step Action

4 If you selected the Stack option in step 3, the Shift Curves by Offset dialog
is displayed:

Shift Curves by Offset

Offset: Unit
| ) (e s

Selected curves will be shifted

[#] 004: UY 1_260 (1)_Chrom. 1:DoE ID DoE_1 002

[#] 006: Uy 1_280 [2)_Chram. 1:DoE 1D DaE_1 003

[¥] 008: L 1_280 (3)_Chrom.1:DoE 1D DoE_1 004

€]

[ ok %J[ Cancel ]

« You can set the Offset value to increase or decrease the offset distance
between the curves.

e Click OK.

Result: Depending on your previous choices, the imported curves are now
displayed in the source chromatogram or in a newly created chromatogram.

Note:

If curves with several different units have been selected, the curves with each
different unit will be grouped together with separate offset from the other
groups.
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Curve options

The illustrations below show the different curve presentation options:

Overlay
?m. T Tesem T e — e
§
. ,
oy
B f
, i ,l-l Ir ¥
I Jl’};"” b4 1 \ AL
17 B B B ——
{:\-.:_-\‘_I: R 'll "I I.l:! I.l\"; '\J: }'\‘V‘JI 1 H"j} E““--\_l‘-\_\_ A _\_.l_
S WMo e [ L s

The curves are presented overlaid on one another.

Stack

T T T TN T T, .

fes

fes

fes

fre

The curves are presented with a given offset Y-axis value so that the curves are stacked
and distinct from one another.
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Mirror
. fJU!\aU'UL

an

¥ o ,_-1,,_'.

I| I.I
" Y
e

For comparison of two imported curves. One curve is inverted in the Y-axis and thus
appears to mirror the other curve. See Section 5.5.4 Create a mirror image, on page 179.

Change comparison settings

The table below describes how to change other comparison settings:

Step

Action

1

2

174

Click the Customize icon to open the Customize dialog.

Select or de-select the check boxes on the Curve tab to compare a different
set of curves.

o Select the Y-Axis tab to change the curve scales either

- individually
or

- all with the same scale (click the All With This Unit button).
e Click OK to update the curves.
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Action

« If you stacked the curves and want to change the stack offset
- choose Operations:Shift offset
and

- type anew Offset value.
o Click OK to close the dialog and update the curves.

Note:

Curves with a fixed Y-axis scale can not be shifted. Scale for curve number
in the Y-Axis tab of the Customize dialog must be set to Auto for the curves
to be shifted.

Tip:
The individual curves can also be moved (see Section 5.5.3 Shift curves, on
page 178).

File:Open:Curves

The table below describes how to import individual curves into an active chromatogram
with the File:Open:Curves commmand:

Step

Action

1

Make sure that the destination chromatogram for the imported curvels) is
active on the screen.
e Select File:Open:Curves in the Evaluation Classic module.

Result: The Open Curves dialog is displayed.

¢ Select the folder and the result file in the browse field of the dialog.

o Select a chromatogram on the Available curves droplist. Usually there
is just one chromatogram.

Result: The available curves are listed below.

o Click the checkboxes on the list for the curves that you want to import
and click the select (right arrow) button.

Result: The selected curve(s) is displayed in the Selected curves list.

Tip:

To remove a curve from the Selected curves list, ensure that the corresponding

checkbox is selected and that the checkboxes for all other curves are unse-
lected, and then click the de-select (left arrow) button.
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Step Action

3 o Repeat step 2 if you want to import curves from other chromatograms.

e Click OK when you have selected the curves you want.

Result: The selected curves are added to the active chromatogram.

Copy curves into a new
chromatogram

A practical way to compare curves is to create a chromatogram and copy curves from
different chromatograms into the new chromatogram. The comparisons are then per-
formed in the new chromatogram.

The table below describes how to copy curves into a chromatogram:

Step Action

1 e Choose File:New:Chromatogram.
Result: The New Chromatogram dialog is displayed.
e Typein a name for the chromatogram.
e Setavolume unit for the chromatogram.
e Click OK to add the empty chromatogram to the current result.

2 Open the source chromatogram(s)

Choose File:Open:Chromatogram to open the chromatogrami(s) that contains
the curves you want to copy.

Result: The Open Chromatogram dialog opens.
3 o Select the result file.
e Click the check box for the source chromatogram in the Available list.
o Click the select (right arrow) button.
e Click OK.
Result: The source chromatogram opens.
4 Copy the curves
e Choose Edit:Copy Between Chromatograms:Curves.

Result: The Copy Curve dialog is displayed.
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Step Action
5 ¢ Select the source chromatogram and a curve of interest in the Source
Chromatogram field.

o Select the new chromatogram and a curve position in the Target
Chromatogram field.

A default curve name with the ending COPY is suggested in the Curve
name field.

o Click the Copy button.

e Repeat this step for as many curves as you want, from the same or
other chromatograms.

Tip:

You can open more source chromatograms with the
File:Open:Chromatogram command.

o Click the Close button when you have copied all curves.

Alternative way to copy curves
An alternative way to copy curves into one chromatogram is to

e create a new chromatogram by copying an existing chromatogram and saving it
under a new name

e import more curves into the new chromatogram according to the instructions de-
scribed above in this section.
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5.5.3 Shift curves

Introduction

You can use the Shift function to stack and move curves from different runs to better
visualize the differences. Each curve is repositioned along the X- or Y-axis by a precise
value and the instruction is logged in the evaluation log.

Note:

The Shift function requires the curves to be present in one chromatogram.

Move a curve with the Shift

The table below describes how to use the Shift function:

Action

Make sure that a chromatogram with the relevant curves is open in the
Evaluation Classic module.

Choose Operations:Shift.

Result: The Shift dialog is displayed.

Select the curve to be shifted in the Source chromatogram and curve
list.

Select a curve position in the Target chromatogram and curve list.

Type a new Curve name or accept the default. The default curve name
ending is SHFT.

Select the axis/axes along which the shift is to be made:

- dlong the X-axis (Shift retention)
- along the Y-axis (Shift amplitude).
Type the shift value(s).

Click OK.

Repeat steps 1 to 3 to shift other curves in the chromatogram.

function
Step
1
2
3
4
178
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Create a mirror image

A very useful way to compare the features of two curves is to produce a mirror image
of one curve. The table below describes how to do this:

Step

1

Action

e Open a chromatogram to insert the relevant curves into.

e Choose File:Open to Compare:Curves.

Result: The Open Curves to Compare dialog is displayed.

¢ Select the desired search criteria in the Folder, Result, Chromatogram
and Curve droplists of the Curve selection section.

o Click Search and a list of found curves will be displayed based on the
selected search criteria.

Tip:
A new search can be performed with new search criteria without erasing
curves located in the previous search.

« Select the checkboxes for the curves that you want to import.
o Select Mirror in the Curve options field.

Result: The curves are displayed with one of the curves as a mirror image
in the active chromatogram window.
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Step Action

4 Shift the mirror image curve downwards

Shift the mirror image curve downwards for an improved presentation:

Choose Operations:Shift.
Result: The Shift dialog box is displayed.

Select the curve to be shifted in the Source chromatogram and curve
list.

Select the same curve number in the Target chromatogram and curve
list box as in step 2.

Select the Shift amplitude checkbox since the shift is to be made along
the Y-axis.

Type a shift value.
Click OK.

The illustration below shows a curve and a mirror image curve displayed.
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5.6  Multi Result Peak Compare wizard

Introduction

This section describes how to use the Multi Result Peak Compare wizard to make sta-
tistical comparisons between peaks in different results, for example by comparing area,
retention, etc. The calculated statistics are presented in a spreadsheet.

Note: Before you proceed with the wizard comparison, all results must be peak inte-
grated using the same retention unit.

Wizard workflow

The pages of the wizard are described in the table below:

Page Description

Entry dialog Welcome page.

Retention unit selection | Select the retention unit that was used previously during
peak integration.

Data selection Select the curves for comparison.

Peak selection Identify the peaks for comparison in all selected curves.
o Select peaks in the first curve

e The system identifies the corresponding peaks in all
other selected curves.

Peak data selection Select peak characteristics to be included in the compari-
son result.
Data view View the results of the comparison.
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Step 1: Select the retention unit

The table below describes how to select the retention unit:

Step

Action

1

In the Evaluation Classic module,

e choose File:Multi Result Peak Compare

or

e click the Multi Result Peak Compare toolbar icon

B

Result: The Multi Result Peak Compare wizard entry dialog is displayed.
Tip:

At this point you may choose to use stored wizard settings. This is described
in "Open the stored wizard settings" below.

Click the Next button to display the Retention Unit Selection dialog.

Select the retention unit that was used when the compared results were
integrated:

e min
o |

e« ml
o ul

e nl

Click the Next button to proceed to the Data Selection dialog.

182
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The illustration below shows the Data Selection dialog.

3]
Curve selection
Folder: ‘fﬂuger;‘ﬂesu\ts v‘ [ Browse... ]
Result ‘ v‘ [ Browse. ]
Chomatogram:  |* v [ Browsz.. |
Curve: “UV‘ v‘ [ Browse... ]
Found curves
Search 001: U 1_280 | Chram.1 | Manual Fun 004 | Roger/Results A
02: L 2 0] Chrom.1 | Manusl Run 004 | /Roger/Results i
[] 002 UV 3 0| Chram 1 | Manual Run 004 | /Roger/Resuts
[] 001 U 1_265 | Chrom.T | Manual Run 003 | Roger/Results
[ 002 U 201 Chram 1 | Manual Fun 009 | /Reger/Resuts u
[] 003 UV 3.0 Chrom.1 | Manual Run 009 | /Roger/Results
[] 001 U 1_2801 Chrom.T | Manual Run 005 | Roger/Results
[] 002 U 2_0] Chrom.1 | Manual Run 005 | /Roger/Results
[] 003 UV 3.0 Chrom.1 | Manual Run 005 | /Roger/Results
[] 001 U 1_2801 Chrom. T | Method Run 001 | /Roger/Results
[] 002 U 2_0] Chrom.1 | Method Run 001 | /Roger/Results
[] 003 U 3_0] Chrom. 1 | Methad Run 001 | /Roger/Results v
<Back | [ MNew> | [ Cancel
Step 2: Select curves to compare
The table below describes how to select curves to compare:
Step Action
1 Use the droplists and Browse buttons in the Curve selection field to specify

the result files, chromatograms and curves for comparison.

Tip:

Click the All button if you want to select all available results, chromatograms

or curves.

2 Click the Search button in the Found curves field.

Result: Alist of all curves that matched the search criteria is displayed in the

Found curves field.
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Step Action

3 o Selectthe checkboxes (or click the Select All button) of the desired curves
within the Found curves field.

o Click the Next button to proceed to the Peak Selection dialog.

Note:

If any of the results was not peak integrated before, or if different retention
units were used, you will be asked if you wish to proceed only with the results
that were integrated with the selected retention unit, or if you want to cancel
the wizard.

The Peak Selection dialog

The illustration below displays the Peak Selection dialog:

Peak Selection - Run 1 3]
Curve: UV 1_280_Chrom.TRun 1
Peak table: L 1_280@01 PEAK.-Edited_Chrarn 1:Aun 1
el , T UVAZB0NIEST — V1230
200
150
100
50
o i
a 20 50 100 120 140 160
—— Select Peak
Peak data |
No Sel | Peak name | Retention (ml] = Area [mPmall]  Height [mal]
1 9
2 5012 1202.1460 200751
El 53.48 9667461 111.350
Peak |dentification Settings
Alea Mumber Height Retention | At Window Peak name
<Back | [ Mew> | [ Cancel

Dialog description
The dialog displays the following properties for the first of the chosen curves:

¢ The integrated peaks and the associated peak table in Peak data.

* The Peak Identification Settings table. Its purpose is to identify the peak parameter
to be used for peak identification in the results.
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Adjust improper peak
integrations

The table below describes what to do if the peaks in the curve window do not appear
to be integrated properly (for example if ghost peaks are numerically labeled).

Step Action

1 Click the Cancel button to quit the wizard.

2 Perform a peak integration (see Section 5.2 Peak integration, on page 102)
and verify that the resulting curve is properly integrated.

3 Repeat the Multi Result Peak Compare wizard operation.

Step 3: Select the peaks

All peaks identified during the peak integration are numerically labeled. In this step the
peaks of interest are selected in the Peak Selection dialog, first manually in one curve,
then automatically in all selected curves.

Select the peaks in the first curve

¢ Double-click a peak in the curve window or click the peak once and then click the
Select peak button.

Result: The peak is assigned an identification letter (A, B, C....) in Sel column in the
Peak data table and under the peak in the Curves window. A row with the peak pa-
rameters is added in the Peak Identification Settings. The order of the letter is deter-
mined by the order of the selection.

* Repeat the selection for all peaks of interest in the curve.

Tip: Click and drag in the curve window to zoom into selected peaks to simplify
accurate peak identification. Right-click and click the Reset Zoom button to
reset the zoom to the full view.

Select identification criterion for each peak in the first curve

Set the desired peak identification criterion:

* Click the desired parameter in the Peak Identification Settings table. For example,
if you have selected the highest peak in the curve and want to compare the highest
peak among all curves, select the Height check box. The available parameters are:

- Area: Same relative area size.

Number: Same number in order after elution.

Height: Same relative height.

- Retention: Same retention value.
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- Peak name: Same peak name.

* Repeat the selection for all peaks of interest in the first curve.

Result: Based on this selection, UNICORN locates the corresponding peaks in all selected
curves and assigns the same identification letters.

Note:

More than one peak in a curve may fulfill the selected identification criteria.

In the illustration below, only the first peak has been selected and has therefore been
assigned the identification letter A. It is the third highest peak and has therefore 3 as
Height in the Peak Identification Settings table. Retention has been selected as identi-

fication criteria:

Peak Selection - Run 1 3]
Curves U 1_280_Chrorn 1 Fun 1
Psak tatle: (1 1_2B0G@ PEAK-Edited_Chrorn 1-Fur 1
el , T UVAZB0NIEST — V1230
200
150
3
100
S0
o i
o 20 40 B &0 100 120 140 160
Select Peak,
Peak data |
o Sel | Peak rame | Rtertion (ml] Avea (mFmal) | Height (mal) [ SetesPesk. ]
T T
2 5012 200 751
E] 53.48 5667451 111350
Pesak Idarification Settings
Arsa Mumber Height Retention | Aet window Peak name
A O3 1 Oz [v] 41.29 {10 O
Set Peak Mame.
<Back | [ Mew> | [ Cancel

Verify the peak identification in all selected curves

Use the Next curve and Previous curve buttons to navigate forward and backward
among your selected curves and manually check the peak identification made by the
software. Verify that UNICORN has identified the correct peaks in the Peak Identification
Settings table and/or curves window of each curve.

If UNICORN has identified other peaks than the intended ones, you can change the peak
identification manually according to the table below:
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If you want to... then...

remove a peak identifi-
cation

o click the desired peak in the curves window
o click the Set as peak button

o choose None in the Set As Peak dialog

e click OK.

Result: The peak in this curve will not be included in the
statistical calculation. The peak identification letter is re-
moved from the curves window.

replace or add a peak
identification

remove a row from the
table

e click a peak in the curves window
o click the Set as peak button
e choose a letter in the Set As Peak dialog

e click OK.

Result: The peak identification letter is replaced/added in
the curves window and Peak data table, and the row is
edited/added in the Peak Identification Settings table.

Note:

A red asterisk will be displayed in front of the identification
letter of all peaks that have been selected, to show that
the peak was not selected automatically by UNICORN.

o select the row

e click the Delete row button.

Result: All peaks with the same identification letter in the
selected curves are excluded from the statistical calcula-
tion. The peak identification letter is removed from the
curves window and Peak data table, and the row is re-
moved from the Peak Identification Settings table.

Note:

If you click Delete row without first selecting a row, the
first row (A) is deleted by default.

Other possible actions you can perform

If desired, you can assign a name to a chosen peak:

e Click the peak label of the row, for example A.

e Click the Set peak name button.

UNICORN 7.0 Evaluation Manual 29-1108-88 AA

187



5 Evaluate results
5.6 Multi Result Peak Compare wizard

e Type anew name and click OK.
Result: All peaks labeled A in the selected curves are assigned the name.

Tip: This can be useful when you compare multiple peak parameters and you wish
to have peak names other than “Peak A", “Peak B", etc., to simplify evaluation
of the comparison.

If desired, you can change the choice of curves.

e Click the Delete curve button to delete a curve from the comparison, if it does not
prove useful for your comparison.

e Click the Back button to navigate back to the Data Selection dialog to add new
curves to your comparison.

Peak selection completion

* Verify the identification of the corresponding peaks in the selected curves again, if
necessary.

¢ When all peak selections and identification settings are complete, click the Next
button to proceed to the Peak Data Selection dialog.

Step 4: Select the Peak Data

188

The illustration below displays the Peak Data Selection dialog:

Peak clion 5]

Select Peak Data: Select Scouting Variables:
[7] Peak name

[¥] Rietention

[ width

[7] Area

[Z] Height

[[] Peak endpaint ietentions
[] whidth at half height

[[] Percent of total area

[[] Percent of total peak area
[ Tupe of peak limits

[ Peak endpaint heights
[ Fraction tube id

[ Baseline height

[ Sigma

[Z] Resolution

[] Retention factor

[ Kav

[] Plate height HETP]

[ Asymmetry

<Back | [ Mew> 1| [ Cancel

The table below describes how to select the peak data:
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Step Action

1 ¢ Inthe Select Peak Data list, select the peak characteristics on the list
that you want to include in your comparisons.
« If available, select the appropriate Scouting variables.

2 o Click the Next button and proceed to "Step 5: The Data View dialog”
below.

Step 5: The Data View dialog

The Data View dialog presents a statistical comparison of the chosen data for the des-
ignated peak comparisons. The illustration below shows the dialog. In this example, there
are three curves and two identified peaks. Peak A has been named Protein 1, and peak
B named Protein 2.

Data View. E‘
A B C D E F G
1 Driginal Result Created Peak name Retention (ml) Area [(mFmAU) Height [mAU) Resolution
2 Peak A: Protein 1
3
4 testrun OO " £/16/2009 3:22:53 PM +02:00 Pratein 1 a6.08 B27.9613 108561
5 testrun 002 " 6/16/2009 3:22:58 PM +02:00 Pratein 1 ansy 6209827 121.874
g testun 003 " 6/16/2003 3:23.03 PM +02:00 Protsin 1 7649 5633433 122283
7 Mean 80839 610762 117806
g Std. Dev. 4087 24007 723
g Rel Std. Dev. 5056 343 6132

10 Peak B: Protein 2

12 testrun 001 " B/16/2003 3:22.53 PM 0200 Protein 2 1091 18237129 196.666 226
13 testun 002 " £/16/2009 3:22:58 PM +0200 Pratein 2 10014 19428853 181.74 1.85
14 testrun 003 " B/16/2009 3:23.03 PM +0200 Pratein 2 29.69 558.2303 1712 1.6

15 Mean 53641 120827 162 006 1908
16 5td. Dev. a4 563 038 38525 4332
17 Rel. Std. Dev. a749 46 558 2378 77428

[] Include Wizard Settings

Piint Preview. | [ Print | [ Save Speadshest | [ Save wizard Settings .|

The table below describes how to use the command buttons of the dialog:

Command button Function

Print Preview Opens a preview dialog showing what the Data View
spreadsheet will look like when printed.

Print Prints the spreadsheet.
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Command button Function ‘

Save Spreadsheet Allows you to save the result from the multi result peak
comparison as:

o an Excel file (xIs)

or

o Tabbed text (.txt)

Save Wizard Settings See "Save the Wizard Settings" below.

Close Ends the Multi Result Peak Compare wizard.

Save the Wizard Settings

The settings from the comparison can be saved, in order to use the same settings on
other results. The table below describes how to save the wizard settings:

Step Action

1 e Click the Save Wizard Settings button.

Result: The Save Wizard Settings dialog opens.

2 Type a name in the Wizard settings name field.

3 e If the settings are to be used by all users on the system, select the
Global wizard settings checkbox.

¢ Click Close to close the wizard.

Tip:
The Global wizard settings checkbox can also be used to toggle between
lists of stored global and stored user settings.

Open the stored wizard settings
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The table below describes how to open the stored wizard settings:

Step Action

1 e Open the Multi Result Peak Compare wizard and click the Select Stored
Wizard Setting button.

Result: The Select Wizard Settings dialog opens.
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Step Action

¢ Select the desired saved settings from the list.

o Click OK.

Result: The Multi Result Peak Compare wizard opens with the saved settings.
Tip:

The Global Wizard Settings checkbox is used to toggle between lists of stored
global and stored user settings.
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5.7  Rename folders, results, chromatograms, curves and
peak tables

Rename folders and files
Folders and files may be renamed in the Result Navigator either by

¢ right-clicking the object and choosing Rename from the shortcut menu
or
¢ choosing Edit:Rename:Navigator Object
This will highlight the name of the selected object and you can type a new name instead.

Note: You cannot rename assigned home folders.

Rename chromatograms, curves
and peak tables

The table below describes how to rename chromatograms, curves or peak tables in the
Evaluation Classic module.

Step Action

1 Choose Edit:Rename and the relevant option Chromatogram, Curve or
Peak Table.

Result: The Rename dialog opens.

2 e Select the appropriate object.
e Type anew name in the Name field.
Note: The original chromatogram or original raw data curves cannot be renamed.

They will not be available in the Rename dialog.
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5.8  Sign results electronically

Instruction

Result files can be signed electronically to enhance data file security. The table below
describes how to sign a result file electronically in the Evaluation Classic module:

Step Action

1 Choose File:Sign Result.
Result: The Sign Result dialog opens.

Sigh Result - Method Run, D01 (3]

Sign result ‘View signatures

Signing user ‘ Roger - |
Log on password ‘ |
Full name ‘ Roger Waters |
Job title: ‘ System Administrator |

Signature description peak integration perfarmed

Signature pazsword [ |
Lock

2 The Sign result tab shows the properties for the current user. You can also

choose another user from the droplist. If you choose a new user, the corre-
sponding password must be typed in the Log on password text box.

« Type your log on password in the Log on password field.

« Type a short text description for the signed operation in the Signature
description field (e.g. "peak integration performed").

The Lock check box is selected as default, to lock the result file from further

changes.

Note:

You should only lock the result when you are sure that the result file will not
be modified anymore.

3 « Type your signature password in the Signature password field.
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Signatures associated with the
result

The View Signatures tab of the Sign Result dialog provides a list of all signatures asso-
ciated with the current result. The information on this tab is for viewing purposes only
and cannot be changed.
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5.9 Save results

Introduction

After you have finished the evaluation process, you can save all the changes you have
made to the chromatograms, including newly created curves and chromatograms that
you have imported and created.

Delete unwanted curves

All the curves that you created during your manipulations will be saved in the chro-
matogram. If some of these curves are no longer needed, select Edit:Delete:Curves in
the Evaluation Classic module to remove the curves.

Note: The original curves that were created during the run can never be deleted.

Save the results

You can either save your edited results in the original file or in a new result file. The table
below describes how to save the results in the Evaluation Classic module.

If you want to save the = then...

edited results...

in the original result file | o select File:Save.
or

o click the Save toolbar icon.

=

in a new result file o select File:Save as.

Note: The previous version of the result file will be overwritten if you save the changes.
This cannot be reversed. However, the raw data curves remain unchanged.
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Exit the Evaluation Classic
module

The table below describes how to exit the Evaluation Classic module:

If you want to... then...
close only the click the red cross icon in the top right corner of the
Evaluation Classic mod- | module window.
ule
exit UNICORN choose File:Exit UNICORN.
Note: If there are unsaved changes, a dialog box opens with an option to save the

changes before exit.
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6 Import and export of folders and
results

About this chapter

This chapter describes how to import and export folders as well as results in different
formats.

In this chapter

This chapter contains these topics:

Section See page
6.1 Import and export folders 198
6.2 Import results 201
6.3 Export results 204
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6.1 Import and export folders

Import folders

Folders containing for example methods, method queues and/or DoE Results can be
imported into UNICORN. The table below describes how to do this.

Step Action

1 Select File:import:Folder(s)....
Laprie - ——
| e 4 | Curves \
«a  Log Off HANY' Entire Result(s)... 1
Exit UNICORN Dok Result(s)... :
+ [ Defect40721 Folder(s)... 1
+ [lHans G 201

Result: The Import dialog opens.

2 Browse to the folder of interest (*.UFol) in the Import dialog.
3 Open the folder by selecting it and clicking the Open button.
4 If the folder contains method queues a System Mapping dialog opens.
rSystem Mapping M1
Select a new target system for each system linked to imported method queues
Criginal system(s) Target systemis)
SystemN [ -
[ineon ] [ el ]

Select a Target system for each Original system listed.

Note:

To proceed with the import, there must be at least the same number of systems
active in UNICORN as the number of original systems.
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Step Action

5 Click the Import button to import the folder with all its content.

Note:

For a folder containing several method queues, the System Mapping dialog
is only shown once.

Note: During the import of a folder an Import Report is generated at the target lo-
cation.

Export folders

Folder export is recommended for bulk export of all items residing in a folder. During
folder export everything in the folder is exported regardless of application or object
navigator filter settings. If the folder contains compound objects, such as method queues
or Dok results, all individual items located outside the exported folder will be placed to-
gether with the exported folder.

The following table outlines the steps needed to export a folder containing for example
methods, method queues and/or DoE Results for later import into UNICORN.

Step Action

1 o Select a Folder in the Object Navigator. To select several Folders, press

Shift while you click the folders.
e Choose File:Export:to UNICORN:Folderf(s)...

p [ o
Export v To UNICORN 3 Curves
Import v Design of Experiment - Modde Entire Result(s)...
<3 Log OFf HANY Externally DoE Result(s)...
Exit UNICORN 0 Folder(s)...
7 ] Defectdtr2] 201
# ElHansG 20
# [ HaNY 201

= [E[HANY 1 (Manual) 201
e —

Result: An Export dialog opens.
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Step Action

2
R
¢ The export file may not contain the entire contents of the folder(s)
L& selected. The following will be excluded:
- Archived results
- Dok results and method queues having results/methods located in
folders where you do not have access.
Do you want to continue with the export?
[ o ][ concel
Click OK to continue the export.
Result: The Export to Another UNICORN database dialog opens.
3 Choose a location and click the Save button to save the folder.

Result:
e The folder is exported as a .UFol file.

e An Export Report is generated at the target location.

Note:
Export of multiple folders results in the generation of a single export file.
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6.2 Import results

Introduction
This section describes how to import curves and result data.

Note: During the resultimport an Import Report is generated at the target location.

Import curves

Individual curves saved in ASCII format (as *.asc or *.txt files) may be imported into the
active chromatogram. The table below describes how to import curves:

Step Action

1 e Choose File:import:Curves.

Result: The Import dialog box opens.

2 e Locate the file that contains the curve and click the file.

o Click the Open button.

Result: The Import Curves dialog opens, showing the available curves in the
file.

3 o Select the curve(s) to import.

e Click the OK button.

Result: The curves are opened in the active chromatogram.

Note: A curve can only be imported in the base unit that it was exported in. For vol-
ume base, the curve is shown in chromatogram with ml and CV as X-axis. For
time base, the curve is shown in in chromatogram with min as X-axis.

Import results

Results that have been exported from a UNICORN database may be imported into the
database again. The table below describes this:

Step Action

1 e Choose File:iImport:Entire Result(s)...

Result: The Import dialog opens.
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Step Action

2 e Locate and click the zip-file that contains the result. To select several
files, press Shift while you click the files.
e Click the Open button.

Result: The Import Result dialog opens.

3 o Select the destination folder for the result.

e Click the Import button.
Result: The result files are individually unzipped and imported into the selected
folder.

Note: A result file cannot be imported into a folder if the folder already contains a
result with the same name. In that case you must rename the file.

Import DoE results

DoE results that have been exported from a UNICORN database may be imported into
the database again. The table below describes this:

Step Action

1 Select File:import:DoE Result(s)...
Capt —
| Import s | Curves |
+a Log Off 'HANY' Entire Result(s)... 1
Exit UNICORN Dok Result(s)... !
+ [ Defect40721 Folder(s)... q
+ E Hans G 201

Result: The Import dialog opens.

2 Browse to the DoE result file (*.UdoE) of interest in the Import dialog.

3 Open the file by selecting it and clicking the Open button.

4 Click the Import button to import the DoE results.

Note: DoE results may also be imported by importing an entire folder, see Import

folders, on page 198.
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Import results from UNICORN 5

Results that only contain original data and have been created in UNICORN 5.11 or sub-
sequent versions can be imported into UNICORN 7.0. These are saved as .res files, not
.zip files. The results can be used for comparison with results created in UNICORN 7.0.
Import from UNICORN 5 is available for results created with some CU based systems,
for example, AKTApilot™ and AKTAprocess™.

The table below describes how to import result data from UNICORN 5:

Step Action

1 Select the destination folder where you want the imported results to be
shown in the Result Navigator Results tab.

2 Choose the File:lmport:Entire Result menu command.

Result: The Import dialog opens.

3 Choose UNICORN 5.* Result Files(*.res) as format in the Files of type field.
4 Locate and select the result files in the navigation field
Tip:
You can select several results at once by using the shift or Ctrl keys when
selecting.
5 Click the Open button

Result: The selected results are imported into the database and shown in
the Result Navigator in the selected destination folder.

Changes in data after import

When results are imported from UNICORN 5, there is some information that will not be
included. It is important to review the data after import, to verify that all essential infor-
mation is there. All functionality in UNICORN 7.0 is not available for imported results,
since necessary data might be missing.

Affected information ‘ Description

Analysis module related data | Any analysis module related data is not migrated.

Pooling For results containing pooled fractions, the pooling
curve will be included but not the pooling table.

Result layout Result layouts are not migrated.

Re-create method fromresult | It is not possible to re-create a method in UNICORN
7.0 from a result that has been migrated from
UNICORN 5.
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6.3  Exportresults

Introduction

This section describes how to export entire results and result items, including

curves
DoE results
documentation

peak tables
and

Design of Experiments projects

The section also describes how to copy items using the Windows clipboard.

Note:

During the result export an Export Report is generated at the target location.

Export options

Select File:Export in the Evaluation Classic module to export data from an open result
file. The following export options are available:

If you choose...

Then the options are...

to UNICORN

e Curves
e Entire Result(s)...

e DOE Resultl(s)...
or

e Folderls)...

Design of Experiments
- Modde

Export of a Design of Experiments to a MODDE™ 9 Inves-
tigation Project file.

Externally

e Curves
e Peak Table

e Documentation

or

e Copy to Metdfile

204
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These options are explained further below. (Folder export is described in Export folders,
on page 199))

Export entire results

One or several entire results may be exported for use in another UNICORN database.
The table below describes how to do this:

Step Action

1 o Select aresultin the Result Navigator. To select several results, press
Shift while you click the results.
o Select File:Export:To UNICORN:Entire Result.
Result: The Export to Another UNICORN Database dialog opens if one result
was chosen. The Browse For Folder dialog opens if several results were
chosen.
2 Result files are exported as compressed .zip files only.
¢ Select an export location. Make a new folder if desired.
e Type a name in the File name field in the Export to Another UNICORN
Database dialog if one result was chosen.
Note:
As the results are exported individually, it is not applicable to enter a
destination file name if several results are selected for export.
3

o Click Save in the Export to Another UNICORN Database dialog or OK
in the Browse For Folder dialog.

Result: The result is saved as a zip file. If several results were exported, each
result is saved as an individual zip file.
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Export DoOE results

DoE results may be exported for use in another UNICORN database. The table below
describes how to do this:

Step Action

1 e Select a DoE resultin the Result Navigator. To select several DoE results,
press Shift while you click the results.

o Select File:Export:To UNICORN:DOE Result(s)...
Result: A DoE Export dialog opens

2
Dok Export \ @
The export file may not contain the entire contents of the DoE result(s)
l . selected, The following will be excluded:
- Archived results
- Dok results having results located in felders where you do not have
Do you want to continue with the export? |
I QK l [ Cancel ]
e Click OK to continue the export.
Result: The Export to Another UNICORN Database dialog opens if one result
was chosen. The Browse For Folder dialog opens if several results were
chosen.
3 DoE Result files are exported as .UdoE files.
e Select an export location. Make a new folder if desired.
e Type a name in the File name field in the Export to Another UNICORN
Database dialog if one result was chosen.
Note:
As the results are exported individually, it is not applicable to enter a
destination file name if several results are selected for export.
4 o Click Save in the Export to Another UNICORN Database dialog or OK

in the Browse For Folder dialog.

Note:
Export of multiple DoE results results in the generation of multiple export files.
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Note: DoE results may also be exported by exporting an entire folder, see Export
folders, on page 199.

Export curves

The table below describes how to export curves in the Evaluation Classic module.

Step Action

1 e Choose File:Export:To UNICORN:Curves.

or
o choose File:Export:Externally:Curves

Result: The Export Curves dialog opens.

Export Curves 3]
Source Chromatogram: Curves to Export:
|Chrum.1 v| [1 uv 1_280_Chrom. 1:Manual Run 001

] uv 2_0_chrom. 1:Manual Run 001
[[] uv 1_280_cChrom.1:Manual Run 001 -~

[] wv 2_0_chrom.1:Manual Run 001

[ v 3_0_chrom. 1:Manual Run 001

[] Cond_chrom.1:Manual Run 001 —
[] % cond_chrom.1:Manual Run 001

[[] Conc B_Chrom.1:Manual Run 001

[] pH_chrom.1:Manual Run 001

[] system flow_Chrom.1:Manual Run 001

[[] system pressure_Chrom.1:Manual Run 001 -
Cuk curves Reduce number of samples
[[] Marmalize Retention
Reduce by Factor:
Fom O <
Max na, samples
Toi i
[ Cut graphically...
2 e Select the curvels) you want to export.

e Enter parameters to limit the curvels) if necessary (described in "Limit
the exported curves" below).

o Click the Select >> button.

e Repeat this step to select more curves.

3 Click the Export button.

Result: The Export Curves to File dialog opens.
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Step Action

4 Select the export file format from the Save as type droplist.

ASClII files (*.asc)
or

Comma Separated Values (*.csv)

5 e Select a destination folder.
e Type afile name and click Save.
Note: Curves are exported as series of numerical coordinates that refers to the

time/volume and signal respectively.

Limit the exported curves

208

You can optimize the exported curves to only the parts that you want to focus on, in the
Export Curves dialog. The table below describes how to use these editing options.

Option Instruction

Cut curves Enter retention values in the text boxes to limit the curve
to only a portion of the original curve.

Cut graphically This button opens a graphicalExport Curves dialog. Move
the vertical markers to the correct cutoff points.

w 1

Reduce number of Adjust the factor value or the maximum number of samples.

samples To reduce the number of samples by a factor of five means
that only every fifth point will be sampled for export.
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Instruction

Normalize retention Select the Normalize retention checkbox to have all export-

ed curves normalized to a common X-axis.

Export peak tables

The table below describes how to export peak tables.

Step

Action

1

Note:

Choose File:Export:Externally:Peak Table.

Result: The Export Peak Table dialog opens.

Select the source chromatogram and the peak table you want to export.

Click the Export button.

Result: The Export Peak Table To File dialog opens.

Select the export file format from the Save as type droplist:

ASCll files (*.asc)
Excel files (*.xls)

XML files (*.xml)

Select a destination folder.
Type a file name.

Click Save.

Peak tables are exported as text strings in ASCII or XML format and numerical
values in the Excel format. All possible columns in the peak table are exported.
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Export documentation

210

Action

The table below describes how to export the run documentation:

e Choose File:Export:Externally:Documentation.

Result: The Export Peak Table dialog opens.

Export Externally - Method Run 001

Iterns:
Test instructions
Wariable list

Start protocol

System settings
Calibration

Evaluation log

Fun lag
Alarmwarnings/errors
Methad
Manual
Spstem

Fiun log baze

&) Time O Volume

Result information
Infarmation

Run summary

Methad infarmation
Infarmation

3]

e Select the report items you want to include in the exported documenta-

tion.

Tip:

Sub-menu items are available only if the top item is selected. For example,
you must select Method Information first to be able to select Information

and Signatures.

e Click the Export button.

Result: The Export Documentation to File dialog opens.

Select the export file format from the Save as type droplist:

e ASCll files (*.asc)

o Excel files (*.xls)
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Step Action

5 e Select a destination folder.
e Type afile name.

o Click Save.

Export the chromatogram to a
Windows metdfile

You can export an image of the open chromatogram as a Windows enhanced metafile.
This image format can be used in other applications, for example Microsoft® Word or
PowerPoint®. The table below describes this export:

Step Action

1 e Choose File:Export:Externally:Copy to Metdfile

or
e Right-click in the chromatogram and choose Copy to Metdfile

Result: The Export Chromatogram to Windows Enhanced Metadfile dialog
opens. The only available file type is Enhanced Meta File (*.emf)

2 e Select a destination folder.
e Type afile name.

e Click Save.

Export Design of Experiments

Design of Experiments may be exported for use in the Design of Experiments application
MODDE. The design is exported in the specific format MODDE 9 Investigation Project

(* .mip).

Tip: The evaluation of Design of Experiments results is described in the UNICORN
Method Manual.
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Copy to the clipboard

You can use the Windows clipboard to copy the contents of the active window and paste
it into other programs. The table below describes how to do this:

Step Action

1 e Choose Edit:Copy
or

e Right-click and choose Copy to Clipboard
or

e Click the Copy icon

Result:

« If the active window only contains a chromatogram, it will immediately
be copied to the clipboard as a Windows metdfile.

« If the active window also contains a peak table, the Copy to Clipboard
dialog opens.

2 Select one of the options:

e Copy curve window as enhanced meta file

o Copy selected peak table data as tabbed text

3 Click the OK button.
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7/ Other evaluation operations

About this chapter

This chapter describes how the results can be used for other types of evaluations. It also
contains information about how to automate frequently used evaluation procedures.

In this chapter

This chapter contains these sections.

Section See page
7.1 Curve operations 214
7.2 Evaluate a column performance test 226
7.3 Automated evaluation procedures 231
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7.1  Curve operations

About this section
This section describes:
* How to evaluate single curve data points in chromatograms
* How to reduce the noise from curves and remove ghost peaks

* How to use arithmetic operations on curves

and

* How to find slope values that can be used for example as watch instruction param-
eter values

In this section

This section contains these subsections:

Section See page
7.1.1 Evaluate single curve data points 215
7.1.2 Reduce noise and remove ghost peaks 218
7.1.3 Add, subtract or divide curves 220
7.1.4 Find slope values 223
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7.1.1 Evaluate single curve data points

Introduction

It is possible to determine the coordinates of any point on a curve and to obtain values
for retention and peak height. This is a useful tool for many other functions, such as for
measuring the parameters used in baseline calculations.

Measurement options
Coordinates can be obtained in two ways:
* Through direct measurement.

* From pecak table data.

Direct measurements

The table below describes how to make direct measurements in a chromatogram:

Step Action

1 Right-click in the chromatogram and select Vertical marker.

Result: A vertical line is set in the chromatogram. A text box in the top left
corner of the chromatogram displays the X-axis and Y-axis values of the
curve at the point where the marker line crosses the curve. See the illustration
below:

Throm.1

Kzarm
|V 156,045 mal —— UV 1_280Q01,SMTH (1)_Chrom.1:Manual Run 001 - LIV 1_260213 BASEM_Chrom1-Hanusl Run 001

mal

180 7

GENBREA8ABRIABRBAE

028

1884

| v 1_zoerapea |

Tip:
The color of the Vertical marker is the same as the selected curve.
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7.1 Curve operations

7.1.1 Evaluate single curve data points

Step
2

Action

Move the marker with your mouse to display the peak position in X-axis and
Y-axis values. The mouse pointer changes into a double-headed arrow when
it is properly placed over the marker.

Click the curve name legend above the chromatogram to change to another
curve.

Result: The Y-axis is changed to the one corresponding to the new curve.

Right-click and select Vertical marker again to de-select the function.

Set a reference point

The table below describes how to set a reference point:

Step

Action

1

e Right-click in the chromatogram and select Vertical marker.

e Move the marker with your mouse to the place for the reference point.

Right-click in the chromatogram and select Set vertical marker reference
point to define a reference point for the marker position.

Drag the marker away from the reference point and read the X-axis and Y-
axis values for the new position. You can also read the

e Delta

e Mean

e Min
and

e Max

curve values for the interval between the reference point and the new posi-
tion.

Note:

216

The curve interval between the reference point and the new marker position
is shaded in the chromatogram.
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Record a Snapshot

The table below describes how to record a Snapshot of the curve values at a specific
volume or time point:

Step Action

1 e Right-click in the chromatogram and select Vertical marker.

« Move the marker with your mouse to the place for the snapshot.

2 Right-click in the chromatogram and select Snapshot from the shortcut
menu.

Result: The Snapshot dialog opens.

3 The dialog displays all the curve data for the Y-axis value where the snapshot
was taken.

¢ Click the Save button to save the snapshot as a text file.

o Click the Print button to print the snapshot.

4 Click the Close button to close the dialog.

Select peak table data

The retention time and amplitude of any peak can be viewed directly in a peak table
after anintegration. These data and more are selected in the chromatogram Customize
dialog. The table below describes how to select peak table data.

Step Action

1 Click the Customize icon.

Jy

Result: The Customize dialog opens.

2 Click the Peak Table tab of interest.
3 ¢ Selectthe checkboxes on the Select peak table columns list for all items
that you want to display in the table.
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7.1.2 Reduce noise and remove ghost peaks

7.1.2 Reduce noise and remove ghost peaks

Introduction

Sometimes the chromatograms contain curves with a noisy baseline. The noise can be
caused by several factors, for example a dirty flow cell, air bubbles, electrical noise, dirty
buffers, etc. The amount of noise can usually be reduced by taking proper precautions,
for example filtration of buffers and instrument maintenance.

You can also use the smoothing function to reduce or remove background noise from
a selected curve. Smoothing is always a compromise between noise removal and
preservation of peak shape.

Smooth a curve

The table below describes how to select a smoothing function and smooth a curve:

Step Action

1 Select Operations:Smooth.

Result: The Smooth dialog box is displayed.

2 Select the curve to be smoothed and its target destination.

3 Select the Filter type to be applied. The options are:

218

Moving average

Use this if you have noise along most of the curve. It affects peak height
but not retention. There is little effect on the peak area.

Autoregressive

Use this if you have periodic noise along the whole curve. It affects peak
height and retention, although this has little effect on the peak area.

Median

Use this if there is only one or a few noise spikes, for example caused
by air bubbles, or if the noise is confined to only a small part of the curve.
It can flatten peaks and affect peaks areas slightly, but does not affect
retention.

Savitzky-Golay

Use this to calculate the smoothing and differentiation of data by a least
squares technique.
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Step Action

4 Select an appropriate smoothing parameter value from Light to Hard for
the selected filter in the Filter Parameters field. Use the slider, or insert a
value manually in the text field. The manual value has the same unit as the
chromatogram. The smoothing effect increases with increasing parameter
values.

Result: A smooth curve is added to the chromatogram. By default, smoothed
curves are given the suffix SMTH. The default curve name can be changed
as needed.

Tip: Start with a low parameter value, for example the default value, and increase
it until the best result is achieved. A useful strategy is to increase the parameter
value by the default value for each try.
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7.1.3 Add, subtract or divide curves

Introduction

In some method runs, several sequential chromatograms might have been created. This
can occur, for example, when the instruction New chromatogram has been used in the
method, thus creating different chromatograms during the run. In order to view and
evaluate the resultant curve of all the chromatogram parts, the curves must be added
together. Usually, you have a number of chromatograms within the same result file and
you want to add the curves. In some circumstances, curves might need to be imported
from other result files.

Sometimes the presentation of a curve may benefit if a blank run curve or a baseline
curve is subtracted from the curve. For example, this is useful when the curves have a
drifting baseline or ghost peaks.

Curves may also be divided, for example to determine the ratio between curves as a
means to study peak purity or to identify peaks. This is described in Section 5.4.4 Peak
purity and peak identification, on page 158.

Add curves

The table below describes how to add several curves to form a combined, cumulative
curve:

Step Action
1 Select and view the first chromatogram in the sequence.

2 Choose Operations:Add.
Result: The Add dialog is displayed.
3 e Select the source chromatogram in the chromatogram list and the first

curve in the desired sequence in the left Source chromatogram and
curve field.

o Selectthe chromatogram in the chromatogram list and the second curve
in the sequence in the middle Source chromatogram and curve field.

Note:

The suggested curve number is highlighted in the Target chromatogram
and curve field. A default name is displayed in the Curve name box.

e Click OK to add the two curves together in a new result curve in the first
source chromatogram.

220 UNICORN 7.0 Evaluation Manual 29-1108-88 AA



Step
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Action

¢ Open the Add dialog again to add more curves to the result curve.

o Select the chromatogram in the chromatogram list and the result curve
(.ADD) from the previous addition in the left field.

o Select the chromatogram in the chromatogram list and the next curve
in the sequence in the middle field.

¢ Click OK to add the two curves together in a new result curve in the first
source chromatogram.

Repeat step 4 until all curves have been added together. The final curve
should be the cumulative curve for the whole run.

Note:

All curves created using the Add operation receive the ADD suffix by default.
The default curve name can be changed as needed. The original curves are
distinguished in the chromatogram by underlined curve names.

Subtract curves

The table below describes how to subtract curves:

Step

Action

1

Choose Operations:Subtract.

Result: The Subtract dialog is displayed.

¢ Select the chromatogram in the chromatogram list and the first curve
in the left Source chromatogram and curve field.

o Select the chromatogram in the chromatogram list and the curve you
want to subtract from the first curve in the middle Source chromatogram
and curve field.

e Click the OK button.

Result: The second curve is subtracted from the first and a new result curve
of the difference is created in the first source chromatogram.

Note:

All curves created using the Subtract operation receive the SUB suffix by de-
fault. The default curve name can be changed as needed. The original curves
are distinguished in the chromatogram by underlined curve names.
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Divide curves

222

The table below describes how to divide curves:

Step

Action

1

Choose Operations:Divide.

Result: The Divide dialog is displayed.

e Select the chromatogram in the chromatogram list and the first curve
in the left Source chromatogram and curve field.

e Select the chromatogram in the chromatogram list and the curve you
want to divide the first curve with in the middle Source chromatogram
and curve field.

If necessary, select the Threshold option and enter Y-axis threshold values.
You may enter different values for each curve.

This option is available only for the Divide operation. If one of the two curves
that are divided has values below the threshold, the resulting curve value
will be 1 at those data points.

e Click the OK button.

Result: The first curve is divided by the second and a new result curve of the
quotient is created in the first source chromatogram.

Note:

All curves created using the Divide operation receive the DIV suffix by default.
The default curve name can be changed as needed. The original curves are
distinguished in the chromatogram by underlined curve names.
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Find slope values

With AKTA™ design systems it is possible to just collect peaks by conditional peak frac-
tionation. The way to find suitable slope values for a particular run is described in this
section.

Where to use slope values

The slope values can be used in the Method Editor
e as Start slope and End slope values in the Peak Fractionation Settings.
e as parameters for the Watch instruction.

Using slope values for Watch instructions

Conditional Watch instructions can be set up to let the progress of a run be determined
by the events during the run (e.g., start to collect fractions when the first peak emerges).

The slope of the curve can be set as a condition to satisfy a Watch condition in the
method during the run. It is important to use accurate slope values for the specific Watch
instruction parameter.

A sample run

You must first make a separation run with the sample you intend to purify. The result
from this separation run is then used to find the slope values.
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Retention scale

Time should be used as the X-axis scale for retention.

Step Action

1 Click the Customize icon.

Result: The Customize dialog opens.

2 « Click the X-axis tab.
o Select Time in the Base field.

Differentiate the curve

The slope values are measured on a differentiated curve. The table below describes how
to create a differentiated curve.

Step Action

1 Select Operations:Differentiate.

Result: The Differentiate dialog opens.

2 e Select the chromatogram and the UV curve you want in the Source
chromatogram and curve list.
e Click the First order option button.
3

Result: The differentiated curve opens in the chromatogram.

Measure the slope values

224

Sometimes the differentiated curve must be filtered to reduce noise and ghost peaks
before the measurements. See section Section 5.4.4 Peak purity and peak identification,
on page 158.

The table below describes how to measure the slope values on the differentiated curve.

Step Action

1 Select the differentiated curve (The text Differentiation will be shown in
brackets above the Y-axis.).
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Step Action

2 Use the zoom function to magnify the curve over an appropriate area.

3 Right-click and select Vertical marker from the shortcut menu.

Result: A vertical marker bar opens in the chromatogram.

4 Place the marker at the beginning of a peak where you want the Watch
conditions to be fulfilled (i.e. where the slope becomes higher).

5 Read the actual slope value in the active marker text box in the top left corner
of the chromatogram pane.

Note: The unit for the differentiated curve is mAU/min or AU/min. Any Y-axis value
for the differentiated curve is the UV curve slope at the selected retention point.

Tip: Measure the slope at the beginning and the end of the smallest, flattest peak
of all the peaks of interest, and use these values.

Illustration: Slope value
measurement

The illustration below shows a measurement of the slope limit after differentiation:
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7.2 Evaluate a column performance test

Introduction

The quality of the packed bed of a column is checked by performing a column perfor-
mance test. Tests should be made directly after packing and at regular intervals during
the working life of the column and also when separation performance is seen to deteri-
orate. The best method of expressing the efficiency of a packed column is in terms of
the height equivalent to a theoretical plate (HETP) and the asymmetry factor (Ay). The
column performance test calculates these values, which can be stored as statistics in
the Column Logbook.

Note: The calculated plate number will vary according to the test conditions and it
should only be used as a reference value. It is important that test conditions
are kept constant so that results are comparable. Changes of solute, solvent,
eluent, sample volume, flow velocity, temperature, etc. will influence the results.

Tip: Refer to the column and/or media instructions for suggested solvents, flow
rates etc.

Method for measuring HETP and

As
The column performance test calculates HETP and A, from the integrated UV curve as
follows:

HETP calculations

L = Bed height (cm)

HETP =3 N = number of theoretical plates
Vg =retention volume
2 B . )
N = 5.54 x ﬁ) W, = peak width at half height
Wh Vg and Wy, are in the same units.

The concept of reduced plate height is often used for comparing column performance.
The reduced plate height is calculated as follows:
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HETP
d50v

dsg, is the mean diameter (m) of the beads.

As a guideline, a value of <3 is normally acceptable.

Peak asymmetry factor

The peak should be symmetrical, and the Asymmetry factor as close to 1 as possible.
Values between 0.8-1.6 are usually acceptable. A change in the shape of the peak is
usually the first indication of bed deterioration due to excessive use.

Peak asymmetry factor calculation:

b a = 15 half peak width at 10% of peak height
=
a b = 2" half peak width at 10% of peak height.

lllustration of a curve

The illustration below shows a UV curve for acetone in a typical test chromatogram from
which the HETP and A, values are calculated.

Absorbance

50%

[ 10%

Volume
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Evaluate the column

performance test

228

Follow the instruction below to evaluate a column performance test.

Step

Action

1

Browse for and open the column performance test result in the Result
Navigator in the Evaluation Classic module.

Result: A dialog is displayed and describes how to save the column perfor-
mance statistics in the Column Logbook. It is not necessary to close this
dialog to proceed with the peak integration.

How To: Save Column Performance Statistics @

Save columh performance statistics for the individual
calumn by

1) Open Pesk Integrate dialog,

2) Revise bed height if necessary and integrate.
3) Right click the peak in peak table.

4) Save column performance statistics

Hote:

2 revized bed height can alzo be changed for the column
type in the column logbook. This wil affect wn
parameters far all individual columns of this calumn type.

[ Do not shaw this message again.

Perform a peak integration as described in Section 5.2.2 Perform a peak in-
tegration, on page 105. Select the UV (280) curve.

Note:

By default, all peaks except the largest will be rejected at the peak integration.

When evaluating the performance of custom packed columns (e.g. AxiChrom™
columns), the measured bed height should be entered in the Column height
(bed height) field of the Peak Integrate dialog. The bed height for the column
type will be used by default if the measured bed height for the individual col-
umn is not entered.
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Step Action

3 Select the peak for column performance statistics in the peak table by
clicking the peak number.

—— UV1 280 Chrom.T:HiScreenCapto ColPerf Test001 — —— LIy 1 _280@01 BASEW (1)_Chrom 1 HiScresnCapto Col
1380

[i] 1 2 3 4 3 3 7 8 a 10 1 12 13 14 15 16

A; UV 1_280@01 PEAK |

Peak data | Integration summary

Mo Peak name | Retention [ml] Area (mImAl)  Height [mAU) | Sigra (ml] | Plate height (cm)  Plates per meter | Resolution | Asymmetry | Retention factor

o E tez04l 2ol sl 242]]

4 To store the column performance result as statistics for the individual column
in the Column Logbook, right-click the selected row and select Save Column
Performance Statistics.
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Step
5

Action

e Click the Column Handling icon.

e Select the Column Logbook tab.

Result: Column Performance statistics for the individual column is displayed
in the Column Logbook table. The Column Data include

Asymmetry, Plate height and Plates per meter.

[Column Handing
SRS T Colmn Type Parameers ol Logbock |
Show by techniaue:

[Cation Exchange -

Select Calumn IDs

Code lot e D
Sho by access label FindbyD: [ - - - Clear
4
1 P Find by sliss: [Froject 03° Find

¥ Global types, user created
¥ Personal types, user crested Columns: Column Logbook:

Column types: D

Alias olumn Data
28.9263.79 20090119 200301 0001 | Project 03 Polishing

Number of uns 7
Max of deka presaure (MPa) 051

Asymmetry” 119
Plate height™ (cm) 000614
Plates per meter” (N/m) 162804

*Caloulated based on the last Column Performance test

T | | | | [l R | Eermmims || o]

Note:

230

Changing the bed height for an individual column (for example an AxiChrom
column) in the Peak Integrate dialog will not automatically change the bed
height for the column type. To be able to create methods that are based on
the correct bed height for this individual column, you will need to create a new
column type with this bed height and choose the type when creating the
method. This will ensure that the correct bed height is used.
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7.3 Automated evaluation procedures

About this section

Frequently used evaluation procedures can be recorded and saved. The saved sequence
of procedure instructions can be included as part of a method. When the method is run,
the evaluation procedures will be performed automatically. This section decribes how
to create and edit procedures and how to work with the Procedure Editor.

In this section

This section contains these subsections:

Section See page
7.3.1 Create a new procedure 232
7.3.2 Edit a procedure 235
7.3.3 Run a procedure 238
7.3.4 Rename or remove procedures 242
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7.3.1 Create a new procedure

Introduction

You can use the Procedure Editor to record or create a new procedure. The Procedure
Editor can also be used to view and edit the instructions within a procedure. This section
describes how to use the Procedure Editor to record new procedures.

The Procedure Editor dialog

The illustration below shows the Procedure Editor in Record mode.

Procedure Editor Untitled ['_}k
File  Control  Help

|j|:| Mode:  Recaord

BASE[YOLUME |

Instruction Parameter
(%) Curve operation | ADD A Insert
) AMP_MIUL 3
O Integration AMP_SHIFT Fieplace
. ) CLEAR

() File operation Copy Delete
() Export cur

DERIMATE 8 |
O chram Dl

HISTOGRAM
O other INTEGRATE

RET_MUL
Orest RFT SHIFT v

Calculate bazeline morphological

Record a procedure

The table below describes how to record a new procedure.

Step Action

1 Open a result file in the Evaluation Classic module.

2 Choose Procedures:New.

Result: The Procedure Editor dialog opens in Edit mode.
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Step Action
3 Start the recording
e Choose Control:Record
or

e clickthe REC icon.

REZ
4 Minimize the Procedure Editor dialog.
5 Perform the evaluation steps that the procedure is to contain.

Result: The steps are recorded in the order that they are performed.

6 Stop the recording
e Restore the minimized Procedure Editor dialog box and select Con-
trol:End Record.
or

e Restore the minimized Procedure Editor dialog and click the Stop button.

#

7 Choose File:Save or File:Save As in the dialog.
Result: The Save As dialog opens.
8 ¢ Type a name for the new procedure in the Procedure name text field.

e Selectthe Global procedure checkbox if desired (see further information
below).

o Click OK.

Result: The procedure is saved and available for future use, for example as
part of a method.

9 Click the Close button to close the dialog.
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Create a Global procedure

Build a procedure with

instructions

234

You can choose to save the new procedure as a Global procedure. This makes the pro-
cedure available to all users. The procedure will have (Global) before the name to desig-
nate that it is available to all users.

Note:

You must belong to an Access Group with Create/Edit Global Objects autho-

rization to be able to save Global procedures.

You can select instructions in the Procedure Editor dialog to build a complete procedure
step by step. The procedure instructions are described in Appendix A.4 Evaluation proce-
dure instructions, on page 265. The table below describes how to create a new procedure
with instructions.

Step Action

1 Choose Procedures:New.

Result: The Procedure Editor opens in Edit mode.

Select an instruction type from the Instruction list (e.g., Curve operation).

Select the appropriate instruction from the field to the right of the instruc-
tion types.

Select or type the appropriate parameter values in the Parameter field.

e Click Insert.
3 Repeat step 2 until the procedure is complete.
4 Choose File:Save.
5 Type a procedure name and click OK.
6 Click the Close button in the Procedure Editor.
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7.3.2 Edit a procedure

Introduction

Evaluation operations are represented by instructions in the Procedure Editor dialog
box. The instructions can be modified to suit other specific evaluation needs and be
saved for later use. This section describes how to use the Procedure Editor to edit a
procedure.

Edit a procedure

The table below describes how to edit an existing procedure:

Step Action

1 Select Procedures:Edit:Open.

Result: The Open Procedure dialog opens.

2 Select the procedure from the list and click OK.

Result: The Procedure Editor opens in Edit mode.

3 Select an instruction in the procedure window.

Result: The instruction and the corresponding parameters are displayed in
the Instruction and Parameter fields. A short definition of the selected in-
struction is displayed at the bottom left corner.

4 Type or select new values in the Parameter fields and click the Replace
button.

Result: The old parameters are replaced by the new parameters.
5 Add a new instruction

¢ Select the instruction in the procedure immediately before where you
want the new instruction.

o Select a type and an instruction in the Instruction field.
o Select or type parameter values in the Parameter field.
e Click the Insert button.

Result: The new instruction is inserted after the selected instruction.

6 Remove an instruction

Select an instruction in the procedure and click the Delete button to remove
the instruction from the procedure.
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Step Action

7 e Choose File:Save

and

« click the Close button to close the dialog.

Descriptions of the procedure
instructions

Appendix A.4 Evaluation procedure instructions, on page 265 contains a list of procedure
instructions with descriptions.

Add instructions to a procedure
by recording

If you start recording again you can add more instructions to a procedure that is already
open in the Procedure Editor:

¢ The new instructions will be added to the end of the present procedure.

or

¢ The new instructions will be inserted after the selected instruction if an instruction
has been selected.

Invalid instructions

The procedure will stop and display an error message if aninstruction calls for an invalid
operation when the procedure is run. Any subsequent instructions in the procedure will
not be executed.

Address the right curves

Curves are identified only by their storage position. An instruction can become invalid if
it addresses the wrong curve:

Example

¢ Theinstruction ADD (01,02,03) will try to add curve 01 to curve 02 and store the result
in position 03.

* Acurvein position 03 that is not a raw data curve will be overwritten.
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* Araw data curve in position 03 cannot be overwritten and the procedure will be
stopped at that point.

Default values for classic
baseline instructions

When a classic or morphological algorithm is used to calculate a baseline, UNICORN will
suggest default values for the four control parameters based on the appearance of the
curve. To instruct UNICORN to use default values appropriate for the curve every time
the procedure is run, choose the default setting in the appropriate fields for the param-
eters.

Example

* CALCULATE BASELINE (01, 06, XXX, XXX, XXX, XXX)

Can be changed to:

® CALCULATE BASELINE (01, 06, DEFAULT, DEFAULT, DEFAULT, DEFAULT)

Global procedures

It is not advisable to edit existing global procedures. Open the global procedure instead
and save a copy under a new name. Use this copy for editing purposes.
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7.3.3 Run a procedure

Introduction

You can run the saved procedures either for a specific chromatogram or for multiple
chromatograms.

Run a single procedure

The table below describes how to run a procedure for a single, specific chromatogram.

Step Action

1 Open a result file.

2 Select Procedures:Run.

Result: The Open Procedure dialog opens.

3 Select the procedure from the list and click OK.

Result: The procedure is executed. A confirmation message is displayed.

Tip: You can also open the procedure in the Procedure Editor dialog and choose
Control:Run or click the Play icon.

Run on multiple chromatograms

It is possible to apply an evaluation procedure to a designated batch of several result
files if they are not open in the Evaluation Classic module. An open file will not run and
an error message will be displayed.

The run on multiple chromatograms is performed in the background of the Evaluation
Classic module and the results of the run are not seen, with the exception of prints and
documentation that are defined as steps in the procedure. For example, runs on multiple
chromatograms are useful

¢ to perform integration with the same parameter settings on many results,

or

* to print a number of results with the same settings.
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The Apply on Multiple
Chromatograms dialog

The illustration below is an example of search results in the Apply on Multiple
Chromatograms dialog:

Apply on Multiple Chromategrams ( Peak integration smooth curve )

Chrornatogram selection

Folder | fFioger/Results/DoE 1D DoE_1 (3] | | Browse.. |

®

Result:

v|[ Browse... ][ A

Chromatogran:

" vH Browse. .. H 1

Found chromatograms

Search Chrom.7 | DoE (D DoE_1 001 | Roger/Resultz/DokE 1D DoE_1[3) ”~
Chrom.1 | DoE 1D DoE_1 002 | /Roger/Results/DokE 1D DoE_1 (3]

Chrom.1 | Dok 1D DoE_1 003 | /Roger/Pesults/DoE D DeE_1[3)

Chrom.1 | DoE 1D DoE_1 004 | /Roger/Results/DoE 10 DoE_1 (3]
Chrom.1 | Dok 1D DaE_1 005 | /Rager/Results/Do 1D DaE_1[3)
Chrom.1 | DoE 1D DoE_1 006 | /Roger/Results/Dok 10 DoE_1(3)
Chrom.7 | Dok [0 DoE_1 007 | Roger/Resultz/DokE D DoE_1[3) . -
Chrom.1 | DoE 1D DoE_1 008 | /Roger/Results/DoE 10 DoE_1 (3]
om.l | DoE D D |:|E_1 009 | oEID D |:|E_1 [Ei]

[ Hun%’l[ Cancel

€]

Perform a procedure run on
multiple chromatograms

The table below describes how to perform a batch run on multiple chromatograms:

Step Action

1 Choose Procedures: Run on Multiple Chromatograms.

Result: The Open Procedure dialog opens.

2 Select the procedure from the list and click OK.

Result: The Apply on Multiple Chromatograms dialog opens.
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Step

3

Action

Use the Browse buttons to find and select the folders, result files and chro-
matograms you want to search. Click the mouse button while pressing Ctrl
to select several items.

Tip:

The search will only be performed in the selected folder, result and/or chro-
matogram. You can use standard wildcard characters and define restricting
search criteria for the Result and Chromatogram fields. Up to 10 user-defined
search filters can be saved in the drop-menus.

Click the Search button.

Result: A list of found chromatograms is displayed.

Select the chromatograms you want to perform the run on.

e The Select All button selects all chromatograms.

e The Clear button removes all chromatograms from the list.

Click the Run button.
Result: The evaluation procedure is performed on each of the selected

chromatograms and any created curve or peak table will automatically be
saved in each result file.

Note:

A Batch Run Log will open after the last procedure run is performed, listing
any chromatogram where the procedure was unable to run. This dialog does
not open if all runs are successful.

Generate reports from multiple
chromatograms

Evaluation procedures applied on multiple chromatograms can be a useful tool to produce
printed documentation simultaneously for many result files (e.g., for a number of scouting
runs). The table below describes how to create a procedure to generate reports for sev-
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eral results.
Step Action
1 Start the recording of a new procedure and minimize the Procedure Editor.

2

Choose File:Report.
Result: The Generate Report dialog opens.

UNICORN 7.0 Evaluation Manual 29-1108-88 AA



7 Other evaluation operations
7.3 Automated evaluation procedures
7.3.3 Run a procedure

Step Action

3 Choose a report format.

4 e Click the Print button.

Result: The Print dialog opens.

o Click the OK button.

¢ Click the Close button to close the Generate Report dialog.

5 Maximize the Procedure Editor and click the stop button.
6 Save the procedure.
Tip:

A printing procedure can also be saved with a method, to produce automatic
prints at the end of a run.

Note: When a procedure is applied on several results, the latest version of the proce-
dure will be used. However, procedures that are saved with a method are not
affected if the original procedure is edited at a later time.

Add procedures to the Quick
Menu

You can add selected evaluation procedures to the Procedures menu in the Evaluation
Classic module. The table below describes how to add procedures to the menu:

Step Action

1 Select Procedures:Edit Quick Menu.

Result: The Edit Procedures Menu dialog opens.

2 o Select the checkboxes of the procedures you want to display on the
menu.
o Click OK.

Result: The selected procedures are included on the Procedures menu.

Remove a procedure

Open the Edit Procedures Menu dialog and select the checkbox again to de-select and
remove a procedure from the menu.
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7.3.4 Rename or remove procedures

Introduction

The procedures that you have created can be renamed or removed from the list of
available procedures. This section describes how this is done.

Rename a procedure

The table below describes how to rename a procedure.

Step Action

1 Choose Procedures:Edit:Rename.

Result: The Rename Procedure dialog opens.

2 Select a procedure.

Result: The procedure name is displayed in the New Name text box.
3 Type the new name.

4 Click OK.

Result: The procedure name is changed.

Delete a procedure

The table below describes how to delete a procedure.

Step Action

1 Choose Procedures:Edit:Delete.

Result: The Delete Procedure(s) dialog opens.
2 Select a procedure.

o Click the Yes button to confirm.

Result: The procedure is deleted.
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Global procedures

It is not advisable to edit existing global procedures. Open the global procedure instead
and save a copy under a new name. Use this copy for editing purposes.

UNICORN 7.0 Evaluation Manual 29-1108-88 AA 243



8 Troubleshooting

8 Troubleshooting

About this chapter

This chapter describes different problems that may arise when performing result evalu-
ations in UNICORN, and how to solve the problems.

Evaluation procedure aborts

The table below describes a problem and its solution:

Problem description

The evaluation proce-
dure aborts

Solution ‘

Instructions in an evaluation procedure refer to curves by
identification number irrespective of the curve names. Make
sure that the curves processed when the procedure is exe-
cuted are compatible with those processed when the proce-
dure was recorded. An evaluation procedure aborts if you
try to store the resulting curves at the position of an original
raw data curve.

Maximum number of curves
exceeded

The table below describes a problem and its solution:

Problem description

Solution

The maximum number of curves (100) | The injection curve is also included for each
are exceeded when importing curves | curve that is imported. Delete the unneces-

sary curves before importing more curves.
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Distorted peaks

The table below describes a problem and its solution:

Problem description Solution

Peaks appear distorted | A high UV averaging time value will distort and delay the
pecks. A high UV averaging time shall only be used when
very large and broad peaks are expected.

Column performance test errors
The table below describes problems and their solutions:
Problem description ‘ Solution

The Column Performance Test attribute | Verify that the proper steps have been
is missing in the Run History performed during the evaluation.

No column performance parameters | Verify that you have right-clicked on the
are saved in the column logbook actual peak in the peak table when saving
the performance statistics.

The column performance parameter Verify that the adjust zero retention value
values are wrong is set to the injection.

Retention time differences

The retention value in the peak label in the chromatogram may differ from that in the
peak table or that in the X-axis. The table below describes problems and their solutions:

Problem description Solution

The retention time in the Verify that the integration was performed on the
peak table differs from that | currently displayed chromatogram.

in the chromatogram.
Note:

Only applicable if there are more than one chro-
matogram in the result.

The retention value in the Verify that the X-axis base has not changed after the

peak label differs from that | peak integration was performed, but is the same as

in the X-axis. in the peak table. This is applicable for ml and CV
bases.
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Problem description

The retention value is not
displayed in the peak label. the peak integration was performed, but is the

‘ Solution ‘
o Verify that the X-axis base has not changed after

same as in the peak table. This is applicable for
volume and time bases.

e Verify that the chromatogram has not been
changed, for example by selecting or deselecting
Adjust retention zero to injection number in the
Customize dialog, X-Axis tab.

Import UNICORN 5 result errors

The table below describes a problem and its solution:

Problem descrip-

tion

Not possible to im-
port UNICORN 5
results.

Solution

Verify that none of the suggested actions in the dialog are
applicable.

- Aresult with the same name already exists.
- You do not have sufficient access rights.
- The database is inaccessible.

Make sure that the result is created by UNICORN 5 control
software and that the system is supported for data migra-
tion to UNICORN 7.0, i.e., see UNICORN Administration and
Technical Manual.

Verify that the result can be opened in UNICORN 5, to make
sure that the file is not corrupt.

Verify that the column that was used had ml as column
volume unit.

246

UNICORN 7.0 Evaluation Manual 29-1108-88 AA



8 Troubleshooting

Export of archived result

The table below describes a problem and its solution:

Problem description

Solution

The export function is available when an archived result Do not export an
is selected. However, it is not possible to export an archived | archived result.
result. Instead the result that was selected before the

archived result will be exported.
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Appendix A Evaluation functions and
Instructions

Introduction

This appendix contains background information about the algorithms and calculation
theories applied in UNICORN.

It also describes the peak table column components and the instructions that are
available for automated evaluation procedures.

In this appendix

This appendix contains these sections:

Section See page
A.1 Smoothing algorithms 249
A.2 Baseline calculation theory 252
A.3 Peak table column components 258
A.4 Evaluation procedure instructions 265
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A.1  Smoothing algorithms

Introduction

This section describes how the smoothing functions are calculated. Choose Opera-
tions:Smooth in the Evaluation Classic module to view and edit the options.

Moving average

The table below describes the process when the Moving average smoothing algorithm
is used.

Stage Description

1 For each data point in the source curve, the processed curve is calculated
as the average of the data points within a window centered on the source
data point.

« The width of the window is determined by the Filter Parameter value,
expressed as number of data points.

2 When the source point is less than half the window size from the beginning
of the end of the curve, the average is calculated symmetrically round the
source point over as many data points as possible.

« Ifyouincrease the window width, the smoothing effect is also increased.

Note: The filter algorithm only accepts odd integer parameter values between 1 and
151.Ifan even number has been given, it is incremented by adding the number
one (1).

Autoregressive

The table below describes the process when the Autoregressive smoothing algorithm
is used:

Stage Description

1 The first data point in the source curve is copied to the processed curve.

2 For each subsequent data point, the previous processed point is multiplied
with the filter parameter value and added to the current source data point.
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Median

250

Stage

3

Description

The result is then divided by the parameter value plus 1 according to the
following formulae:

t1=5;

tn =(Q*tn-1+ Sn)

(p+1)

Where:

t, = current processed point
t,.1 = previous processed point
S,, = current source point

p = smoothing parameter value

Note:
If you increase the parameter value, the smoothing effect is also increased.

Note:

The filter algorithm only accepts integer parameter values between 1 and 25.

The table below describes the process when the Median smoothing algorithm is used.

Stage Description
1 For each data point in the source curve, the processed curve is calculated
as the median of the data points within a window centered on the source
data point.
¢ Thewidth of the window is determined by the parameter value, expressed
as number of data points.
2 When the source point is less than half the window size from the beginning

of the end of the curve, the median is calculated symmetrically round the
source point over as many data points as possible.

e Ifyouincrease the window width, the smoothing effectis also increased.

e To completely remove a noise spike, the window width should in effect
be slightly more than twice the width of the spike.
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Note: The filter algorithm only accepts odd integer parameter values between 1 and
151.Ifan even number has been given, it is incremented by adding the number
one (1).

Savitzky-Golay

The table below describes the process when the Savitzky-Golay smoothing algorithm
is used.

Stage Description

1 The algorithm is based on performing a least squares linear regression fit
of a polynominal of degree k over at least k+1 data points around each point
in the curve to smooth the data.

The derivative is the derivative of the fitted polynominal at each point.
The calculation uses a convolution formalism to calculate 1st through 9th
derivatives.

2 The calculation is performed with the data in low X to high X order.

If the input trace goes from low to high, it is reversed for the calculation and
is re-reversed afterwards.

Tip: See Gorry, Peter A, General Least-Squares Smoothing and Differentation by
the Convolution (Savitsky-Golay) Method (Analytical Chemistry 1990, Volume
62, 570-573) for information about the Savitzky-Golay algorithm.
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A.2  Baseline calculation theory

Introduction

There are two methods to calculate the baseline, based on a morphological and classic
algorithm.

Overall process

The table below describes the overall process of a baseline calculation.

Stage Description

1 The baseline segments are defined.
2 The baseline points are selected.
3 The baseline is drawn.

Baseline segment definition

Baseline parameters are used to find the baseline segments. The default values for the
parameters are determined from the source curve. The baseline segments are found by
different parameters that are based on the type of algorithm that is selected.

Tip: The parameters can be displayed in the Evaluation Classic module if you choose
Integrate:Calculate baseline function. You can also click the Baseline settings
button in the Integrate:Peak integrate dialog.

Morphological algorithm

The Morphological algorithm searches for all parts of the source curve where:

¢ The curve parts come into contact at both ends of a horizontal line of the length
defined in the Structure width parameter. The default value of this parameter is
based on the widest detected peak in the curve. The horizontal line is moved along
the curve up the peak until it reaches the contact points. The curve parts below the
horizontal line and the line will now form a “"curve” with a plateau. The center point
in the plateau formed by the horizontal line will be the data point for the baseline.

¢ The data points fulfil the Minimum distance between data points. This parameter
reduces the total number of data points that are created from a curve.
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Classic algorithm

The Classic algorithm searches for all parts of the source curve where:

* The curve parts are longer than the Shortest baseline segment. This parameter
determines the minimum length for a part of the source curve to be considered a
possible baseline segment.

* The curve has no point outside the Noise window. The noise window is defined as
arectangular corridor parallel to the slope of the curve and centered on the first and
last points within the currently inspected segment.

* The slope is less than the Slope limit. This limits the maximum slope of the baseline
to differentiate baseline segments from peaks.

* The curve parts are lower than the Max baseline level. This parameter determines
the highest acceptable signal level for the baseline.

The baseline parameters can be illustrated as a rectangular box that the source curve
has to fit into in order to be identified as a baseline segment, where:

* The length of the box corresponds to the Shortest baseline segment.

* The height of the box corresponds to the maximum level of noise on the baseline
segments. This is referred to as the Noise window.

* The box is allowed to be tilted with a maximum slope corresponding to the Slope
limit.

* The box is not allowed to move up above the Max baseline level.
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Baseline parameters -
illustration (Classic algorithm)

The illustrations below show the baseline parameters graphically.
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Baseline segment identification
(Classic algorithm)

The table below describes the baseline segment identification process:

Stage Description

1 The box is virtually moved along the source curve in steps of one third of
the Shortest baseline segment length to look for baseline segments.

2 A baseline segment is found whenever the currently examined part of the
source curve fits completely within the box.

3 The found baseline segments are joined by connecting adjacent segments,
provided that the slope of the joining lines does not exceed the Slope limit.

Baseline points (Classic

algorithm)

When the baseline segments have been defined and joined, they are replaced by baseline
points at the start and end of each segment. The line between these is also filled with
points.

Tip: The baseline points are shown as gray squares in the Integrate:Edit baseline
function of the Evaluation Classic module.

Baseline drawing (Classic

algorithm)

The baseline points are used to create the baseline curve using a spline interpolation.
The spline function ensures that the baseline curve is guided by the baseline points.
However, the curve does not necessarily pass through the baseline points. The baseline
will be a smoothly curved function passing close to or through the points.

To reduce the effect of noise at the peak integration, the created baseline is forced equal
to the source curve in every position where the difference between the baseline and the
source curve is small enough. Choose Integrate:Calculate Baseline. If the Accept nega-
tive peaks option is off, the baseline will be forced down to the level of the source curve
whenever the created baseline goes above the source curve.
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Measure a Classic algorithm

baseline segment

You can try to measure the Shortest baseline segment length directly on your chro-
matogram. To measure the shortest baseline segment:

Step

Action

1

Locate the shortest segment of the curve that you consider a part of the
baseline.

Right-click in the chromatogram and choose Vertical marker.

Use the Vertical marker to measure the length of the segment by reading
the start and end point values.

Choose Integrate:Calculate Baseline and insert this value as the Shortest
baseline segment value.

Measure noise level (Classic

Curve coordinates can also be used to measure noise levels on the source curve. To
measure noise levels:

Action

Use the Zoom function to focus on a part of the curve that is representative
for the baseline noise.

Select an appropriate Y-axis scale.

Measure the Y-axis coordinates.

e Calculate the noise range as the difference between the max. and min.
values.

e Add an extra 20%.

e Choose Integrate:Calculate Baseline and insert this value as the Noise
window value.

algorithm)
Step
1
2
3
4
256
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Measure the slope limit (Classic

algorithm)

Follow the instructions below to measure the slope at any part of the curve.

Stage

Description

1

Select Operations:Differentiate in the Evaluation Classic module.

Result: The Differentiate dialog opens.

e Select the desired source curve.
e Select the First order calculation option.

Result: The differentiated curve will appear in the active chromatogram.

Select an appropriate Y-axis scale, right-click and select Vertical marker to
measure the Y-axis values for the differentiated curve with the curve coor-
dinates function.

Result: The Y-axis value is interpreted as the UV curve slope at the selected
retention point.
e Determine the highest slope value of the baseline (non-peak) part of the

curve.

e Add 10%.

o Select Integrate:Calculate Baseline and use this value as the Slope
limit.

Ti

~

p:

If the differentiated curve is very noisy, it can be filtered with a light Moving
average filter in the Operations:Smooth function.
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A.3  Peak table column components

Introduction

This section contains a list of peak parameters with explanations and calculation formulae
when applicable.

Peak parameters - illustration

The diagram below illustrates the peak parameters. See the parameter list below for
explanations.

Peak parameter descriptions

The list below contains descriptions of the peak parameters.

Parameter Description

Area Calculated as the area between the curve and baseline, be-
tween the peak start and peak end, time or volume base (gray
area in the diagram above).
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Parameter ‘ Description

Asymmetry Peak asymmetry (indicator of column packing). See definition
below this table.

Baseline height Baseline amplitude at peak start, peak maximum and peak

end (A, F and G in the diagram above).

Retention factor

The retention factor will only be calculated when the chro-
matogram is in volume base. The total liquid volume, V;, must
be entered in the Peak Integrate dialog for this parameter to
be calculated. See definition below this table.

Fraction tube id

Fraction number at peak start, peak maximum and peak end.

Height Maximum amplitude above the baseline (C-F in the diagram
above).

Kav Gel phase distribution constant in gel filtration. Kav will only
be calculated when a gelfiltration column was used and when
the chromatogram is in volume base. The void volume, V,
must be entered in the Peak Integrate dialog for this parameter
to be calculated. See definition below this table.

Plate height (HETP) | Height equivalent to theoretical plate and plates/meter. The
column height must be entered in the Peak Integrate dialog
for this parameter to be calculated. See definition below this
table.

Peak endpoint Amplitude above the baseline at left (A in the diagram above)

heights and right peak limits (E-G in the diagram above).

Peak endpoint re- | Retention value at peak start and peak end, time or volume

tention base (A and G in the diagram above).

Peak name Name of the peak.

Percent of total Peak area as a percent of the total area under the curve above

area the baseline. Time or volume base.

Note:
This value can differ in time and volume base if the flow rate is
not constant throughout the method.

Percent of total Peak area as a percent of the sum of all integrated peaks.

peak area

Note:

This value can differ in time and volume base if the flow rate is
not constant throughout the method.
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Parameter Description ‘

Resolution Peak resolution. See definition below this table.

Retention Retention at the peak maximum, time or volume base (Cin the
diagram above).

Sigma Standard deviation for a Gaussian-shaped peak. See definition
below this table.

Type of peak limits | Identifies the criteria for peak start and peak end as either the
baseline intersection or dropline to the baseline or skim line.

Width Difference in retention between the peak end and peak start,
time or volume base (G-A in the diagram above).

Width at half Calculated by taking the maximum height of the peak above

height the baseline, then determining the peak width at half this value
above the baseline. Time or volume base. (B-D in the diagram
above, where BD bisects CF)

Note: In the Options dialog (which is available in all UNICORN modules from the

Tools menu) you can select if negative retentions should be displayed or not.
The default selection is that negative retention is displayed.

Asymmetry formula

The formula below is used to calculate the Asymmetry.

Asymmetry =B/ A
Where:

e Ajisa partial peak width, measured at a percentage of the peak height (asymmetry
ratio), for the leading part of the peak.

* Bis a partial peak width, measured at a percentage of the peak height (asymmetry
ratio), for the tailing part of the peak.
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height

o,
10% peak{ alg

Change the Asymmetry Ratio

The Asymmetry Ratio is selected in the Options dialog. The table below describes how
to select a value:

Step Action

1 ¢ Choose the Tools:Options menu item.

Result: The Options dialog opens.

2 e Type aratio value in the Asymmetry Ratio at text box.
e Click OK.

Result: The ratio value is changed and the dialog closes.

Note: You must repeat the peak integrations after the change to update the values
based on the new asymmetry ratio. The default ratio is 10%.

Retention factor formula

The formula below is used to calculate the Retention factor.

e M
Vi
Where:

* Vg =retention volume.

eV, =total liquid volume.
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Kqy formula
The formula below is used to calculate Kav.
Ve
Ve Vo
Where:

* Vg =retention volume.
* Vy=void volume.

* V¢ =columnvolume.

HETP formula
The formula below is used to calculate the HETP value.
HETP = L/N
N = 5.54  (Vg/w; )¢ assuming a Gaussian peak.
Where:
e N =no. of theoretical plates.
* L=bedheightincm.
* Vi =peak retention volume or time.

* w, =peak width at half height expressed in the same units as V.

Peak resolution algorithms
The peak resolution is calculated with one of the following three algorithms:
1 (Vo - Ve / Wpp + W) / 2)
2 (Vs - Vgyl / ((Sigmas, + Sigmay) % 2)
3 (Vo - Vo) /2 X (Wi + Wiy / 2.354
Where:

* Vg Wy, Sigma; and Wy, are the retention, width, Sigma and width at half height
of the previous peak.

*  Vgo, Wy, Sigma, and Wi, are the retention, width, Sigma and width at half height
of the current peak.

262 UNICORN 7.0 Evaluation Manual 29-1108-88 AA



A Evaluation functions and instructions
A.3 Peak table column components

Note: The Resolution Algorithm variable in the Options dialog determines which
of the three algorithms is used. The default setting is algorithm 3.

Change the peak resolution
algorithm

Follow the instructions to change the peak resolution algorithm in the Options dialog.

Step Action

1 In the Administration module, on the Tools menu, click Options.

Result: The Options dialog opens.
2 Click the Evaluation tab.

3 In the Resolution Algorithm list, click the desired algorithm as described in
Peak resolution algorithms, on page 262.

-

Options @

Wiew Eval OPC Settings

Asymmetry Ratio at 10 0-100 (% of peak height)

Resolution Algorithm | 3; {(Ret2 - Ret1) / ({2 * (WidthHalfHeight2 + Wir |

[] Show system default curves (%)
Aurto-Integrate result (%)

(™) Only applies for Evaluation

[ oK |[ Cancel
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Step Action
Click OK.

Result: The dialog closes and the peak resolution algorithm is changed.

Note: You must repeat the peak integrations after the change to update the values
based on the new algorithm.

Sigma formula

The formula below is used to calculate Sigma.

L]
sigma= | . (5 (%" %0))

i=1

Apcak

Where:
* nisthe number of data points.
e xisthe volume or time value.

* X

ymax 1S the volume or time value at the maximum amplitude value.

*  Apeak is the area of the peak.

Note: The peak width for a Gaussian peak is (4 x Sigma).
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A.4  Evaluation procedure instructions

Introduction

This section contains information about the procedure instructions that are available
for selection in the Instruction field of the Procedure Editor in the Evaluation Classic
module. Choose Procedures:Edit:New in the Evaluation Classic module to view the In-
struction list. The procedure instructions are used to build a complete, automated
evaluation procedure, which may be included in a method and executed as part of a

method run.

Tip: J

The mouse pointer is placed over a parameter field to show the allowed
value range.

The curve source is defined as the curve position number.

Curve operation

The table below contains a list of instructions for curve operations.

Instruction Description

ADD

Adds two curves to produce a third curve, which is the sum of the
two curves. The two source curves must have the same Y-axis unit
and not be fraction, injection or run log curves, or else a run time
error will occur.

AMP_MUL

Multiplies the amplitude of the source curve by the multiplication
factor and stores the result in the target curve position.

AMP_SHIFT

Shifts the amplitude of the source curve by the shift factor and
stores the result in the target curve position.

CLEAR

Clears the specified curve from the working memory of the comput-
er.

CopPY

Copies the source curve to the target curve position.

cutr

Cuts out the part of the source curve between the Left and Right
limits and stores the result in the target curve position.

DERIVATE

Differentiates the source curve (first or second order) and stores
the result in the target curve position. The Y-axis of the target curve
position will be a normalized scale without unit.
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Description ‘

Divides two curves to produce a third curve, which is the quotient
of the two curves. The two source curves can have any Y-axis unit.
The Y-axis of the target curve position will be a normalized scale
without unit.

HISTOGRAM

Creates a histogram from any non-fraction curve (source curve 1)
and a fraction curve (source curve 2_frac), and stores the result in
the target curve position. If source curve 2 is not a fraction curve a
run time error will occur. The Y-axis of the target curve position will
be the same as that of the first source curve.

INTEGRATE

Performs a mathematical integration of the source curve and stores
the resultin a Result curve. This instruction is not the same as Peak
integrate, which performs a real peak integration.

RET_MUL

Multiplies the retention of the source curve by the Multiplication
factor and stores the result in the target curve position.

RET_SHIFT

Shifts the retention of the source curve by the Shift factor and stores
the result in the target curve position.

SMOOTH_AR

Smooths the source curve with an autoregressive filter and stores
the result in the target curve position. The Filter parameter decides
the strength of the filter.

SMOOTH_MA

Smooths the source curve with a moving average filter and stores
the result in the Resulting Curve. The Filter width parameter decides
how many samples wide the filter is.

SMOOTH_ME-
DIAN

Smooths the source curve with a median filter and stores the result
in target curve position. The Filter width parameter decides how
many samples wide the filter is.

SMOOTH_SG

Smooths the curve with the Savitzky-Golay algorithm.

sus

Subtracts two curves to produce a third curve, which is the differ-
ence of the two curves. The two source curves must have the same
Y-axis unit and not be fraction or injection curves.

DIV

Divides two curves to produce a third curve, which is the quotient
of the two curves. The two source curves can have any Y-axis unit.
The threshold values are used to avoid division of numbers close
to zero. At those points where source curve 1 has an amplitude less
than Threshold1, or the source curve 2 has an amplitude less than
Threshold2, the result of the division is defined to be 1.0.
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The table below contains a list of instructions for integration.

Instruction Description

CALCULATE_BASE-
LINE

Calculates a baseline from the source curve. The baseline is
stored in the target curve position. DEFAULT can be selected
in the Baseline parameters, which will then calculate default
baseline parameters for each new curve.

CALCULATE_BASE-
LINE_MORPH

Calculates a baseline from the curve crvSrc using a morpho-
logical method. DEFAULT can be selected in the Baseline
parameters, which will then calculate default baseline param-
eters for each new curve. The baseline is stored in curve
crvDst.

CLEAR_PEAKTABLE

Clears the peak table in Peak table source from the computer
memory.

COPY_PEAKTABLE

Copies a peak table from Peak table source to Resulting
peak table.

NEGATIVE_PEAKS

Controls the baseline behavior in subsequent baseline calcu-
lations. If ONOFF is ON then the baseline can be drawn above
the curve and negative peaks can be detected by PEAK_IN-
TEGRATE. If ONOFF is OFF then the baseline is never drawn
above the curve.

PEAK_INTEGRATE

Performs a peak integration on the source curve and stores
the resulting peak table in Resulting peak table. It is assumed
that the baseline is subtracted.

PEAK_WINDOW

Specifies which part of the source curve that will be integrat-
ed. Peaks between retention Left limit and Right limit will be
detected if the ONOFF parameter is set to ON. If ONOFF is
set to OFF, the whole curve will be used for integration.

REJECT_PEAKS

Any combination of conditions is allowed. If all parameters
are OFF then every detected peak is included in the peak
table.

SET_COL-
UMN_HEIGHT

SET_COLUMN_VO

Sets the column height for the peak integration calculation
of the HETP value. The Column height parameter is the
height of the column in centimetres. If Column height is OFF
then the HETP value is not calculated for the following inte-
grations.

Sets void volume for Kav peak integration calculation.
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Instruction ‘ Description

SET_COLUMN_VT Sets the total liquid volume for peak integration calculation
of the capacity factor.

SET_SKIM_SIZE_RA- | Sets the Skim size ratio to be used in the following peak in-
TIO tegration(s).

WINDOW_PEAK_IN- | Integrates the curve within the peak window. All curve parts
TEGRATE outside the peak window remain unchanged.

File operation

The table below contains a list of instructions for file operations.

Instruction Description

CURVE_OPEN Opens the curve specified in the Result file defined in File name
and stores it in target curve position. If "*" is entered as File
name the current result file will be used. The File name param-
eter may include a path from the users root folder.

IMPORT_CURVE Imports a curve to the current chromatogram from another
chromatogram (in the current file) and stores it in the target
curve position.

IMPORT_PEAK- Imports a peak table to the current chromatogram from another
TABLE chromatogram (in the current file) and stores it in the target
curve position.

PEAK- Opens the specified Peak table in the Result file defined in File
TABLE_OPEN name and stores it in the Resulting peak table. If "*" is entered
as File name the current Result file will be used. The File name
parameter may include a path from the current users root
folder.
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The table below contains a list of instructions for export operations.

Instruction Description

EXPORT_CURVE_ASCII

Exports the curve entered in Curve source to the file de-
fined in Export to file in ASCII. If "*"is entered as file name
in the Export to file field the current Result file will be
used. If "?" is entered followed by text (e.g., "Enter a file
name”), as file name, a full search path must be entered
in answer to the question. In the part of the source curve
limited by the Left limit and Right limit every <n> sample
is exported.

EX-
PORT_DOC_400_ASClI

Exports the documentation in the current result file in
ASClI format to the file defined in Export to file. If "*" is
entered as file name in the Export to file field the current
Result file will be used. If "?" is entered followed by text
(e.g., "Enter a file name"), as file name, a full search path
must be entered in answer to the question. If all parame-
ters to this function are OFF then no documentation is
exported. If at least one of them is ON then the documen-
tation will be exported and the corresponding parts will
be included in the exported file.

EXPORT_DOC_400_XLS

EX-
PORT_EVAL_LOG_ASCII

Exports the documentation in the current result file in MS
Excel XLS format to the file defined in Export to file. If "*"
is entered as file name in the Export to file field the cur-
rent Result file will be used. If "?" is entered followed by
text (e.g., "Enter a file name"), as file name, a full search
path must be entered in answer to the question. If all
parameters to this function are OFF then no documenta-
tion is exported. If at least one of them is ON then the
documentation will be exported and the corresponding
parts will be included in the exported file.

Exports an evaluation log in ASCII format to the file de-
fined in Export to file. If "*" is entered as file name in the
Export to file field the current Result file will be used. If
“?"is entered followed by text (e.g., "Enter a file name"),
as file name,, a full search path must be entered in answer
to the question.
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Instruction

EXPORT_EVAL_LOG_XLS

‘ Description ‘

Exports an evaluation log in Excel xls format to the file
defined in Export to file. If "*" is entered as file name in
the Export to file field the current Result file will be used.
If "?" is entered followed by text (e.g., "Enter a file name"),
as file name, a full search path must be entered in answer
to the question.

EXPORT_METHOD_ASCII

Exports a method to the file defined in Export to file in
ASCII format. If "*" is entered as file name in the Export
to file field the current Result file will be used. If all param-
eters are OFF then no method is exported. If Main is ON
then the main method is included and if Blocks is ON then
all blocks are included in the exported file.

EXPORT_METHOD_XLS

Exports a method to the file defined in Export to file in
Excel xls format. If "*" is entered as file name in the Export
to file field the current Result file will be used. If "?" is en-
tered followed by text (e.g., "Enter a file name"), as file
name, a full search path must be entered in answer to
the question. If all parameters are OFF then no method
is exported. If Main is ON then the main method is includ-
ed and if Blocks is ON then all blocks are included in the
exported file.

EXPORT_MUL-
TI_CURVES_ASCII

Exports multiple curves (previously defined with EX-
PORT_SEL_CURVES instructions) in ASCII format to the
file defined in Export to file. If "*" is entered as file name
in the Export to file field the current Result file will be
used. If "?" is entered followed by text (e.g., "Enter a file
name"), as file name, a full search path must be entered
in answer to the question.

EXPORT_MUL-
TI_CURVES_CSV

Exports multiple curves (previously defined with EX-
PORT_SEL_ CURVES instructions) in comma separated
value .csv format to the file defined in Export to file. If "*"
is entered as file name in the Export to file field the cur-
rent Result file will be used. If “?" is entered followed by
text (e.g., "Enter a file name"), as file name, a full search
path must be entered in answer to the question.

EXPORT_NOR-
MALISE_RETENTION

Normalizes retention when exporting multiple curves.
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Instruction Description

EXPORT_PEAK-
TABLE_ASCII

Exports the peak table in Peak table source to the file
defined in Export to file in ASCII format. If "*" is entered
as file name in the Export to file field the current Result
file will be used. If "?" is entered followed by text (e.g.,
"Enter a file name"), as file name, a full search path must
be entered in answer to the question.

EXPORT_PEAK-
TABLE_XLS

Exports the peak table in Peak table source to the file
defined in Export to file in Excel xIs format. If "*" is entered
as file name in the Export to file field the current Result
file will be used. If "?" is entered followed by text (e.g.,
“Enter a file name"), as file name, a full search path must
be entered in answer to the question.

EXPORT_PEAK-
TABLE_XML

EXPORT_SEL_CURVES

Exports the peak table in Peak table source to the file
defined in Export to file in XML format. If "*" is entered as
file name in the Export to file field the current Result file
will be used. If "?" is entered followed by text (e.g., "Enter
a file name"), as file name, a full search path must be en-
tered in answer to the question.

Selects a curve for subsequent export (using the EX-
PORT_MULTI-CURVES_* instruction). The curve is cut
according to the right and left cut limit and the number
of points to be exported may be set by the Export param-
eter (for example, every fifth point).

Chromatogram functions

The table below contains a list of instructions for chromatogram functions.

Instruction Description

RESTORE_DESTINA-
TION_CHROM

Resets the destination for the subsequent curve and peak
table operations to the default chromatogram. Used to-
gether with the SET_DESTINATION_CHROM instruction.

SET_DESTINA-
TION_CHROM

Opens the named chromatogram as destination for the
subsequent curve and peak operations. Used together
with the RESTORE_ DESTINATION_CHROM instruction.
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Other instructions

The table below contains a list of instructions for other operations.

Instruction ‘ Description ‘

BASE

Sets the X-axis base that the following calculations will be made
in. If the value of the X-axis base is DEFAULT, then the default
base is used (usually the base the method was run in). This instruc-
tion should be the first in the evaluation procedure, otherwise it
will have no effect.

Comment Inserts a comment below the marked instruction.

ENDLOOP Marks the end of a LOOP statement.

LOOP The instructions between this statement and the ENDLOOP
statement are repeated n times. It is possible to have loops within
loops as long as the number of LOOP statements matches the
number of ENDLOOP statements.

QC_TEST Performs a QC test according to the parameter settings.

REPORT Prints a report with the specified named report layout and title. If

Title is "*" then the title in the report layout is used. If Report
Layout is "*" then a default layout is used.

RUN_PROGRAM

Starts a program as a separate process. The Program name string
contains the program name and parameters to start it with.

Test instructions

The Instruction field

also contains a group of test instructions. These instructions are

only available for the UNICORN software development team.

Instruction

AUTOSAM-
PLER_PEAK_INTER

Description ‘

Sets the area intervals for the AUTOSAMPLER_PEAK_TEST.
VALS

AUTOSAM-
PLER_PEAK_TEST

Locates the first peak in the peak table. Compares the
area of the peak in the peak table with the specified
maximum and minimum areas.

EXPORT_TEST_RE-
SULT_TO_FILE

Finishes the current result and saves the output file as an
ASClI file in a destination and with a file name specified
in the variable DestFilename (.txt). Acomplete search path
may be included in the file name.
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Instruction ‘ Description

GRADIENT_TEST_INTER- | Sets the level intervals for the NEW_GRADIENT_TEST.
VALS

NEW_GRADIENT_TEST | The theoretical straight line between the 0% and 100%
levels are calculated. The deviation between the curve
and the ideal straight line is compared in both directions
from the center position (50%) until the deviation exceeds
the defined maximum deviation. The calculated deviation
points are checked against the defined limits.

NEW_STEP_RE- The relative amplitude is calculated at the specified reten-

SPONSE_TEST tions (the 0% and 100% amplitudes are used for refer-
ence). The calculated relative amplitudes are checked
against the specified error margins. The 0% level ampli-
tude is verified to be within the specified interval from the
absolute 0 level.

NEW_TEST_CURVE_AM- | Verifies that the curve amplitude has changed more than

PLITUDE_CHANGE or equal to the value of the Delta parameter between the
defined to and from retention points. A print parameter
may be set to On to generate printed results.

NEW_TEST_CURVE_AM- | Verifies that the curve amplitude is stable between the

PLITUDE_STABLE defined to and from retention points. The actual curve
value is compared to a set amplitude parameter. If the
difference exceeds a set Delta value, the test is failed. A
print parameter may be set to On to generate printed re-

sults.
NEW_TEST_LOG- Verifies if a specified text is present in the logbook curve
BOOK_EVENT between the defined to and from retention points. The

test can be defined to be passed either if the text is
present or not. A failed or passed text will be added to the
output file. A print parameter may be set to On to gener-
ate printed results.

NEW_UV_RE- The amplitudes for the 0% and 100% levels are calculated

SPONSE_TEST and the difference between the values are calculated.
The results of (1) Curve2_Difference / Curvel_Difference
and (2) Curve2_Difference / Curve3_Difference are calcu-
lated. The calculated points are checked if they are outside
the defined limits from the 50% level.

STEP_RESPONSE_INTER- | Sets the level intervals for the NEW_STEP_RE-
VALS SPONSE_TEST.
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Instruction

TEST_INFO

Description ‘

Adds selected information items to the output file (e.g.,
system name), UNICORN version, etc. Also, a specified
free text can be added. A print parameter may be set to
On to generate printed results.

UV_RESPONSE_INTER-
VALS

Sets the level intervals for the NEW_UV_RESPONSE_TEST.
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